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Welcome to M 
 
 
M is an interactive composing and performing system that takes notes and chords that 
you specify and manipulates them, under your control, to create musical compositions 
which unfold during live performance. 
 
M contains many unique and useful features, including: 
 
• A variety of sophisticated recording and note editing techniques. 
 
• Controls for the selective re-ordering and randomization of musical material. 
 
• A capability for automating changes in MIDI velocities, note densities, rhythms, legato-
staccato articulations, and accents. 
 
• "Snapshots" that store and recall any configuration of screen controls, and Slideshows, 
which are sequences of Snapshots. 
 
• A performance system which allows you to "conduct" by dragging the mouse within the 
Conducting Grid, or to control the program from a MIDI keyboard, or to perform by 
selecting screen controls with the mouse. 
 
 

About This Manual 
 
The manual is divided into three kinds of chapters:  beginning tutorial (1-3), advanced 
tutorial (4-12), and feature reference (13-22). The tutorials lead you step by step into the 
world of M. While M may appear to be a complex program, we've worked hard to make 
things clear and simple, and we think you'll find the time spent going through the 
tutorials well worth it. We've also spiced the tutorials with suggestions for getting the 
most out of this powerful composing environment. 
 
The reference section is designed to explain each feature, and will be helpful when you're 
exploring on your own after completing the tutorial. 
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1   Setting Up 
 

 
 
System Requirements 
 

M 2.7 requires a Mac OS computer running OS X 10.3.9 or later. For external MIDI I/O, 
a MIDI interface is required. 
 
M 2.7 uses OS X Core MIDI for MIDI input and output. 
 

Registering M 
 

When you start M 2.7, a dialog box appears asking you for a serial number. 
 

 
If you do not enter a valid serial number, you can use M in demo mode. In demo mode, 
saving documents and capturing MIDI files will be disabled.  
 
If you have purchased M and received a serial number by e-mail, you may type it into 
this dialog box. M serial numbers consist of letters and numbers in six groups of four 
characters separated by dashes. Enter four characters into each space in the dialog box, 
then click the Register button. 
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2  Guided M Tour 
 
 

M turns your computer into an interactive composing and performing environment. 
 
Instead of merely playing back what you've already composed, M becomes a part of the 
actual process of composition. You enter your basic musical ideas and materials as 
melodies, chords, and rhythms, and then work with M to transform those ideas into 
finished compositions. 
 
M's powerful tools and musical controls let you work so quickly and interactively that the 
line between composing and performing becomes blurred. You're composing and 
performing at the same time, and with a vast array of controls. You can control your 
music by clicking and dragging the mouse on the computer screen, by "conducting" in 
the Conducting Grid, by pressing keys on your computer keyboard, or by playing specific 
notes on your MIDI keyboard. 
 
When working with M, you hear the musical results of everything you do while you're 
doing it, virtually without dropping a beat, so that you can try new things and explore 
musical ideas quickly, efficiently, and with immediate satisfaction. 
 

 
Screen Layout 

 
Start the program by double-clicking on the program icon from the Finder and look at the 
main screen. M's main screen is a musical control panel which lets you do many things 
simultaneously and gives you a visual overview of all of the program's operations. 
 
There are six windows in the main screen. Each window contains a particular grouping of 
controls, and the controls in all of the windows are interrelated as different parts of the 
same musical process. All of M's main screen windows are always active so that you can 
use any control whenever you like.  
 
The six windows of the main screen are shown in the following diagram. 

 

Patterns Conducting Snapshot

Variables Cyclic Variables

Midi
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The Patterns Window contains four rows of controls for creating and managing 
Patterns. A Pattern, in M, is a collection of notes that can be transformed in a variety of 
ways. The Patterns Window also contains some controls for managing Voices. A Voice 
in M is a "path" through the program which begins with a Pattern. 
 
The Conducting Window contains controls that allow you to affect the operations of the 
whole program. You can change certain aspects of the program's operation in the 
Conducting Grid; you can start and stop the music, change the tempo, and do lots of 
other things that we'll describe later in this manual. 
 
The Variables Window contains controls that allow you to transform M's Voices. A 
Variable in M is a category of transformation. In the Variables Window, you can change 
note ordering, transposition, texture, and density; you can introduce rhythmic "feel"; and 
you can set MIDI velocity ranges. You can also choose between different groups of 
Patterns that you've created. 
 
The Cyclic Variables Window contains controls that allow you to establish cyclic 
variation for note durations, legato-staccato articulations, and accents. 
 
The Midi Window contains controls that allow you to to direct your Voices' outputs to 
different MIDI channels and to send program (patch) change numbers to your 
synthesizers.  

 
The Snapshot Window contains controls that allow you to store and recall groups of 
other screen controls. You can also record and play back sequences of Snapshots, which 
we call Slideshows.  

 
Four by Six   

 
Notice that there is a recurring design theme of four  throughout the main screen. 
 
The Patterns Window, for example, consists of four horizontal rows, one for each Pattern. 
 

 
 

 
In the Variables and Cyclic Variables windows, there are four levels in each box. Each 
level represents a Voice. The top level in each box, for example, represents Voice 1, the 
second from the top represents Voice 2, and so on. 
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Notice also that there is a recurring design theme of six throughout the screen. 
 
There are, for example, six boxes, horizontally arranged, for each Variable in the 
Variables Window. There are also six boxes, vertically arranged, for each Variable in the 
Cyclic Variables Window. We call these boxes Variable Positions. Each of the Variable 
Positions represents a group of settings for a Variable. By clicking on a Variable Position 
during a performance, you can instantly change from one group of settings to another. 

 
Variable Positions

 
 
If the arrow associated with a Variable is highlighted, as shown below, you can also 
move from one Variable Position to another by "conducting" in the Conducting Grid.  

 

 
 
 

Edit Windows 
 

Each of the Variable Positions is associated with an Edit Window. In the Edit Windows, 
you determine what the contents of the Variable Positions are. 
 
The Edit Windows are accessed either through menu commands or by double-clicking on 
a Variable Position. One example of an Edit Window, although there are many different 
Edit Windows in M, is the Transposition Edit Window, in which you can set a 
transposition independently for each of the Voices. Open it by double-clicking in one of 
the six Transposition Variable Positions. 

 

 
 

The following window will appear. 
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Using M's Windows  
 

All of M's main screen windows and Edit Windows can be moved on the screen so that 
you're looking at what's important to you. To move the Transposition Edit Window, for 
example, just drag the word Transposition to a different location on the screen. 

 

Drag Window with Title Bar 
 

In most applications, you work only in the one window which is active. In M, all of the 
main screen windows are open and active at the same time, so that you can use them all 
simultaneously during performance. 
 
Edit Windows are the only windows which can be closed. To close an Edit Window, 
click inside the triangle in the upper left hand corner. If you haven't yet closed the 
Transposition Edit Window, close it now. 

 

Close Box  
 

When many windows are open at the same time on the screen, some will be covered up 
by others. To bring a particular window to the front, click in its title area, or choose its 
name from the Windows Menu, or Command-click anywhere inside the window. 

 
   

Using the Screen Controls  
 
The design of M's screen controls isn't quite the same as a typical program. That's 
because M is intended for interacting with an ongoing musical process. M's user interface 
is easy to learn, however, and once you spend a little time with the program, you'll be 
working the controls with ease and using your computer as a performance instrument. 

 
Buttons 

 
First, there's the simple push button. Click on it once to trigger an action.  

 

Snapshot Button Blink Everything
Button

Start Button

 
 
Then, there's the toggle button. Click on it to turn a control to its opposite state. The Play-
Enable Buttons in the Patterns Window are toggle buttons. Click once on the Play-Enable 
toggle and the speaker icon will disappear, indicating that its Voice will not be heard 
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during playback. Click again and the speaker icon will reappear, indicating that its Voice 
will be heard during playback. 

 

 
 

There are also arrow buttons, so-called because they display arrows. They're called 
Conducting Arrows. To highlight a Conducting Arrow button, click on it. To 
unhighlight it, click again. 
 
The Conducting Arrow buttons are used to connect Variables to the Conducting Grid. 
The direction in which a Conducting Arrow is pointing indicates the axis in the 
Conducting Grid along which you can "conduct" the selection of one a Variable's six 
Positions. To change the direction in which an Conducting Arrow is pointing, click on the 
Conducting Arrow and hold the mouse button down. The Conducting Arrow will rotate. 
Release the mouse button when the Conducting Arrow is pointing in the direction you 
want. 

 

 
 

Or, to use another method, click on the Conducting Arrow and then drag in a circle 
outside of its box. 

fl

fl

fl

fl

 
The Numerical 

 
A Numerical is a box which contains a letter, number, or graphic that can be changed 
with the mouse. 
 
Look in the Conducting Window and find the Tempo Numerical. It's located to the right 
of the word Tempo. 

 
 

 
We'll change the Tempo Numerical to a higher value. Position the cursor in the top half 
of the numerical's box and press the mouse button. 

 
 

 
The cursor will change to a thin upward-pointing arrow and the numerical's value will 
increase. 
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To change the value of the Tempo Numerical to a lower value, position the cursor in the 
lower half of the box and press the mouse button. The cursor will change to a thin 
downward-pointing arrow and the numerical's value will decrease. 
 
You can also use a slider gesture to change the value of a numerical. Click on a numerical 
and, still holding down the mouse button, move the cursor upwards or downwards 
outside of the numerical's box. The cursor will disappear and the numerical's value will 
change. For practice, change one of the Phase Numericals at the far right-hand side of the 
Patterns Window, or change one of the Sound Choice Numericals in the Midi Window. 

 

 
 

The Range Bar 
 
The Range Bar is used to define a range within which a value will vary. The normal 
procedure is to click at the point in the bar where you want the high or low end of the 
range to begin, then drag to the other end of the range. 
 
The one range bar on the main screen is the Tempo Range Bar, in the Conducting 
Window. Click in the left half of the range bar and drag the mouse to the right. You'll be 
drawing out a white range for variation in Tempo.       

 

 
 

Look beneath the Tempo Range Bar to either side of the Tempo Numerical. You'll see 
numbers which indicate the current high and low tempo range values. Try setting the 
Tempo Range Bar so that the low end is around 40 and the high end is at 210. 

 

 
 

If you want to set a range bar to a single value, click anywhere in the bar, without 
dragging. Just for fun, set the Tempo Range Bar to a single value of 120. 
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The Slider 
 

Open the Note Density Edit Window by double-clicking in one of the Note Density 
Variable Positions. The primary controls in the Note Density Edit Window are sliders, 
which let you set values by dragging "handles" left or right. Note that there's a numerical 
to the left of each slider, showing a precise value. 
 

 
To move a slider, position the mouse cursor on a slider "handle" and drag it left or right. 
Try it. When you're done, close the window by clicking in the triangle in the upper left-
hand corner. 

 
The Picture Matrix 

 
The Picture Matrix is a pop-up menu in which you can select any of the displayed icons. 
Each box in the Use Column, in the Patterns Window, triggers a Picture Matrix. Press the 
mouse button in one of the boxes. The Picture Matrix shown below will appear.  

 

 
 

Then drag the mouse to the side and release the mouse button on one of the icons. The 
selected icon will appear in the Use Box. 

 
 

Other Controls 
 
There are several other types of screen controls used in specific cases, such as the 
controls in the Note Order Variable, the graph functions in the Time Distortion Variable, 
and the Editing Grids in the Cyclic Editor. We'll explain how they work in those sections 
of the manual where we describe their functions. You'll find that they follow from the 
principles you've learned in this guided tour. 

 



 

15 

3   Beginning  Tutorial 
 
 

In this chapter, we'll show you how to get M to play notes through your MIDI setup or 
Quicktime Musical Instruments, and, if you're using an external input device, receive 
incoming MIDI data. Then we'll guide you through creating two Voices and performing 
with them. 
 
Be sure that your synthesizers are connected correctly, as described in Chapter 1, and be 
sure that you're familiar with M's windows and screen controls, as described in Chapter 2.  

 
The Midi Assignment Window 

 
Before we start, we need to introduce some terminology. M has Input and Output 
Channels. These are similar to MIDI channels, except than an M Output Channel can be 
mapped to a specific MIDI device and channel. Input Channels are similar: incoming 
MIDI received by a particular device on a particular channel is mapped to an M Input 
Channel you specify. The mapping is what happens in the Midi Assignment window. It is 
usually very simple, but when using OMS, it can be quite complex. 
 
Choose Open… from the File menu and open the tutorial M document called Jumping 
Right In. Then choose Midi Assignment… from the File menu. The Midi Assignment 
window lets you choose the MIDI sources and destinations that M uses. The description 
of how to use the Midi Assignment window is divided into three parts, depending on how 
your setup is configured. Please refer to the appropriate section for your situation. 

 
 
To switch an Output Channel's Port/Device from Modem to Printer (or to QuickTime), 
click on the word Modem and it changes to Printer. Click again and it will change back to 
Modem (or to QuickTime, if you have it installed). 
 
Before closing the Midi Assignment window, make sure that the currently assigned 
Port/Device for each Output Channel corresponds to something that is properly 
connected, both from your computer's MIDI interface and from M in the PatchBay 
window.  

 
Using the MIDI Assignment Window 

 
The Midi Assignment window provides a lot of possibilities, but for the purpose of 
getting started, we'll try to make it as simple as possible. When you open the Midi 
Assignment window you will see an input device listed for each M Input Channel and an 
output device listed for each M Output Channel. You'll want to ensure that the Input 
Channels are all set to a device or port that corresponds to your MIDI keyboard or other 
controller and that the Output Channels are set to a device or port that you can listen to. 
 
To change the port or device for an Input or Output Channel, click on the name you want 
to change. You will get a pop-up menu of all the available Input or Output devices. 
Choose the one you want. 
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Creating Voice 1 
 

1. Hear What You're Playing 
 

Note: If you're not using a MIDI keyboard with M, skip to step 4 below. 
 
You're about to enter some notes into Pattern 1. If you're using a MIDI keyboard, you 
want to hear what you're playing while you're playing. What do you do? 
 
If your keyboard is a synthesizer, you'll hear what you're playing directly. But if your 
keyboard is a controller for another synthesizer, you'll want to direct your input through 
M to whatever MIDI channel your synthesizer is receiving on. If you don't know what 
channel your synthesizer is receiving on, consult the operation manual and check your 
synthesizer's settings. 
 
Look in the Midi Window at the bottom of the screen. Double-click on the first Position 
in the Orchestration Variable. 

 
 
The Orchestration Edit Window will open. 
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The row labelled 1 in the Orchestration Edit Window sends the output of Voice 1 to any 
of the sixteen M Output Channels. Select, by clicking on them, the boxes that correspond 
to the receive channels of your synthesizers. As shown above, for example, Voice 1 is 
being sent to Output Channel 1. We'll assume, in this tutorial, that your keyboard sending 
on MIDI channel 1. 
 
Close the Orchestration Edit Window by clicking in the close triangle in the upper left-
hand corner of the window. 
 
Then look at the first horizontal row in the Patterns Window. 

 

 
 

Notice the words and icons above the row: Src, Use, a speaker, a section of the 
Orchestration Variable with two small arrows next to it, and a mouse with a baton. Click 
in the first box below the icon showing a section of the Orchestration Variable. 

 

 
 

A check mark will appear. You've just enabled Echo-Thru-Orchestration, which sends 
the output of your keyboard through the Pattern to the M Output Channels you've 
selected in the Orchestration Variable. Play on your MIDI keyboard. You'll hear what 
you play. 

 
2. Enable Record 

 
Still in the Patterns Window, press the mouse button while pointing in the first box below 
Use. A Picture Matrix will pop out to the right. 
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Still pressing the mouse button, drag the mouse to the right and release the button on R. 
The R will appear in the box. 

 
 
Be sure that the numerical below Src (Source Channel) reads All, indicating that M is 
receiving on all MIDI channels. 

 
 
 

3. Play 
 

Play the following notes on your MIDI keyboard. 
 

 
 

After you play, the Output-Length Numerical should read 3,indicating the number of 
notes you've recorded. 

 
 
If you make a mistake in playing or if you want to erase the Pattern for any reason, do the 
following. Click on the Select Box for Pattern 1. 
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Then choose Clear from the Edit menu. This will erase the Pattern. 
 

 
 
 

Then play again. 
 
Once you've finished entering notes into Pattern 1, disable Record by pressing the mouse 
button in the first row under Use, dragging to the dash in the Picture Matrix, then 
releasing the mouse button. 

 
4.  Use the Pattern Editor to Enter or Fix Notes 
 

You'll either be at this step because you don't have a MIDI keyboard to enter notes or 
because you've finished entering notes with your MIDI keyboard. 
 
Double-click on the Select Box for Pattern 1. 
 

 
 
You will see the Pattern Editor window, which displays the notes in a Pattern in a 
piano-roll fashion and lets you edit them. If you've already played something into M, you 
should see something similar to the following melody.  
 

 
 
If not, just click on the grayed-out little rectangles where the notes appear below, and you 
can enter the melody. If you played the melody incorrectly, click in the Pattern Editor to 
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fix it. Clicking on a note that is already present removes it from a Step, clicking on a 
rectangle without a note adds it. Steps that are present in a Pattern are outlined in black, 
those that are beyond the current end of the Pattern are outlined in gray. 
 
The Pattern Editor changes a Pattern as you edit it. You will also notice that you hear the 
steps of the Pattern playing through the current orchestration. That's because the Editor 
Sound Enable control is on. Click the speaker icon to turn it off if it bothers you. 
 

 
 
We'll show you more about the Pattern Editor in Chapters 5 and 14, but, especially if you 
don't have a MIDI keyboard, you can use the Pattern Editor in this simple way to enter 
basic melodic patterns. 

 
 

5. Listen to What You've Recorded 
 

Click on the Start Button, which initiates playback. Or press the Space bar on the 
computer keyboard. 

 

 
You should be hearing what you played, perhaps with some minor rhythmic variation. If 
you're not hearing anything, click on the Play-Enable Button for Voice 1, so that a 
speaker icon appears. 

 
 

Click on the Stop Button whenever you like. Or press the Return key on the computer 
keyboard. 
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6. Select a Sound 
 
Are you hearing the sound you want?  If not, look at the Sound Choice Variable in the 
Midi Window. Look particularly at the leftmost numerical in the first row, below the 
number 1. The 1 indicates Output Channel 1. 

 

Output Channels

Sound Choice Numericals 
 

The numerical under 1 is blank, which means that no program change has been sent, but 
the numerical can be changed to read the program number for the sound you'd like. 
Change it. Try for a sound something like a double-bass. The program change won't be 
sent to your synthesizer until you release the mouse button.   

 

 
 

 
Note: If M's program numbers are one off from your synthesizer's numbers, refer to Midi 
Assignment in the File menu, described in Chapter 13. 

 
7. Set the tempo 

 
To set your Voice's tempo, you'll first set the system tempo with the Tempo Range Bar, 
then set the Time Base Numericals for the particular Voice. 
 
Set the Tempo Range Bar, in the Conducting Window, to about 118 by clicking once in 
the center of the bar. 

 
 
Then look in the Patterns Window at the Time Base column. 

 
Change the denominator of Voice 1's Time Base Numerical from 4 to 8, as shown above. 
You'll hear your notes played twice as fast. 
 
The system tempo is analogous to a conductor's beat. The Time Base Numericals are 
analogous to the note values that a performer plays in relation to the beat. 
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8. Set accents 
 
Double-click in the first Position of the Velocity Range Variable, in the Variables 
Window. 

 
 
The Velocity Range Edit Window will open. Specify, for Voice 1, the range within which 
accents will vary, between 48 and 110 as shown below. 

 
 

Now double-click in the first Position in the Accent Variable, in the Cyclic Variables 
Window. 
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The Cyclic Editor Window will open with the Accent Button selected. 
 

 
 
 

The four Editing Grids represent the four Voices, 1 - 4, top to bottom. When the Accent 
Button is highlighted, it means that the Editing Grids are showing Accent patterns. (They 
can also show rhythm and legato-staccato articulations.) 
 
Click on the number 4 below the fourth column of the Editing Grid for Voice 1 (the 
topmost Editing Grid). 

 

 
 

You've set a cycle length of four steps. Notice that when you clicked below the Editing 
Grid, the accent levels for steps 2, 3, and 4 were set to their default values of level 1. 
We're now going to change those values. 
 
Click at level 2 for the second, third, and fourth columns, so that the black dots change 
their positions in the Editing Grid. You should be hearing an accent cycle of one strong 
beat followed by three weaker beats. 
 

 
 

 
To get continually varying accents, click on the number 1 below the first column, then 
drag down the length of the column from level 4 to level 1, so that almost the entire 
column is selected. The program will choose randomly from the different levels selected. 
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But wait. What velocities do the levels represent?  The range of accent variation is 
determined in the Velocity Range Edit Window, which should still be open on the screen. 
To understand the connection between the Velocity Range Edit Window and the Editing 
Grids, experiment with different  ranges in the Velocity Range Edit Window and 
different Editing Grid settings in the Cyclic Editor Window. 
 
Note:  Accent variation is dependent upon the sensitivity to MIDI velocity of your 
synthesizer's current sound. If you don't hear significant changes in accent, experiment 
with other sounds, as described above in the section on selecting sounds. 

 
 

Creating Voice 2 
 

1. Create a different kind of Pattern 
 

For our second Voice, we'll use chords rather than just single pitches. 
 
Look at the Select Column in the Patterns Window. Option-click on the quarter note icon 
in the Voice 2 row (second from the top). A new Picture Matrix will pop out. 

 

 
 
Drag the mouse to the icon representing two quarter notes stacked in a chord, then release 
the mouse button. You've put Pattern 2 into Chord Record Mode. 

 

 
 

2. Hear what you're playing 
 

Refer now to the beginning of this chapter, in Section 1 under Creating Voice 1. Follow 
the same routines we described above for setting Echo-Thru-Orchestration, but remember 
that we're now working with Voice 2, which will always be the second row from the top 
in any column. In the Orchestration Edit Window, set Voice 2's MIDI output channel 
numerical to the receive channel of your second synthesizer. Or, if you only have one 
synthesizer, set Voice 2's MIDI output channel numerical to the same channel as Voice 1. 
 
Click in the Echo-Thru-Orchestration Button for Pattern 2 so that the check mark 
appears. 
 
Then click on the Echo-Thru-Orchestration Button for Voice 1, so that its check mark 
disappears, and be sure that Record for Pattern 1 is disabled, so you won't be recording 
into it again.  
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3. Enable Record and play 

 
Enable Record for Pattern 2. Refer to the beginning of this chapter, under Enable 
Record, if you don't remember how. Then play the following music. Don't worry about 
playing it in rhythm, as the rhythm will be determined elsewhere. 

 
 

4. Listen to what you've recorded 
 

Once you've recorded the notes, disable Record for Pattern 2 as we did above for Pattern 
1, so you won't accidentally play in any new material. Then click on the Play-Enable 
Button for Voice 2, so that a speaker icon appears. To hear Voice 2 as a solo, click also 
on the Play-Enable Button for Voice 1, so that the speaker icon disappears. 

 
 

Start the music by clicking on the Start Button in the Conducting Window. 

 
5. Select a sound 

 
If you're working with a second synthesizer, or with a multi-timbral synthesizer, set the 
Sound Choice Numerical (under the number that corresponds to your synthesizer's MIDI 
receive channel) to a sound that you like. Try for something that resembles a vibraphone. 
If you don't remember how, refer above to the section on selecting sounds. 

 
6. Set the Time Base 

 
Change Voice 2's Time-Base Denominator Numerical to 16. You'll hear the music played 
four times faster. 
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7. Give your Voice an improvisational feel 
 

Double-click on the second Position in the Note Order Variable, in the Variables 
Window. 

 

 
 
The Note Order Edit Window will open. Notice that the second-from-the-left box in the 
upper right corner is selected, indicating that you're editing the settings of the second 
Note Order Variable Position. 

 

 
   

Notice that there are three types of note ordering to chose from:  Original Order, Cyclic 
Random, and Utterly Random. These types of note ordering are explained in detail in 
Chapter 7, but for the moment notice that each type is represented by a number. For now, 
position the mouse on the leftmost number for Voice 2. 
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Click and drag the number box all the way to the left. You'll see the black bar change to a 
gray bar. The numbers in the second box will also change. 

 

 
 

 
What you're doing is scrambling the order of the notes as they're played by Voice 2, 
giving your melody an improvisational feel. You aren't changing the order of the notes as 
they're stored in your Pattern. 
 
Now close the Note Order Edit Window and look at the Note Order Variable on the main 
screen. The second Note Order Variable Position is still highlighted, indicating that it is 
that Position which is affecting the music. Just for verification, click on the first Position 
in the Note Order Variable. You'll hear the note ordering change back to the order in 
which you first recorded. 

 
8. Listen to both Voices together 

 
Select the Play-Enable Button for Voice 1. You'll hear both Voices playing together. But, 
alas, Voice 1 and Voice 2 are no longer in sync because you changed Voice 2's Time 
Base. Click on the Sync Button, in the Conducting Window, and they'll be in sync again. 
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9. Transpose Voice 2 
 

Open the Transposition Edit Window by clicking on the first box in the Transposition 
Variable, in the Variables Window. In the second row from the top, change the 
Transposition Numerical in the Octave Column from 3 to 4. Voice 2 will be transposed 
up an octave. Then change the Transposition Numerical in the Note Column from C to 
D#. Voice 2 will be transposed up another minor third. C3 represents the key and octave 
in which a Pattern was originally recorded, and any change from that setting will change 
your Voice's relative transposition. 
 

 
 

10. Set accents and articulation 
 

Using the technique described earlier in this chapter, under Set Accents, set a velocity 
range for Voice 2 in the Velocity Range Edit Window. 
 
Then select Accent in the Cyclic Variables Window. Following the routines described 
above for Voice 1, set an accent cycle length of 3 for Voice 2, with one strong and two 
weak beats. 
 
Still in the Cyclic Editor, click on the Legato Button. 
 

 
 
Select a cycle length of one, and set continually varying legato-staccato note articulations 
by dragging the height of the column from top to bottom with the mouse.  
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11. Set rhythmic variation 
 

Open the Note Density Edit Window by double-clicking in the first Position in the Note 
Density Variable. Change the Note Density for Voice 2 to about 50 percent, which will 
cause about 50 percent of the Voice's notes to be skipped during playback. 

 

 
 
 
 

Simple Performing 
 

Manipulating the screen controls is one way to perform with M. But there are others. You 
can, for example, use your MIDI keyboard to vary your Voices while they're playing. 

 
 

Transpose with your MIDI keyboard 
 

In the Patterns Window, click in the Use Column for Voice 1 and select the sharps-and-
flats icon from the Picture Matrix. Do the same for Voice 2. 

 

 
 
 

What you've done is enable Keyboard Transpose. 
 
Then play different notes on your MIDI keyboard. Remember that middle C (C3) on your 
keyboard represents the key in which you originally recorded your Patterns, and that 
every note you play away from middle-C will transpose a Voice by an equivalent 
amount. 
 
When you've finished transposing, don't forget to deselect Keyboard Transpose in the 
Use Column. 
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Use the Input Control System 
 

The Input Control System lets you use your MIDI keyboard to control M's functions. To 
enable the Input Control System, select any Voice's Picture Matrix in the Use Column, 
then drag to C. Only one Voice, any Voice, needs to be enabled for you to use the Input 
Control System. 

 

 
 

 
Here's one example of using the Input Control System. If the music is playing, play B 
below middle C on your MIDI keyboard. The music will stop. If the music isn't playing, 
play middle C on your MIDI keyboard and the music will start. It's a simple example, but 
there's lots more you can do. See the Input Control System Template in Appendix B. See 
also Chapter 10.  
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4   Recording Patterns 
 

A Pattern in M is a collection of notes that can be transformed in a variety of ways. A 
Voice in M is a "path" through the program which begins with a Pattern. A Pattern is the 
first step in a Voice, and the first step in using M is to create a Pattern that contains the 
kind of pitch information that you want to work with. 
 
In the previous chapter, we've given you an overview of working with M. In this chapter, 
we'll discuss in greater depth M's procedures for using a MIDI keyboard to record pitches 
into Patterns.  
 
To begin, open the file called AT-1 (for Advanced Tutorial 1), which contains some 
prerecorded Patterns and Voice setups. Once AT-1 is open, choose Save as... from the 
File menu and save the file under another name, for example, M Work, so that the 
original AT-1 file will always be available. Then, as we proceed, save your changes 
periodically so that, if you decide to take a break, you can pick up the tutorial where you 
left off. 
 
A final note before proceeding. If you're using several synthesizers, or if you have a 
polytimbral synthesizer, set up your synthesizers so that you can hear four different 
sounds, each controlled by a separate MIDI channel. If you're using only one synthesizer, 
set M's four Voices to your synthesizer's MIDI receive channel. Try to find sounds that 
have fairly sharp attacks, that can sustain, and that respond to velocity, such as electric 
piano sounds. 

 
 

1. Choose a Pattern 
 

Choose which Pattern, of the four possible ones, you want to record into. The AT-1 file 
already provides notes recorded in Patterns 1 and 2, so we'll begin here by recording into 
Pattern 3. The recording controls for Pattern 3 are located in the Patterns Window, third 
row from the top.  
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2. Choose an Input Channel 
 
The Source Channel Numerical , under Src in the Patterns Window, sets what M Input 
Channel acts on a Pattern. 

 
 
All means that a Pattern will receive MIDI information on all Input Channels. All will be 
suitable for most situations. But if you're using a keyboard that can send MIDI data on 
more than one channel, you may want to act on different Patterns simultaneously but 
independently. Or you may be working with more than one performer or with more than 
one keyboard. In such cases, you could set each Pattern's Source Numerical to a specific 
M Input Channel by changing the values in the numericals. The actual MIDI channel and 
device of an M Input Channel are set in the Midi Assignment window, but by default, 
Input Channels correspond to MIDI channels. 

 
3. Monitor your recording 

   
Be sure that you can hear what you're playing. Echo your keyboard's output through M to 
your synthesizer by enabling Echo-Thru-Orchestration. 
 
Note: If you have a keyboard synthesizer, you'll want to set Local Control Off, so that the 
keyboard's output goes through M and then out to the synthesizer section of your 
keyboard. For more information on Local Control Off, refer to the discussion of the Midi 
Assignment Window in Chapter 19. 
 
The enable buttons for Echo-Thru-Orchestration are located in the Patterns Window 
under the icon shown below. Click on Pattern 3's enable button for Echo-Thru-
Orchestration so that a check mark appears. 

 
 

You've connected the MIDI output of your keyboard to the MIDI output channel(s) set 
for Voice 3 in the Orchestration Variable. 
 
The Echo-Thru-Orchestration Enable Button and the Orchestration Variable work 
together. Double-click on the first Position in the Orchestration Variable, in the Midi 
Window.  
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The Orchestration Edit Window will open. 
 

 
 
 

There are four rows of sixteen boxes. The rows, numbered at the left of the window, 
represent M's four Voices. The sixteen boxes in each row, numbered at the top of the 
window, represent the sixteen M Output Channels. (The actual MIDI channel and device 
of an M Output Channel is set using the Midi Assignment window.) When a box in a row 
is darkened, it means that the Voice represented by that row will be sent on the Output 
Channel represented by the number over the box. As shown above, Voice 1 is sent on 
Output Channel 1, Voice 2 on Output Channel 2, Voice 3 on Channel 3, and Voice 4 on 
Channel 4. We'll use these settings for this tutorial. 
 
To show you how the Orchestration Variable works, we'll play some music. Click on the 
Start Button in the Conducting Window. 
 

 
 

You should hear Voice 1 played by your first synthesizer, and Voice 2 played by your 
second synthesizer. If you have only one synthesizer, and if it's receiving on Channel 1, 
you're hearing only Voice 1. 
 
Now click on the first box in row 2 so that it's filled in. Then click on the second box so 
that it's blank, as shown below. You're hearing Voices 1 and 2 played by your first 
synthesizer. You've merged the outputs of Voices 1 and 2 to a single Output Channel, in 
this case Channel 1. 
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Next, click on the first box in row 2, so that it's blank. Then click on the second box in 
row 1. You aren't hearing Voice 2, but you are hearing Voice 1 played by both 
synthesizers, one of them receiving on Output Channel 1, the other receiving on Output 
Channel 2. 

 

 
 
You can send a Voice to any number of M Output Channels. 
 
Now click on the Stop Button, if you haven't already. 
 

 
 
Restore the Orchestration Variable to the settings shown below. 

 

 
 

Close the window by clicking on its close triangle. 
 

 
 

4. Enable Record 
 

Look at the Use Column in the Patterns Window. 
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Press the mouse button in the third box from the top. The Use Picture Matrix will pop 
out. 

 
 
Drag the mouse to the right and release the mouse button on R. The R will appear in the 
Use Column. 

 
 
You've set Pattern 3 to receive MIDI input data as pitch information.  
 
The Use Column lets you determine how incoming MIDI information will be interpreted 
for each Voice. R interprets MIDI data as pitch information. The dash means that 
incoming MIDI data is ignored. The other icons in the Picture Matrix are discussed in 
chapters 10 and 11. 

 
 

5. Select a Record Mode 
 

Locate the Select Column in the Patterns Window and Option-click on the quarter note 
icon in the Pattern Select Box for Voice 3. 

 

 
 
 

The Record Mode Picture Matrix will pop out, containing icons for the three Record 
Modes. 
 

 
 

 
To select a Record Mode, drag the mouse to one of the icons and release the mouse 
button. If you try this, re-select the single quarter note icon when you've finished. 

 
About the Record Modes 
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The Record Modes determine how the Patterns will interpret incoming MIDI data. First 
we'll tell you what the different Record Modes do, then we'll explain how to use them. 
 
Single Note Mode, represented by a single quarter note icon, means that MIDI data will 
be recorded as single notes. Even when you play a chord of two or more notes, the notes 
of the chord will be recorded as a string of individual pitches. 

 
 

Chord Mode, represented by two stacked quarter notes, means that MIDI data will be 
recorded as chords and single notes. When you play a chord of two or more notes, the 
notes of the chord will be recorded as a chord. When you play single notes, the notes will 
be recorded as single notes. 

 
 

Build Mode, represented by the plus sign, allows you to record dense or complex chords 
that may not be possible to play in real time. When you  hold down one note while 
playing other notes or chords, the notes or chords that you play will all be recorded as 
part of the same chord. They'll all be played back simultaneously, within the limits of 
your synthesizer. Letting go of all notes will advance you to the next Pattern step. 

 
 

6. Play using one of the Record Modes 
 

Be sure that Single Note Mode is selected for Pattern 3. If you've followed all the steps 
we've gone through, the row for Voice 3 should look like the one shown below. 

 

 
 
 

Play a C major triad (three notes), a D minor triad (three notes), and a C major scale 
(eight notes). You should hear your notes echoed out to your synthesizer that's receiving 
on MIDI channel 3. When you've finished, the Output Length Numerical should read 
14. 
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The Output Length Numerical reads 14 because all notes recorded in Single Note Mode 
are separated into individual events. 
 
Now click on the Play-Enable Buttons for Voices 1, 2, and 3. The speaker icon will 
disappear for Voices 1 and 2, and appear for Voice 3. 

 
 

Click on the Start Button to listen to Voice 3. You'll hear a C major arpeggio, a D minor 
arpeggio, and a C major scale. Single Note Record Mode records any chords you play as 
single notes. 
 
Stop the music by clicking on the Stop Button. Select Pattern 3 by clicking on its box in 
the Select Column, then choose Clear from the Edit menu. You've erased Pattern 3. The 
Output Length Numerical for Voice 3 should change to zero. 
 
Next, select Chord Mode from the Record Mode Picture Matrix for Pattern 3. 
 

 
 

Then play a C major triad, a D minor triad, and a C major scale. The Output Length 
Numerical should now read 10. Click on the Start Button and you'll hear the two chords 
followed by the scale.  
 
Clear the Pattern as described above and select Build Mode from the Record Mode 
Picture Matrix for Pattern 3. 

 
 
Click on the Start Button. But you won't hear anything yet. 
 
This time, play and hold down the lowest C on your MIDI keyboard. Holding the note 
down, play a C major triad on C3. Then play a G major triad on G4. Release the low C.  
 
Then play a low F, and while you're holding down the low F, play an F major triad and a 
C major triad at the high end of the keyboard. It doesn't matter if the triads are played as 
single notes or as chords, as long as one note, in this case the low F, is held down. The 
Output Length Numerical will now read 2, and you've heard a widely-voiced C major 
ninth chord followed by an F major ninth chord. Are you still holding down that F?  
Good. Now play the same F major triad again. These notes will disappear from the 
second step in the Pattern. 
 
Release the low F and stop the music. Disable Record for Pattern 3 by selecting the dash 
in the Use Picture Matrix. 

 
Using Drum Machine Record Mode 
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Drum Machine Record Mode is a special record mode. It's most effectively used in 
conjunction with one of the Insertion Modes, either Overdub Mode or Replace Mode. 
 
Ordinarily, new notes recorded into any Pattern are added to the end of the Pattern. The 
point of using Drum Machine Record Mode is to put notes into a Pattern at specific beats, 
similar to the way you record patterns on a drum machine. But there's no requirement that 
you use drum sounds. 
 
Select Pattern 4 as your Drum Machine Record Mode Pattern by clicking on the Select 
Box for Pattern 4. Enable Echo-Thru-Orchestration for Voice 4. Then deselect Play-
Enable for Voice 3 and select Play-Enable for Voice 4, so that the speaker icon appears 
only in the box for Voice 4. Next, enable Record for Pattern 4 by selecting R from the 
Use Picture Matrix. At this point, the Voice 4 row should look like this: 

 

 
 
Using Overdub Mode 

 
Now we'll select Overdub Mode as the insertion mode we want to use. Option-click on 
the middle icon in Pattern 4's Select box.  
 

 
 

The Insertion Mode Picture Matrix pops out. Drag the cursor to the icon representing a 
white ball stacked on a black ball and release the mouse button. 

 

 
 
The Select box should appear as shown below. Overdub Mode adds any new notes or 
chords to a step that's already there and, in conjunction with Drum Machine Record 
mode, allows you to build up Patterns of notes on top of each other. 

 
 

Next, Option-click on the icon at the right side of Pattern 4's Select box. 
 

 
 
The Drum Machine Record Mode Picture Matrix pops out. 

 

 
 



 

39 

Drag the mouse to the repeat sign icon and release the mouse button. You've selected 
Drum Machine Record Mode and your Pattern 4 Select Box should look like this: 

 

 
  

Be sure that you can hear what Voice 4 is playing. Set the Orchestration Variable to the 
receive channel for your synthesizer. Test it by playing on your MIDI keyboard. But 
notice that even though Pattern 4 is enabled for Record, no notes are recorded. That's 
because Drum Machine Record Mode won't work until you click on the Start Button. 
 
Now we'll create a blank Pattern of 16 steps into which you'll record your Drum Machine 
Pattern. Hold down the Option key while changing Pattern 4's Output Length Numerical. 
Set it to read 16. By Option-clicking on the Output Length Numerical, we've created a 
Pattern of 16 rests. 

 

 
 

Then set Voice 4's Time Base Denominator Numerical to 16. 
 

 
 

Then enable the metronome, so that when we record we can hear where the notes will go. 
Choose Use Metronome from the Options menu. 

 

 
 
 

Be sure that the first Positions are selected in the Note Order and Rhythm Variables, as 
these have been preset in the AT-1 file. Drum Machine Record Mode is most effective 
when used with 100 percent original note ordering and a constant rhythm. You may not 
understands what this means now, but don't worry. We'll explain more in Chapter 7. 
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Click on the Start Button. You should be hearing a metronome click from the computer 
speaker at 120 beats per minute. 
 
Locate the beginning of Pattern 4's cycle, so that you can play notes into specific beats. 
The easiest way to do this is to look at the Pattern Group Variable, in the Variables 
Window. Look in the box for Pattern Group a. You'll see four "bricks" stacked on top of 
each other. A brick indicates that a Pattern contains notes. Notice that the bricks flash 
when a Pattern reaches the beginning of its cycle. Notice the bottom brick, which 
represents Pattern 4. On the "downbeat," play C3, D3 on beat 5, E3 on beat 9, G3 on beat 
13, and B3 on beat 16.  
 
When you've finished playing the notes, you should hear a pentatonic scale in 4 | 4. Add 
notes at different times in the Pattern loop. Since we're recording in Overdub Mode, notes 
played at the same time as already recorded notes will be stacked into chords. Stop the 
music whenever you like. 
 
Now we'll change all of Pattern 4's notes back into rests. Select Pattern 4 by clicking on 
its Select Box, then choose Change to Rests from the Edit menu. Don't choose Clear. If 
you choose Clear, you'll have to add the rests again.  

 
Using Replace Mode 

 
Now enable Replace Mode from Pattern 4's Insertion Mode Picture Matrix. Your Select 
Box should look like this: 
 

 
 
Following the same procedures as described above, play some notes. This time, however, 
notes played at the same time as previously recorded notes will replace the previously 
recorded notes.  

 
Using Drum Machine Record Mode with a Drum Machine 

 
Drum Machine Record Mode can be very useful when using M to control drum 
machines. Once you're a little more familiar with the program, experiment with Drum 
Machine Record Mode in a way that will give you some interesting percussion patterns 
from your drum machine or sampler. There are lots of things you can do with Note 
Ordering, Accent, Rhythm, Note Density, Time Distortion, and other Variables that will 
take you far beyond the capabilities of any drum machine. You'll need to know what note 
numbers the sounds correspond to, but that shouldn't be hard to figure out using Echo-
Thru-Orchestration. 
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A Concluding Word 
 

Before you move on to the next chapter, disable Record for Pattern 4 and deselect Use 
Metronome in the Options menu. 
 
Then, if you like, listen to all four Voices. Click on Play-Enable for all Voices, or click 
on one button and drag to the others. Then click on the Start Button. Finally, stop the 
playback and choose Save from the File menu to save what you've done so far. 
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5 Editing Patterns 
 

In this chapter, we're going to show you how to use the Pattern Editor, how to use the 
special editing commands in the Pattern Menu, how to cut, copy and paste Patterns, and 
how to edit with the Output Length Numerical. 
 
M lets you perform all edit operations while the music is going, so you can hear the 
effects of your changes immediately. 
 
Start by opening your M Work file. 

 
 

Using The Pattern Editor 
 

To open the Pattern Editor Window, double-click on the Select Box for a Pattern. Or 
select a Pattern and then choose Edit... from the Pattern menu, in which case the Pattern 
Editor Window will open displaying the selected Pattern. Note that the items in the 
Pattern menu are not available if no Patterns have been selected. 
  
The Pattern Editor Window will appear. 

 
 

 
 

 
About the Pattern Editor 

 
The Pattern Editor is used for editing Patterns that you've already recorded. Its graphic 
tools can also be used for creating new Patterns. 
 
Notes in a Pattern are displayed in the Pattern Editor as darkened boxes in an Editing 
Grid. You can add or subtract notes by clicking in the Editing Grid with the mouse. You 
can also perform operations on the entire Pattern or on Regions of a Pattern with the Step 
Editing Tools, which you'll find in the upper right-hand corner of the Pattern Editor 
window.  
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You can also edit a Pattern with your MIDI keyboard, using M's Record Modes and 
Insertion Modes. 

 
 
The Editor Size Box 

 
Increase the size of the window by dragging the Size Box in the lower right-hand corner. 
This will be useful when you have Patterns with a lot of notes that you want to see all at 
once.  

 

Editor Size Box 
 

Moving the Window 
 

Next, try moving the window around on the screen by dragging the title. Move it to the 
upper left hand corner of the main screen, so that you can enlarge it downwards and to 
the right.  

 

 
 

The Pattern Size Numerical 
 

The Pattern Size Numerical allows you to increase the maximum number of notes you 
can potentially have in a Pattern. You can have up to 999 notes in a Pattern. 

 

 
 

Change the potential size of a Pattern by clicking and holding on the numerical for that 
Pattern. If you want to greatly increase the potential size, change the numerical as a 
slider. 
 
Note that you're increasing the potential size of the Pattern. You aren't adding new steps. 
The point of limiting a Pattern's potential size is to conserve computer memory. Setting 
up a large Pattern reserves that much space in memory for the notes you'll add to the 
Pattern. If you don't use all that note space, you're just wasting memory that might be put 
to better use elsewhere. 
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The Editing Grid 

 
Next, notice the numbers 1 - 4 under the word View to the right of the Editing Grid. The 
boxed-in number is the number of the currently displayed Pattern. Change to another 
Pattern by selecting another number. 

 
 

Go back to Pattern 1 by clicking on 1 under View. Notice that the lines of the Editing 
Grid are black in the area containing notes or rests. The empty part of the Editing Grid is 
drawn in gray lines. 

 

 
 
 

You can see the notes of two Patterns at once, if you like. Shift-click on 2 under View. 
The number 2 will be surrounded with a lighter box than number 1. 

 

 
 

The notes for Pattern 2 will be shown in gray in the Editing Grid. This indicates that 
you're "just looking" at the notes in Pattern 2, but you can still edit Pattern 1. 
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Re-size the window to see all the notes, if necessary. 
 
The Pattern Editor Editing Grid displays notes with pitches shown on the vertical axis, 
and time, in steps, shown on the horizontal axis. M's Patterns do not contain duration 
information. Duration information is determined in other parts of the program. 
 
You can scroll through pitches by clicking on either of the two scroll arrows to the left of 
the Editing Grid, above and below the keyboard. Click on the bottom arrow, for example, 
to see more pitches in the lower range. 

 
 

Scrolling vertically will change the Editing Grid's display of pitches in reference to the 
keyboards. As you scroll, notice that the pitch indicators at the ends of the left keyboard 
change, so you always know where you are.  
 
Scroll through the Editing Grid in octaves by clicking and holding on the octave icons 
next to the scroll arrows. Click on 8va to scroll up an octave. Then click on 8vb to scroll 
down an octave, so you're back to where you were. 
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Notice the Scroll Bar at the bottom of the Editing Grid. Hold down the mouse button on 
either arrow to see the Editing Grid scrolling horizontally through the steps of the Pattern. 

 

 
 
 

Clicking on the dotted area of the Scroll Bar "pages" you forwards or backwards by one 
full Editing Grid. Page ahead to the last spot in the Scroll Bar, then return to the 
beginning. 
 
Dragging the white box (called the Thumb) of the Scroll Bar places you at a location 
which is proportional to the maximum size of the Pattern. A Pattern's size is not the 
number of steps it contains, but the maximum number of steps it could contain. Do the 
same thing as you did with paging by dragging the Thumb to the far right, then back as 
far left as it will go. 
 

 
About the Editor Sound Enable 

 
At the bottom right of the window you'll see a speaker icon. Click on it if it's not 
highlighted. 
 

 
 

This lets you hear MIDI notes played through the current settings of the Orchestration 
Variable when you use the MIDI Edit Counter, described below. 

 
The MIDI Edit Counter 

 
You can play the notes in your Pattern "manually" with the MIDI Edit Counter, which 
sets the point at which recorded MIDI data will affect the Pattern. The MIDI Edit Counter 
is the black box below the Editing Grid, underneath the horizontal lines.  
 
Drag it along the bottom of the Editing Grid to play each step in your Pattern. If your 
Pattern is longer than the current width of the Editing Grid, you can drag the MIDI Edit 
Counter past the end of the Editing Grid and it will scroll along with you. 
 

 
 

Playing on the Grid Keyboard 
 

You can also play any note "graphically" through MIDI. Click on any note on the 
keyboard to the left of the Editing Grid. You'll hear the note played by whatever 
synthesizer is currently receiving the Pattern displayed in the Editing Grid. This 
technique is useful when you're creating Patterns directly in the Editing Grid and you 
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want to hear a note before you put it in. It's also useful when you're creating a Pattern 
that's designed to be used with a drum machine, since you can find the MIDI pitches that 
correspond to the different sounds on your drum machine. 
 
If the notes you play with the mouse aren't loud enough, try increasing the Velocity 
Numerical, which is just above the Editor Sound Enable speaker icon.  

 

 
 

 
Editing with the Mouse 

 
Click on 1 under View so that just Pattern 1 is displayed in the Editing Grid. Scroll the 
Editing Grid so that you can see all eight notes of the scale. 
 
In the Patterns Window (drag the Pattern Editor Window out of the way if you can't see 
the Patterns Window), deselect Play-Enable for all Voices except Voice 1. Click on the 
Start Button, in the Conducting Window. You should hear the notes of the C major scale 
as they're displayed in the Editing Grid of the Pattern Editor. 
 
Move the mouse into the Editing Grid and notice, as you move the mouse around, that 
note names are displayed next to the keyboard on the left and step numbers are displayed 
above the Editing Grid. Position  
the mouse at the intersection of step 9 and note D4 (you may need to scroll up or down to 
find this) and click. The step will fill in and the new note will be heard when the Pattern's 
playback gets to the last note. Click on the intersection of step 10 and E4. You'll be 
hearing a ten note C major scale. 

 

 
 

Click in various places throughout the Editing Grid while the music is playing. Even if 
your Pattern was originally recorded in Single Note Mode, you can create chords by 
clicking on different pitches in a column. You don't need to be in Chord or Build Mode, 
since they only apply to how the Pattern reads MIDI input. 
 
You can create chord clusters by dragging down through a column. You can repeat notes 
by dragging across in a row. 
 
You can delete a note from a step by clicking on a filled-in rectangle. Change step 2 to a 
rest, as shown below. 
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Now click on step 15 (scroll to get there if you need to) and notice that the steps between 
the old end of the Pattern and step 15 have been filled with rests, as shown below. 

 

 
 
 

The Step Editing Tools 
 

The Step Editing Tools allow you to work on groups of notes, rather than single notes. 
 
In the top right-hand corner of the Pattern Editor you'll see a row of four icons 
representing the four Step Editing Tools. The square with dotted lines is the Selector. 
You also have the Eraser, the Plunger, used for insertion, and the Scissors, used for 
deletion. These Step Editing Tools can be used to operate on single steps of a Pattern or 
on Regions of a Pattern. A Region is a block of any number of consecutive steps, from 
one to the total length of the Pattern. 
 
The Selector lets you select a Region of the Editing Grid in which to erase, insert, or 
delete. You can also select Regions in which the Pattern Menu commands will operate. 
 
The Eraser removes all the notes from a selected Region and replaces them with rests. 
 
The Plunger lets you add steps to your Pattern at any point within the Pattern. 
 
The Scissors removes selected steps from the Pattern and decreases the number of events 
in the Pattern accordingly. 
 
To select a tool, click on its icon. Once you've selected a tool, position the mouse directly 
above the Editing Grid. The mouse cursor will change to the selected tool.  
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Let's delete the extra notes in the C major scale that we added above. 
 
Select the Selector, position it over step 11 in the Editing Grid, then click and drag to step 
15. The selected area will be highlighted, as shown in the diagram. Note that you can 
select only Regions that contain notes or rests. 

 

 
 
 

Now we'll cut out the selected Region. Select the Scissors, position it over the selected 
Region in the Editing Grid and click, and the Pattern will contain only ten steps again. 

 

 
 

Restore the ten-note scale by clicking with the mouse at D3 for step 2. Now let's try the 
Eraser. First, using the Selector, select steps 5-10. 
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Now, select the Eraser and click above the selected region. All the steps turn to rests. 
 

 
 
 

You can also use the Eraser without selecting a Region. Click on a single column above 
the Editing Grid or click and drag along the top of the Editing Grid. Try erasing step 3 in 
this way. Restore step 3 again by clicking in the Editing Grid with the mouse. 
 
Next, to make a five-step Pattern, we'll delete the rests we just created. Select steps 5-10 
again, then select the Scissors, position it over the selected Region, and click.  

 

 
 
 

You can also click over unselected steps. Clicking repeatedly in one position will delete 
steps one by one. Delete step 5 in this way, so you're left with four steps. Restore step 5 
by clicking in the Editing Grid with the mouse. 
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Now we'll insert some new notes into the Pattern. Select the Plunger, position it over the 
Editing Grid at step 5, and click four times. 

 

 
 

The total number of steps in the Pattern will increase by four. You can now add notes by 
clicking in the Editing Grid. Just for the purposes of this tutorial, restore the eight-note C 
major scale.  

 
 

MIDI Editing 
 

What you've just been doing is graphically editing your Pattern. With another method, 
which we call MIDI Editing, you can add notes to a Pattern or change notes in a Pattern 
from your MIDI keyboard. It's basically the same process as recording the original 
Pattern, but MIDI Editing in the Pattern Editor gives you visual control of where notes 
are added. 
  
Since notes will be played from your keyboard to the Pattern, Record must be enabled for 
the Pattern you're editing. Enable Record for Pattern 1 and Play-Disable all Voices except 
Voice 1. Make sure that you can see Pattern 1 in the Editing Grid. 
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Then look at the area directly beneath the Grid. You'll see a bar made of thin lines which 
is called the MIDI Edit Range. The MIDI Edit Range defines the area on the Editing 
Grid that can be affected by incoming note data. Set the MIDI Edit Range to extend from 
step 5 to step 8. You can set it for one step more than the number of steps you already 
have in your Pattern. 
 

 
 

To set the MIDI Edit Range to the entire Pattern, click on the All Button in the lower 
right corner of the Pattern Editor Window. 
 

 
 

To set the MIDI Edit Range to the current step, indicated by the MIDI Edit Counter, click 
on the Ctr (Counter) Button next to the All Button. 
 

 
 

Now click on the All Button again and drag the MIDI Edit Counter (the black box below 
the MIDI Edit Range). Notice that you can move it only within the area designated by the 
MIDI Edit Range. Dragging the MIDI Edit Counter within the MIDI Edit Range sets the 
point from which MIDI data will affect the Pattern, setting an insert point for adding new 
notes, for instance. If you don't want to hear the notes in the Pattern as you drag the MIDI 
Edit Counter, deselect the speaker button at the bottom of the Pattern Editor Window. 
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Using the Record Modes 
 

The Pattern Editor gives you a copy of the Record Mode information shown in the Select 
Boxes in the Patterns Window. We call this the Mode Selector, and it's located to the 
right of the Editing Grid. 

 
Each column in the Mode Selector contains a Picture Matrix for changing Record, 
Insertion, and Drum Machine Modes. Click in the row for Pattern 1 in each column and 
select different items from the Picture Matrices. Notice that as you do, your selection is 
reproduced in the Select Box for Pattern 1 in the Patterns Window. 
 
Then, for Pattern 1, re-select Single Note Record Mode in the left column, re-select Insert 
Mode in the middle column, and deselect Drum Machine Record Mode in the last 
column. The Pattern 1 row should look like this: 
 

 
 

Now drag the MIDI Edit Counter so that it's under step 5.  
 

 
 

Drag the MIDI Edit Range from step 5 to step 8. 
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Be sure that Record is enabled for Pattern 1. Play the following notes in sequence on your 
MIDI keyboard:  D4, C4, B3, A3. You should see the notes appear in the Editing Grid 
before the G3 that was previously at step 5. Your Pattern should now consist of twelve 
steps. 

 

 
 

Notice that the MIDI Edit Counter stepped along as you played your keyboard. Insert 
Mode allows you to insert new notes before the current step. 
 
Single Note Mode turns chords into single steps. Play a C major triad and notice that 
three new notes appear in the Editing Grid. 
 
Select Chord Mode from the Chd Picture Matrix for Pattern 1, so that the Picture Matrix 
looks like this: 

 
 
 

Play a C major triad again and notice that it appears in the Editing Grid as a single step of 
three notes. Select the Scissors and delete the notes you just recorded so that we have a C 
major scale again. 
 
Re-select Single Note Record Mode for Pattern 1 and choose Replace Mode from the Ins 
Picture Matrix for Pattern 1. 
 

 
 

Replace Mode allows you to replace the current step with a new note. 
 
Position the MIDI Edit Counter under step 1. Play a G major scale on your MIDI 
keyboard. As you play the notes, notice that each note of the C major scale is replaced by 
a note of the G major scale, while the MIDI Edit Counter steps along beneath the Pattern. 
Drag the MIDI Edit Counter back to step 1 and play a C major scale again to get you 
back to where you were. 
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Now position the MIDI Edit Counter under step 5 and click on the Ctr Button to restrict 
the MIDI Edit Range to step 5. Play different notes on your keyboard and notice how 
each new note replaces the last, all on step 5. Play G3 to restore the scale. 
 
Then select Overdub Mode from the Ins Picture Matrix for Pattern 1. 

 

 
 

Overdub Mode lets you add new notes to the current step. Try playing some notes on 
your MIDI keyboard and observe that they appear in the Editing Grid in step 5 to form 
chords. 
 
If you're in Single Note Mode, each time you play a step the MIDI Edit Counter will 
advance so that you can overdub the next step. If you're in Chord Mode, you can play a 
chord over the contents of the current step. 
 
A word about Drum Machine Record Mode. We won't go over it again here, but you may 
want to try out the Drum Machine Record Mode tutorial again while watching what 
happens in the Editing Grid. 

 
 

The Pattern Menu Editing Commands 
 

The Pattern Menu contains a number of powerful commands that alter Pattern 
information as it's stored in memory. These commands operate on a selected Pattern or 
Patterns or on a selected Region. 
 
To use the Pattern Menu commands, select the Pattern or Patterns by clicking in the 
Pattern Select Boxes in the Patterns Window, or select a Region in the Editing Grid, then 
select the appropriate command in the Pattern Menu. 
 
To begin, close the Pattern Editor Window by clicking on its close triangle. Select Pattern 
1 in the Patterns Window, then re-open the Pattern Editor Window by choosing Edit... 
from the Pattern menu. Now we'll try some of the other editing commands while 
watching the results in the Editing Grid.  

 
Select Pattern 1 in the View Column, re-size and scroll the Editing Grid so that you can 
see all of the steps, and drag out a Region of several steps with the Selector. 

 
Transposing Patterns 

 
Choose Transpose Up Half Step from the Pattern menu. You'll see the selected Region 
move up a half step in the Editing Grid. Then choose Transpose Down Half Step from 
the Pattern menu. You'll see the selected Region move down a half step in the Editing 
Grid. 
 
Choose Transpose Up Octave from the Pattern menu. The Pattern will transpose up an 
octave in the Editing Grid. Choose Transpose Down Octave to restore the Pattern to its 
original key. 
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The Transposition commands in the Pattern Menu will transpose a selected Pattern as it is 
stored in memory. Note the difference between these commands and the controls in the 
Transposition Variable. The Transposition commands in the Pattern Menu change the key 
in which the selected Pattern was originally recorded. The controls in the Transposition 
Variable change the transposition of Voices during playback, leaving the Pattern stored in 
memory in the key in which it was originally recorded. 
 

Rotating Patterns 
 

Choose Rotate Forward from the Pattern menu and watch the Editing Grid. You'll see 
the last step in the Region rotate around to become the first step. The other notes will 
shift one step forward. Choose Rotate Backward, and watch the first step become the 
last, so that the Region is restored to its original order. 

 
Reversing the Order of Steps in a Pattern 

 
Choose Reverse Order from the Pattern menu and observe the Editing Grid. You'll see 
the Region reverse itself to become a descending scale. Choose Reverse Order again and 
the Region will return to its original state. 

 
Enlarging Patterns with Rests 

 
Choose Double with Rests from the Pattern menu while watching the Editing Grid. 
You'll see a rest inserted after every step in the Region. Select the Scissors and cut  out 
the rests. Then choose Triple with Rests from the Pattern menu. You'll see two rests 
inserted after every step in the Region. Notice in the Patterns Window that the number in 
the Output Length Numerical has increased as well. Choose Eliminate Rests from the 
Pattern menu, and you'll remove all the rests. 
 

Eliminating Chords 
 

Now, click on 3 in the View Column so that Pattern 3 is displayed in the Editing Grid. It 
should still have those large chords we recorded earlier when discussing Build Mode. 
Then select  
Eliminate Chords from the Pattern menu and watch what happens. You'll see the notes 
in the chords turned into individual steps. But be careful!  This operation is not 
reversible. 

 
The Edit Menu Commands 

 
Another way to edit your Patterns is with the commands in the Edit Menu. These 
commands operate on a selected Pattern or on a Region of the Pattern you've selected in 
the Editing Grid. 
 
Undo is unimplemented. 
 
Cut deletes the notes of the Pattern or Region and stores them on the computer 
Clipboard. 
 
Copy puts the selected Pattern or Region in the Clipboard without deleting it. 
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Paste replaces the selected Pattern or Region with the contents of the Clipboard. All 
aspects of the Pattern will be copied, such as Record Modes and Insert Modes. The 
number of steps pasted into a Region can't exceed the number of steps already in the 
Region. In other words, if you have a ten-note Region selected and try to paste in a 100-
note Region from the Clipboard, only the first ten notes of the new Region will be copied. 
If, however, you select the entire Pattern and then paste, the entire Clipboard contents 
will be pasted regardless of the number of notes already in the destination Region. 

 
Clear deletes the notes in the selected Pattern or Region.  
 
Paste Notes, unlike Paste, replaces only the notes of the selected Pattern or Region. 
 
Change to Rests removes all notes from a selected Pattern or Region without deleting 
steps. 
 
Fill with Rests fills an entire Pattern, up to its maximum size as determined in the size 
numerical, with rests. 
 
Paste at End will add the contents of the Clipboard to the end of the selected Pattern or 
Region. 

 
 
 

Editing with the Output Length Numerical 
 

In addition to creating blank Patterns, as discussed in the section on Drum Machine 
Record Mode, the Output Length Numerical can be used to add rests to the end of a 
Pattern or to delete notes from a Pattern.  
 
Select a Pattern and view it in the Editing Grid. Then, while pressing the Option key on 
the computer keyboard, increase the Output Length Numerical for the Pattern by 4. 
You've just added four rests to the Pattern. Now Option-click on the Numerical and 
change it back to the previous length; the four new rests are deleted from the end of the 
Pattern. 

 
Save your work before moving on. 
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6  Playing Voices 
 

In this chapter, we're going to discuss the controls that affect the playback of Voices. 
 
Open the M document called AT-2. This is a file with four simple Voices that will clearly 
illustrate the workings of some basic playback mechanisms. 

 
 

Hearing a Voice 
 

There are certain things you must do to be able to hear a Voice. 
 
 

Set Play-Enable 
 

Be sure that the Play-Enable Button for the Voice is on. For the moment, set the Play-
Enable for Voice 1. 

 
 

Select a MIDI output channel 
 

Be sure that the Voice is being sent on the MIDI channel you want, so that your 
synthesizer will receive it. Double-click on the first Position in the Orchestration Variable 
in the Midi Window so that the Orchestration Edit Window opens. 

 

 
 
 

Then click in the row for your Voice (in this case, Voice 1) under the numbers that 
correspond to the receive channel or channels of your synthesizers. In the Orchestration 
Edit Window shown above, Voice 1 is sending on MIDI channel 1, Voice 2 on channel 2, 
and so on. 
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Try sending a Voice on more than one MIDI channel by clicking in the appropriate MIDI 
channel boxes in the Voice row. 
 

 
 
You can send a Voice on any number of M Output Channels, but if you send a single 
Voice on too many Channels at once at a fast tempo, the music may slow down. 
 
The setting shown below merges Voices on a single Output Channel. 

 

 
 

 
Be sure that the Orchestration Edit Window shows an orchestration which matches your 
synthesizer setup. Then close the window. 

 
Set the Output Length 

 
Be sure that the Voice has an Output Length of something other than 0. If you can't 
change the Output Length from 0, it means that there aren't any notes present in the 
Pattern. 
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Set the Time Base 

 
Be sure that the Voice's Time Base Denominator is something other than sa, as shown 
below. sa is a special Time Base setting, used for playing a Voice from a MIDI keyboard. 
We'll discuss it in detail in Chapter 10. 

 

NO YES  
 

Set Note Density 
 

Be sure the Voice's Note Density is not set to 0 percent. At 0 percent, the Voice will 
never play. 

 

This Voice won't play

These Voices will play

 
 

Start and Stop 
 

When the program is playing, the Start Button is highlighted. 
 

 
 

The Start Button plays the four Voices "from the beginning."  If you click on the Start 
Button again, the Voices start over again in the same way. This is equivalent to pressing 
the Sync Button. 
 
Click on the Stop Button to stop the music. 

 
 

The Stop Button turns all the currently playing notes off, causing them to go into their 
normal envelope decays. If you stop playback by clicking on the Stop Button, you have 
no choice but to click on the Start Button to begin playing again, which will reset your 
Voices to the beginning. 
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An alternative to stopping the program is to pause it, using the Pause Button. Start the 
program playing again by clicking on the Start Button and then click on the Pause Button. 
The button will highlight. 

 
 

Click on the Pause Button again to resume playing, and the button will un-highlight. The 
Pause Button allows you to stop and start again at the same point—the Voices will "pick 
up from where they left off."  Unlike Stop, using Pause doesn't turn off any notes, it just 
keeps new notes from happening. This means that organ-type sounds will sustain 
indefinitely. Other sounds will sustain to their fullest extent. 
 
 

Other Playback Controls 
 

Setting a tempo 
 

Once the Voice is playing, we can change its tempo and hear the music slow down and 
speed up. The tempo control sets the overall basic speed of the M clock. All four Voices 
play in relation to the same tempo, although they may actually play at different speeds 
depending upon their Time Base and Rhythm settings. 
 
While your Voice is playing, do the following. 
 
Click at an appropriate place in the Tempo Range Bar, which will give you a specific 
value. As shown below, the Tempo Range Bar has been set to a tempo of 168. 
 

 
 

Try clicking at different points in the Tempo Range Bar. You'll hear the tempo "jump" to 
its new setting. 
 
Next try clicking and dragging in the Tempo Range Bar, which will give you a range of 
possible values. You can work within that range by changing the Tempo Numerical or by 
conducting the Tempo (we'll explain conducting in Chapter 8). 

 

 
 

You can drag in either direction within the Tempo Range Bar, from low to high or from 
high to low. The tempo will be set at the midpoint of the range you've selected. Once 
you've set a tempo range, try adjusting the tempo from the mid-point setting by changing 
the Tempo Numerical. If the music is going, you'll see a thin indicator showing where in 
the range the actual tempo lies. 
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Setting a range is essential when you want to conduct tempo, since the span of the 
Conducting Grid will be equal to that range. More details on this later. 

 
Using the Metronome 

 
The metronome is useful in certain recording situations, such as recording in Drum 
Machine Record Mode. It's especially useful in hearing complex rhythmic relationships 
between Voices. 
 
Start Voice 1. While you're listening to it, choose Use Metronome from the Options 
menu. You'll hear a periodic click from the speaker. (If it's not the right volume, adjust 
the volume with the Control Panel desk accessory.)  Because Voice 1 is playing eighth 
notes, you should hear one click for every two notes in the Voice. 

 
Now we'll adjust the Metronome's Time Base. The Metronome's Time Base is expressed 
as a ratio between the tempo pulse and the Metronome's click. In M, we think of tempo as 
always expressed in quarter notes. The Metronome can be changed to some multiple of 
those quarter notes.  
 
Try clicking on the quarter note icon at the far right of the Tempo Numerical. This is a 
Picture Numerical, meaning that it's changed as a numerical but it contains pictures 
instead of numbers. It will scroll up through eighth notes, eighth note triplets (an eighth 
note with 3 next to it), sixteenth notes and so on, and scroll down through quarter note 
triplets, half notes, etc. As you scroll, you'll hear the Metronome's click change in relation 
to the Voice's eighth note pulse .  

 
The usual setting for the Metronome is a quarter note. If you set the Tempo Numerical 
for 120 beats per minute and the Metronome's set for a quarter note, you'll hear 120 clicks 
every minute. Setting the Metronome Numerical for eighth notes will give you two clicks 
per tempo pulse. Setting it for half notes will give you one click for every two tempo 
pulses. 
 
Reset the Metronome Time Base to a quarter note and deselect Use Metronome from the 
Options Menu. 

 
Change the Output Length 

 
You can reduce the number of notes played from a Voice's Pattern by changing the 
Output Length Numerical. Start Voice 1 and decrease the Output Length Numerical to 4, 
as shown below. 
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Now change it to 1. You should hear one note played again and again. Now change it to 
0. What happens?  Set the Output Length Numerical back to its current maximum of 8. 
 
When you first create a Pattern, the Output Length Numerical will display the number of 
notes in the Pattern. When you changed the Output Length to something less than 8, you 
weren't deleting notes from the end of the Pattern, you were just making the Pattern start 
over before all of its notes were played. 
 
The Output Length can't be longer than the number of steps in the Pattern. However, if 
you Option-click while increasing the value of the Output Length Numerical, you can add 
rests. Refer back to the last chapter, under Editing with the Output Length Numerical. 
When you use the Option-click technique, the change to the Pattern isn't made until you 
release the mouse from the numerical, so you can adjust it to a precise value. 
 
You permanently delete notes if you hold down the Option key and decrease the value of 
the Output Length Numerical. 
 
 

Time Base and Phase 
 

The Time Base controls for each Voice consist of two numericals arranged as a fraction. 
You'll find these controls in the Patterns Window.  
 
For this section, set Voice 1's Time Base Numericals so that the fraction reads 1 over 4, 
as shown below. 

Numerator Denominator

 
 

Choose Use Metronome from the Options menu so that you can hear the tempo pulse. 
Make sure the Metronome Time Base, in the Conducting Window, is set at a quarter note. 
 
The Time Base Denominator, the number on the right of the fraction, sets the basic pulse 
of your Voice in relation to the overall tempo. A setting of 4 will play quarter notes. A 
setting of 6 gives you six notes for every whole note, equivalent to dotted eighth notes. 
 
Change Voice 1's denominator to 6. You should hear six notes for every four clicks of the 
metronome. Click on the Sync Button to make this relationship a little clearer. 
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The possible values for the Time Base Denominator are 1 through 9, 11, 12, 13, 15, 16, 
and 24. As you'll see, increasing the value of the Time Base Denominator speeds up the 
music. While the music is going try some different settings, then change the Time Base 
Denominator back to 4.  
 
The Time Base Numerator, on the left, is like a multiplier for the denominator that allows 
you to slow things down. If the Time Base Numerator is set to 3, for example, your Voice 
will play three times more slowly than it does if the Time Base Numerator is set to 1, no 
matter what the denominator is. 
 
Change Voice 1's Time Base Numerator to 3. You should hear a new note for every three 
clicks of the metronome. 

 
 

Change the Time Base Numerator back to 1. De-select Use Metronome.  
 
Anything Against Anything Else 
 

The Time Base controls are especially important in determining the time relationships 
between two or more Voices. You can set up interesting cross-rhythms or impossibly 
complex polyrhythms. 
 
Play-Enable Voice 2. Change its Time Base setting to 1 | 2. You should hear the melody 
in Voice 1 being played twice as fast as the chords in Voice 2, so that Voice 2 could be 
said to "accompany" Voice 1.  
 
Try the following combinations: 
 
• Voice 1 = 1 | 3, Voice 2 = 1 | 4 
• Voice 1 = 1 | 12, Voice 2 = 2 | 1 
• Voice 1 = 1 | 9, Voice 2 = 1 | 6 
• Voice 1 = 1 | 24, Voice 2 = 1 | 8 
• Voice 1 = 1 | 11, Voice 2 = 1 | 7 
 
It's often necessary to use the Sync Button with the Voices any time you change the Time 
Base Denominator, especially to a higher value. This is because the note relationships 
between the two Patterns change. 
 
When you're done, set both Voices' Time Base Numericals back to 1 | 4. 

 
Try a Little Phase 

 
The Phase Numerical is in the Patterns Window under the icon of two sine waves out of 
phase with each other. It sets the number of Ticks by which a Voice will be delayed 
before playing back. 
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A Tick is the smallest time division in M. M divides each quarter note (1 | 4 time base) 
into 96 Ticks. The Phase Numerical allows you to offset each Voice by any number of 
Ticks up to 199. 
 
To illustrate the use of the Phase Numerical, let's set up two identical Voices. First, select 
Pattern 1 by clicking on its Select Box. Then choose Copy from the Edit menu to copy 
Pattern 1 onto the Clipboard. 
 
Now, in the Variables Window, click on the b Position in the Pattern Group Variable.  

 

 
 
 

You've just switched the current Pattern Group to b, which is empty, so that you can 
paste your Pattern into it. We'll talk more about Pattern Groups in the next chapter. 
 
The title area of the Patterns Window should now read Patterns b.  
 
Select Pattern 1 by clicking on its Select Box. Choose Paste from the Edit menu. You 
should see the Output Length Numerical go to 8. Select Pattern 2 and choose Paste again. 
Now you have two identical  
Patterns to play with. Select sounds that have a percussive attack without much sustain, 
such as marimba sounds. 
 
Start the music. You should hear the two Voices playing in unison. Now, click on the 
Phase Numerical for Voice 2 and gradually increase the Phase offset for Voice 2. You're 
making Voice 2 go "out of phase" with Voice 1. As you increase the Phase value, Voice 
2 lags further and further behind. At first you should hear a subtle phase-shift effect, 
followed by a rhythmic offset. Increase the Phase Numerical to 48. You should hear 
Voice 2 exactly an eighth note behind Voice 1, creating an alternating effect. It's an 
eighth note because a quarter note is divided into 96 ticks, and 48 is half of 96. 
 
Let's do something else. Paste the same Pattern into the remaining blank Patterns, and 
Play-Enable all four Voices. Now change the Phase Numerical for Voices 2, 3, and 4 to 
creating a pseudo-digital delay effect. Try the following settings: 
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You might also want to experiment with your Orchestration Variable settings. One use of 
the Phase Numerical is to uncouple the attacks of all the Voices so that you achieve more 
of a "live" feeling in your music, rather than having it sound mechanical. 
 
To help you in Phase calculations, there's a table in the reference section on the Patterns 
Window which gives the number of Ticks for each Time Base unit. It's relatively easy to 
calculate yourself. Just divide 384 by the value of the Time Base Denominator. A 
denominator of 4 (a quarter note), for example, is 96 Ticks because 384 / 4 = 96. 

 
Remember to save your work, if you wish. 



 

67 

7   Variables 
 
 

 
In M, a Variable is some aspect of the music which can be changed. M offers you many 
Variables which you can use to introduce rhythmic and melodic variety into your music.  
 
In this rather long chapter, we're going to explain how to work with M's Variables.  
 
First, open the M Work file that you've been working with. 
 

 
Using M's Variables 

 
Each Variable has six alternative Positions (except for the Sound Choice Variable, which 
has 16). One of these is highlighted at any time, which is the Position that affects the 
music when M is playing.  
 
Each Variable is always doing something. The essence of using M is to shape what the 
Variables do until the total result suits you. You do this by using interactive Edit 
Windows to create alternative settings for each Variable. At the same time, on the main 
screen, you can be trying different combinations of these settings by selecting alternative 
Positions. 
 
Each Position in a Variable displays a miniature representation of its settings. Usually 
you'll see four rows of information, with each row affecting one Voice. 
 
Play-Enable all four Voices in the Patterns Window and start the music. Then click 
wildly on different Positions of the Variables on the screen. You'll hear the music change 
in different ways. 
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Now stop the music and re-select the first Positions of all the Variables. 
 

 
 

Editing Variables 
 

The actual settings that make up a Position in a Variable are changed in Edit Windows 
(with the exception of Pattern Group, which is changed in both the Patterns Window and 
the Pattern Editor; and the Sound Choice Variable, which is changed directly in the Midi 
Window). You've been using the Orchestration Edit Window extensively in the previous 
tutorial sections. 
 
You open Edit Windows by double-clicking on the Position of a Variable you want to 
alter. 
 
Open the Note Density Edit Window by double-clicking on the first Position in the Note 
Density Variable. 

 

 
 

 
Notice the group of six small boxes to the right of the window title. These are 
representations of the Variable Positions on the main screen. They show you which 
Position you're editing. You can also click in these boxes to select another Position to 
edit. Note that you can select a Position which isn't active on the main screen. This might 
be a bit confusing at first, but it's extremely powerful in performance. In the window 
shown above, we know we're editing the first Position of Note Density. 
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Click on the second box and notice how the settings in the Edit Window change. 
 

 
 
However, if you look in the Variables Window, you'll see that the first Position of Note 
Density is still the active one. 
 
If you do want to change the active Position of a Variable from inside an Edit Window, 
Option-click on one of the boxes. Option-click on the third box in the Note Density Edit 
Window and notice how the active Position of Note Density also changes to the third 
Position. 

 
 

Transposition 
 

The Transposition Variable allows you to transpose the four Voices relative to the keys 
in which you created their Patterns. 
 
The miniature representation of the Transposition Variable shows an alignment of bricks 
relative to a vertical line. A brick positioned to the right of the line indicates that the 
Voice will be transposed up by some amount. A brick positioned to the left of the line 
indicates the Voice will be transposed down. The farther a brick is away from the line, 
the greater the amount of transposition.  
 

Transpose Up

Transpose Down
No Transposition 

 
Double-click on the first Position of the Transposition Variable to open the Transposition 
Edit Window. 

 

 
 

In the Transposition Edit Window, each Voice is represented by a Note Numerical and by 
an Octave Numerical. The note refers to the key of transposition, where the key in which 
you've originally composed the Pattern is represented as C. Note that this is a relative 
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transposition. If you've made a Pattern in the key of F, for instance, a value of C3 in the 
Edit Window would still mean no transposition, and you would hear your Voice in F. A 
value of D3 would then transpose your Voice up two half steps to G. 
 
The Octave Numerical also refers to a relative position, where octave 3 is the octave of 
the original Pattern. If the Note Numerical is set to C, an Octave Numerical value of 4 
would transpose the Voice up an octave and an Octave of 2 would transpose the voice 
down an octave. 
 
Why this system?  Remember in the first tutorial when you transposed a Voice by 
playing on a MIDI keyboard?  The note and octave in the Edit Window represent the note 
you have to play to get a particular transposition. 
 
Now Play Disable all Voices except Voice 1. Then start the music.  
 
Click on the Note Numerical for Voice 1 so that it changes upward to C#. You'll hear 
Voice 1 transpose up a half step. 

 

 
 

If you keep increasing the Note Numerical, you'll be transposing by half steps. When you 
go above the note B, the Octave Numerical will increase automatically. Increase the Note 
Numerical until the transposition reads C#4. 

 

 
 

Now decrease the Octave Numerical by 1 so that the transposition is at C#3 again. 
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Play-Enable other Voices and try transposing them to different values. If you're 
conservative, a Transposition Variable Position would contain settings for the four 
Voices that were related by at least octaves, but obviously, this is not required. Again, 
when you're done, restore the transposition values to C3 and close the Edit Window. 

 
Note Density 

 
The Note Density Variable allows notes to be skipped. This is useful for varying the 
rhythm and texture of your Voices. 
 
Play-Disable all Voices except Voice 1. Then double-click on the first Position in the 
Note Density Variable to open the Note Density Edit Window. 

 

 
 

The individual Note Density controls are sliders which indicate the probability of a note 
being played.  
 
Start the music and drag Voice 1's slider to the left so that the numerical in the percentage 
column reads 50. You should now hear about half notes from the C major scale and half 
rests, although the particular notes of the scale that you'll hear are not predictable. 
 
Notes coming from a Pattern pass through a note density "filter" which decides whether 
they will be played or not. At a setting of 100 percent, every note from the Pattern will be 
played. With a setting of 50 percent, there's a 50-50 chance that M will play any 
particular note. If a note is not played, either the previous note will be held out or a "rest" 
will be played, depending upon how you want to think about it. 
 
To hear this, gradually increase the setting to 90 per cent by using the numerical next to 
the slider. Then Play-Enable the other voices and vary their Note Densities as well. 

 

 
 

When you've got a feel for what's happening, restore the note densities to 100 per cent for 
all four Voices. 
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The Note Density Variable is the first one we've looked at that gives us some way of 
varying rhythm — in this case, by leaving out notes. The next group of Variables we'll 
discuss, called Cyclic Variables, affect rhythm in a more deterministic way. Because of 
this, it's often best to start out with the Note Density Variables set at 100 percent, and 
then wait until you've set the other rhythm Variables before playing with the Note 
Density Variable. This order of events will make it easier to hear the Cyclic Variables in 
action. 

 
Velocity Range and Accents 

 
The Velocity Range Variable works in conjunction with the Accent Variable. It lets you 
establish ranges within which accent patterns will be generated. Because the range bars of 
the Velocity Range Variable are so responsive, you can quickly experiment with the 
balance between voices, or the exaggeration of accents. Since the Velocity Range 
Variable and the Accent Variable work with each other, we'll look at them together. 

 
Double-click in the first Position in the Velocity Range Variable to open the Velocity 
Range Edit Window. 
 

 
 

 
Drag this window down to the lower left-hand corner of the screen by clicking and 
dragging on its title. 
 
Then double-click on the first Position in the Accent Variable, in the Cyclic Variables 
Window, so that the Cyclic Editor opens with Accent selected, as shown below. 
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Drag the Cyclic Editor around the main screen, if necessary, so that you can see and work 
in both windows. 
 

About the Cyclic Editor  
 

Let's talk about the Cyclic Editor in general before we get to specifics. 
 
You create and edit Cyclic Variables in the Cyclic Editor. The Cyclic Variables are 
cycles of from one to sixteen steps that control accents, rhythms, and note articulations. 
With an Accent Cycle, for example, you can have one accented note followed by two 
unaccented notes. 

 
 

What's really cool about M's Cyclic Variables is that a particular step can be a range of 
values, rather than a single value, in which case M will pick a value from the range at 
random each time. 

 
 

By double-clicking on the first Position in the Accent Variable, you opened the Cyclic 
Editor to edit accents. You can edit all of the Cyclic Variables (Rhythm, Legato, and 
Accent) in the same Cyclic Editor Window. The Variable that's being edited is 
highlighted on the right side of the window. The information you create is the same for 
all three Cyclic Variables; it's just interpreted differently. 

 
Editing Operations 
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The four Editing Grids, top to bottom, represent the Cycles for each of the four Voices. 
The vertical lines within each Editing Grid are called steps, and they're numbered 
underneath. The horizontal lines are called levels, and they're numbered on the sides of 
the Editing Grid, from 0 to 4. Generally, a higher level indicates a higher value. As 
shown in the Editing Grid below, the cursor is pointing to the junction of step 4 and level 
3. 

 

  
 

To change the number of steps in a Cycle, click on a number below the Editing Grid. 
Clicking on 10, for example, will set up a Cycle of ten steps. 
 
Each step can have either a single value or a range of values. To set a single value for a 
step, click at the intersection of that step and the desired level. To set a range of values, 
drag the mouse between different levels. Each time M encounters a step in a Cycle which 
has a range of values, it will pick one of the values to use. 
 
You can also drag horizontally to set a number of steps to the same value, provided you 
don't exceed the Cycle length. 
 

 
 

Here are some example Cycles. To get used to using the Cyclic Editor, duplicate the 
Patterns you see below in the Editing Grid for Voice 1. 

 

 
 

The Cycle above will produce the same value, day in and day out, over and over again. 
It's exactly equivalent to this: 
 

 
 

The Cycle below will produce a continually varying result by picking randomly from all 
five available steps. 

 

 
 

Note that none of the Cycles we've made so far has been truly cyclic at all. They've been 
either constant or continuously varying. The following Cycle, however, does have a 
repetitive nature. It alternates between a high and low value. 
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Cyclic Variables Blink 
 

As an aid to understanding complex interactions between Cycles of different lengths, 
we've introduced the rhythmically blinking dot. The first step in the miniature 
representation of the active Position of a Cycle will blink each time the Cycle plays its 
first step (unless a Cycle contains only one step, in which case it won't blink). Every rule 
has its exception. 
 
And every silver lining has its cloud. If you have a lot of rapidly repeating Cycles, the 
amount of processing time M spends blinking dots can become considerable. If you find 
that your mouse is acting unresponsively, try choosing No Cyclic Blinking from the 
Options menu. 

 
Experimenting With Velocity Range and Accents 

 
Now, back to the Velocity Range Variable and its connection to the Accent Variable. The 
Accent Variable's levels 1-4 correspond to quarters of the filled-in area in the Velocity 
Range Bar. The diagram in the Cyclic Editor Window, as shown below, serves as a 
graphic reminder that accents, as played by the Cyclic Editor, are dependent on the 
settings of the Velocity Range Variable. 
 

 
 

A wide velocity range, set in the Velocity Range Variable, gives you wide changes in 
dynamics only if widely different accent levels have been set in the Cyclic Editor. A 
narrow range of  
values in the Cyclic Editor gives you small changes in dynamics. Of course, it also 
depends on how "velocity sensitive" the sound you're using happens to be. Let's try this 
out. Remember to use piano-type sounds for this experiment, which will make it easier to 
hear changes in velocity. 

 
Play-Disable all Voices except Voice 1. Start the music.  
 
Look at Voice 1's velocity range as set in the Velocity Range Edit Window below. It's a 
fairly wide range, but you don't hear any difference in dynamic level. This is because 
only one Accent level has been set for Voice 1 in the Cyclic Editor, as shown below. 
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Now, click on the number 4 below the Editing Grid for Voice 1. You'll see the Editing 
Grid as shown below. 
 

 
 

What you've done is set an Accent Cycle of four beats, with the first beat being strongly 
accented and the rest unaccented. If you don't hear these accents, try a different sound on 
your synthesizer by changing the appropriate Sound Choice Numerical.  
 
Next, click once anywhere in the Velocity Range Bar for Voice 1.  
 

 
 
 

You've set the Velocity Range Bar to a single value. Consequently, you'll hear only one 
accent level, even though you've set several values in the Cyclic Editor. Reset the 
Velocity Range Bar to a wide range of values by dragging within the bar. You can fine-
tune the range with the numericals on either end of the bar. Do you hear the differences in 
accent again? 
 
Next, try drawing out small ranges, starting at the left end and proceeding toward the 
right end of the velocity range bar. This will show you how you can think of the velocity 
range both as an amount of accent and as kind of volume control to set loud Voices 
against soft ones. This can be particularly effective when you've set up each of the six 
Velocity Range Variable Positions for unique dynamic contrasts between the four Voices, 
as shown in the group of four Velocity Range Positions below, where each Position 
"features" a different voice. 
 

 
 

More About Accent Cycles 
 

For each step of an Accent Cycle, we have five levels of accent that correspond to MIDI 
velocity values. 0 means that any note or chord at the step will not be heard. 1-4 represent 
progressively higher levels of accent, as mentioned above. 
 
Start the music for Voice 1, if it's not still playing. Now, position the mouse at the 
intersection of step 2 and level 0 for Voice 1 and click. You'll see what's shown below. 
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What you should be hearing is an Accent Cycle of one loud note, a rest, and two soft 
notes. 
 
Now click on level 1 for step 2, so that you can hear a note on the second step. Then click 
on level 4 at step 4 and drag down to level 1, so that you get the Cycle shown below. 

 

 
 
 

This is an Accent Cycle of a loud note, two soft notes, and a note of varying accent. What 
you've done is to set step 4 so that the program can select randomly from among the 
different accent levels. Listen to the Cycle several times through to verify that step 4 is 
different each time. 
 
Now drag down the column at step 4 from level 4 to level 0. You should occasionally 
(about 20 percent of the time) hear a rest at step 4. 
 
Now make a longer Accent Cycle of 16 steps for Voice 1 by clicking on the number 16 
below the Editing Grid. As you're listening to the results, experiment with different levels 
at each step. Then, in the Patterns Window, adjust the Voice's Time Base to 1 | 16. Set a 
number of steps to level 0 in odd places, like the Cycle shown below. 

 

 
 
 

Then Play-Enable other Voices and change their Accent Cycles. Remember that you set 
the range of accent levels in the Velocity Range Variable. 
 
When you've finished experimenting, reset each Accent Cycle to one step at level 4, as 
shown below. We're doing this to make the accents constant so that we can hear the effect 
of the other Cyclic Variables clearly. 
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Close the Velocity Range Edit Window, but leave the Cyclic Editor open. Then, in the 
Patterns Window, set Voice 1's Time Base back to a more subdued 1 | 4. 

 
 

Creating Rhythms 
 

Click on the button labeled Rhythm in the Cyclic Editor. You'll see the window as 
shown below. Make sure that the first Rhythm Variable Position is selected for editing, 
and that it's also the active Position in the Cyclic Variables Window. In other words, you 
want to edit the Rhythm that's actually going to affect the music. 
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The Rhythm Variable lets you set the amount of time between the beginning of one note 
and the beginning of the next. A Rhythm Cycle consists of steps which express how 
much time to wait after playing a note before playing the next one. This time is expressed 
in multiples of the Voice's Time Base, as determined in the Patterns Window, so that a 
Voice's overall rhythm remains in the same relationship regardless of its Time Base. This 
relationship is illustrated below. 
 

with a Time Base of:

using Rhythm Values of:

gives you durations of:

with a Time Base of:

using Rhythm Values of:

gives you durations of:
 

 
 
Here's an example. Set Voice 1's Time Base to 1 | 8, or eighth notes. Make a Rhythm 
Cycle for Voice 1 that looks like this: 
 

 
 

 
Play-Enable only Voice 1. Then start the music. You should hear a jumpy, swingin' sort 
of rhythm from Voice 1.  
 
Now set Voice 1's Time Base to 1 | 6. The jumpy, triplet-feel aspect of the rhythm 
remains the same, but the speed of the Voice has slowed down. Try a Time Base of 1 | 4, 
then try 1 | 16. Ya gotta love those 32nd notes. 

 
Rhythm Values 
 

How do we know how different levels in the Rhythm Cycle actually multiply the Time 
Base?  It's done quite flexibly with the Rhythm Value Numericals. At the far right of 
the Cyclic Editor, you'll see a column of numericals, as shown below: 
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These are the actual "multiplication factors" assigned to each step for all Rhythm Cycles 
throughout the program. Let's do an actual calculation in Ticks, M's basic timing unit, to 
show you how rhythm values are determined. 
 
At the moment, we're using levels 0 and 1 in our Rhythm Cycle. According to the 
Rhythm Value Numericals, level 0 is .5 and level 1 is 1. The number of Ticks for a 16th 
note (Time Base 1 | 16) is 24, where a Tick, as you may recall from our discussion of 
Phase in Chapter 6, is one 96th of a quarter note. You calculate the number of Ticks for 
any value of the Time Base by multiplying the Time Base by 384. For example, 384 * (1 | 
4) = 96. Or 384 * (1 | 16) = 24. 
 
So, for step 1, we have 24 * 1 (the rhythm value for level 1) = 24 Ticks. For step 2, we 
have 24 * .5  (the rhythm value for level 0) = 12 Ticks.  
 
Now change the Time Base to 1 | 6. 384 * (1 | 6) = 64, so step 1 is 64 ticks and step 2 is 
32 ticks. 
  
Unless you're really numerically-minded, you probably won't count Ticks like this, so 
don't worry if this discussion ticked you off, so to speak. We just wanted to give you a 
feeling for the interrelationship between the Rhythm Cycle, the Rhythm Value 
Numericals, and the Time Base. 
 
While listening to the music, change the Rhythm Value Numerical assigned to level 0 to 
1. Now the rhythm you hear should be perfectly even. Now set it to 1.5. The rhythm 
becomes uneven and slightly jumpy again. It should be. It's based in 5-tuplets! 

 
Weighting Rhythmic Randomness 

 
Note that you were able to define level 0 in the Rhythm Value Numericals to generate the 
same or even a higher time value than level 1. For clarity in looking at rhythms and 
figuring out what's going on, we suggest leaving them in ascending order at first, but 
there are some very creative things you can do with the rhythm numericals. Here's one of 
them: 
 
Change your Rhythm Cycle to look like the one below. 

 

 
 

Now set the Rhythm Value Numericals as shown below, so that the lowest one is .5, the 
next three are 1, and the top one is 1.5. 

 

 
 
 

What you should hear now is a rhythm which is generally even, but occasionally gets 
"off" by a factor of a half. Change the Time Base of Voice 1 to 1 | 4, and listen to this 
Voice against another one which has a Time Base of 1 | 4. 
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What's going on here is that when M encounters step 4 in the Rhythm Cycle, it chooses 
one of the five levels in the range you've drawn out. But since most of the levels generate 
a value of 1, most of the time the rhythm is always the same as it is for the other three 
steps, which always generate a value of 1. Two chances in five, the Rhythm Cycle will 
produce a value of .5 or 1.5 to mess things up (or straighten them out again). 
 
Note that there's only one set of numericals and that they apply to all the Rhythm Cycles 
in the program. So you can't compose a Rhythm Cycle for one Voice and then expect to 
use a new set of numericals for the next one. 
 
As you explore what you can do with rhythmic relationships between Voices, you may 
need to use the Sync Button to realign the Rhythm Cycles with each other. 
 
So that we can hear more clearly the effects of the other Variables, change the Rhythm 
Cycle for Voice 1 back to one step and one level, as shown below. Leave the Cyclic 
Editor open. 

 

 
 

 
Working with Phrasing 
 

The Legato Variable lets you create Cycles of note articulations, or phrasing. A staccato 
note is different from a legato note in that it is released very shortly after it starts, leaving 
some silence until the next note begins. A legato note leaves little silence before the next 
note and may even overlap subsequent notes. Of course, for you to be able to hear this 
sort of thing, you must have a sound on your synthesizer that can be sustained. Percussive 
sounds won't allow you to hear much difference. Generally, the sounds most sensitive to 
legato and staccato phrasing will resemble woodwinds, such as a clarinet. An organ tone 
will also work very nicely, and even a piano sound can be effective.  
 
The way to tell, of course, is to phrase the sound yourself on a keyboard. Is there a 
difference in playing staccato notes as against holding the key down for a while?  For 
demonstrating the Legato Variable, choose a sound on your synthesizer that you can 
phrase effectively. 
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Select the Legato Button in the Cyclic Editor, so that the window opens as shown. 
 

 
 
 

As with Rhythm, the actual values of the Legato Variable are determined by a set of 
Legato Value Numericals. As you can see, the current values for Legato are 100, 75, 50, 
25, and 6. These numbers express how long the note will be sustained as a percentage of 
the time between the onset of a note and the onset of the next one. The concept is 
illustrated in the diagram below. 

 
1 | 4a Time Base of:

with Legato values of:

gives you notes sustained for:

 
 

 
Make sure you're editing the first Position in the Legato Variable, and also be sure that 
the first Position is the active one. The top Legato Cycle should look like this: 

 

 
 

Start the music and listen to Voice 1 alone. You should hear a steady pulse with the notes 
in the Voice each sustaining for about half a quarter note. 
 
Next, click on level 4 for step 1. You should hear each note sustain for the full quarter 
note. 
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The best way to illustrate that Legato is a percentage of the time between notes is to play 
with the Time Base Denominator. Change it to 1 | 1 for Voice 1. Now the notes sustain 
much longer, but they don't overlap or cut out early.  
 
Now click on level 1 in step 1 of the Legato Cycle. The notes cut off shortly after being 
played, but one wouldn't necessarily characterize the feeling as staccato. Change the 
Time Base to 1 | 16. As your mother might say, "Now that's staccato!". But the point is 
that the proportion of time between notes that the note is held remains constant. Return 
the Time Base to a more subdued 1 | 4 again. We don't want you to get too excited. 
 
Now we'll set some Legato Cycles. Create the one shown below for Voice 1. You should 
hear three staccato notes (short sustain) followed by one legato note (long sustain). 
 

 
 

Now we'll use one of M's unique features — that of wildly overlapping notes. Change the 
top Legato Value Numerical, the one assigned to level 4, to 400 per cent. Now the fourth 
note in the Cycle sustains over the other three. If your synthesizer is anything like ours, 
it'll probably start to cut off some of these sustaining notes after a while, or the sound 
you're using may just die out on its own, but these are things you need to determine as 
you work. Organ sounds often sustain indefinitely, so extremely long sustained notes can 
be heard to best advantage. 
 
Reset the value for level 4 to 100 per cent. As with the Rhythm Variable, Legato value 
assignments apply to all Legato Cycles at all Variable Positions. 

 
Click on step 4 at level 4 and drag the cursor down to 0. You should hear a Cycle of three 
short notes and one note of randomly varying articulations—sometimes long, sometimes 
short. 

 

 
 

Making the phrasing vary like this in certain places is quite effective in adding that 
human element we're all searching for. And as with the Rhythm values, you can weight 
the randomness by manipulating the table of Legato values in clever ways. 

 
Cyclic Editor Interactions 

 
Before leaving the Cyclic Variables, it's important to make a point about how the three 
Cyclic Variables relate to one another. Set the Cyclic Editor so that you can edit the first 
Rhythm Variable Position. Make a rhythm with two steps like the one shown below. 
 

 
 



 

84 

As you listen to the effect of the Legato Cycle, notice that it tracks the rhythm. In other 
words, the Rhythm Variable is responsible for deciding when to advance the Legato 
Cycle to its next step. This is also true for the Accent Cycle. 
 
What this means is that even though you have a Legato Cycle which has four steps in it, 
it's not necessarily going to be exactly four quarter notes in length. Right now, for 
example, the Legato pattern of length 4 will reset every three quarter notes. In that space 
of time however, four events (or rests) will have been played, each of which will have 
used a successive step from the Legato Cycle. 
 
That covers the Cyclic Editor. It's what makes a plodding series of notes in a Pattern 
come alive into a full-fledged Voice. If you know what's good for you, you'll be spending 
a lot of your time coming to grips with its power. Work with it for awhile to get a feeling 
for how the Cyclic Variables affect each other.  
 
 

Time Distortion 
 

No doubt many of you have been asking yourselves, "What is time distortion anyway?" 
and "How can time be distorted here on Earth?"  You're about to find out. 
 
The Time Distortion Variable lets you speed up and slow down a Voice within a fixed 
amount of time. You've all heard a "swing" or shuffle rhythm. It's simply a slowing down 
and then a speeding up in the space of a quarter note, so that the eighth note in the middle 
is delayed. The Time Distortion Map for swing looks like this: 

 

 
 
 

If you choose to distort a longer period of time, say, a whole measure, then you could call 
Time Distortion rubato. The thing about rubato playing is that over the whole song, the 
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tempo is consistent. Here too, the same amount of time will go by when you use a Time 
Distortion Map, it'll just go by rather, well, distorted.  
 
Double-click on the first Position in the Time Distortion Variable. The Time Distortion 
Edit Window opens with a neutral Time Distortion Map. The various controls in the 
window are labelled in the diagram below. 

 

Map Edit
Selector Length Numericals

Time

Graph

Real Time

Cl
oc

k 
Ti

m
e

Map Clear Button

 
 

The central feature of the Time Distortion Map is a graph, represented as a diagonal line. 
The horizontal axis is Real Time. The vertical axis is Clock Time. Real Time refers to 
how much time has actually gone by. Clock Time refers to how many ticks of M's clock 
have occurred. The length of time covered by the map is variable with the Length 
Numericals. The graph shown above covers the space of a quarter note, and shows a 
normal relationship between Real Time and Clock Time, in that ticks of the clock take a 
consistent amount of Real Time. 
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In the next map, however, the Voice would play very fast at first and then slow down 
drastically to fit the chosen amount of Clock Time. This is because almost all the clock 
ticks occur within the first few moments of Real Time. 

 

 
 
 

Let's try plotting the map you see above. First, set the Length Numerical to eight quarter 
notes, as shown above. Just change the number 1 to a value of 8 and leave the quarter 
note alone. 
 
Next, click the mouse where you see the sharp corner of the graph above. The cursor 
turns into what is sometimes called a  "bombsight."  Once you release the mouse, you've 
set a breakpoint. A line is automatically drawn from the lower left corner of the map to 
the breakpoint you've made. And the cursor appears to be attached to a "string" which 
shows you where the line would go if you were to click the mouse at its current Position 
to set another breakpoint. 
 
To finish the map, move to the upper right-hand corner and double-click. If you've 
succeeded in completing the map, the cursor will turn back into an arrow, and the string 
won't be following you around. If this didn't happen, try double-clicking again. 
 
Start the music. You should hear a flurry of notes, followed by a few very slow notes. 
After eight quarter notes, the flurry starts again. The Voice will repeat its Time Distortion 
Cycle until you get tired of listening to it and stop the music. 
 
Now, to clear Voice 1's map, click on the Clear Button at the top of the Edit Window.  
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Let's try drawing a new map for Voice 1. This time, we'll make the map line cross the 
center line several times, which will give us a constant increase and decrease in the speed 
of the notes. 

 

 
 
 

Click on the graph at the corner indicated by the words Start Here in the figure above. 
Move the mouse to the next breakpoint, click again, and so forth until you reach the top. 
Notice that you must always have the map increasing in time for both axes. The reason 
for this is that although you can distort time, you can't go backwards into it. Rest assured, 
however, that we at Intelligent Music are looking into this problem. 
 
Finish the map by double-clicking near the upper right-hand corner. 
 
Start the music and listen to Voice 1 constantly speeding up and slowing down. 
 
You can edit an existing time map by tugging on the breakpoints. The cursor changes to a 
heavy arrow to indicate you're changing an existing map, rather than creating a new one. 
Try making the map you created above less angular by dragging the breakpoints towards 
the center. 
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Each Voice can have its own Time Distortion Map at each Position of the Time 
Distortion Variable. You can work on a Time Distortion Map for Voice 2 by clicking on 
the number 2 next to the word Edit: above the graph. At this point, Voice 1's Time 
Distortion Map is redrawn in a thin line, and you see Voice 2's map as a heavy line that is 
set to the default ineffectual setting. At any time, the map you're working on will be 
drawn in a heavier line that the others. 

 

 
 

 
Make an ensemble of Time Distortion Maps such as the one shown above. 
 
We suggest that you keep one Position (such as Position 1) of the Time Distortion 
Variable free of maps, so that you have a rhythmically neutral setting available when 
working with other rhythm Variables. 

 
Working With Rhythm 

 
The Note Density, Velocity Range, and Time Distortion Variables and the Accent, 
Legato and Rhythm Cyclic Variables all affect rhythm, phrasing, and dynamics in one 
way or another. Once you understand how they work, you can do things that are 
impossible and even dangerous with conventional sequencers and composition programs.  
 
Working with all these Variables together can be a little intimidating, however, so it helps 
to keep a Position of each Variable which does little or nothing to the music. That way, if 
ever you get confused about why the music sounds the way it does, you can click on 
these "safe" Positions until you figure out what's happening. Using these special Positions 
may also help you concentrate on modifying the Variable of interest without being 
bothered by extraneous information.  
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Note Order 
 

The Note Order Variable reorders the notes in your Pattern, creating new melodies from 
the ones you've recorded. You create a note order setting interactively, so that you can 
come up with the values that suit a particular musical result. And you can use as much as 
or as little reordering as you want, or dispense with it altogether, as we've been doing 
thus far. 
 
Open the Note Order Edit Window by double-clicking on the first Position of the Note 
Order Variable. 

 

 
 

The Note Order Edit Window will appear. 
 

 
 

The Note Order Edit Window allows you to mix three kinds of note orderings. As 
indicated at the bottom of the Edit Window, each ordering scheme, as represented in the 
Note Order Edit Window, has a different "color" associated with it. 
 
Original Order (solid) means that the Voice will play the notes back in the exact order 
that you recorded them. The window above is set for 100 percent Original Order on all 
four Voices. 
   
Cyclic Random (gray) means that the ordering of the notes of your Pattern has been 
recomposed and stored as a "copy" of the original Pattern. If you listen to a Voice with 
100 per cent Cyclic Random ordering, it will be just as repetitive as it would be with 
Original Ordering. 
 
Utterly Random (polka dot) means that M will continually pick a note or chord from an 
arbitrary place in your Pattern as it's playing. Remember, the notes aren't new, but the 
order they're played in is. Unless you have only one note in your Pattern, Utterly Random 
ordering is nonrepetitive. 
 
Now start the music and listen to Voice 1. You should hear the C major scale in order 
from low C to high C. 
 
We're going to change Voice 1's Note Order to 100 per cent Utterly Random. Click on 
the middle numerical-like box and drag it to the left, until the number inside reads 0 and 
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the number in the far-right box, which is the box that indicates the percentage of Utterly 
Random ordering, reads 100. 

 

 
 
 

The bar is completely polka-dotted, to indicate that it's truly Utterly Random, and you 
should hear a random, non-repetitive reordering of the C major scale. 
 
Now slide the middle box back to the far right-hand side of the bar. As you do this, the 
bar turns completely gray. 

 

 
 

You're hearing a random reordering of the C major scale which repeats every eight notes. 
 
If you're not satisfied with the variation, or if you just want to hear another one, you can 
change the Cyclic Random ordering without affecting the original Pattern. Select Pattern 
1 in the Patterns Window, then choose ReScramble from the Pattern menu. You should 
be hearing a new Cyclic Random ordering of the notes of the C major scale. 
 
Now let's do something more interesting. Slide the far-left box, representing Original 
Order, toward the center, and pause when you've reached about 50 per cent. Slowly 
increase the Original Order percentage toward, say, 95 per cent. If you listen carefully, 
you should begin to hear the feeling of the scale "emerge" from behind the randomly 
reordered melody. What's happening now is that the Voice picks notes from the Pattern's 
original order most of the time, but it occasionally picks notes from the Cyclic Random 
ordering. 
 
Play with the user interface of the Note Order Edit Window. It's one of those things that's 
hard to explain but easy to figure out intuitively. Just to summarize: 
 
• Slide the left-hand box to increase or decrease Original Order. 
• Slide the middle box to the left to increase Utterly Random. 
• Slide the middle box to the right to increase Cyclic Random by decreasing Utterly 
Random. 
• Slide the left-hand box to the left to increase Cyclic Random by decreasing Original 
Order. 
• Don't slide the right box (it doesn't move). 
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The Pattern Group Variable 
 

The Pattern Group Variable is a bit different from the other Variables, in that you don't 
double-click on it to edit its settings. This is because its Edit Window is really the 
Patterns Window, which is always open. 
 
A Pattern Group stores the notes and chords of four Patterns, one for each Voice. It also 
stores many of the settings you see in the Patterns Window, including: 
 
• Output Length 
• Time Base 
• Phase 
• Record Modes (Chord, Insert, and Drum Machine) 
 
The miniature representation of a Pattern Group is a box which contains up to four bricks. 
The presence of a brick indicates whether or not there is any musical material stored in a 
Pattern. A brick flashes each time the Pattern it represents starts playing over again. This 
can help you keep track of what step in a Pattern is currently playing. And besides, it 
looks cool. 
 
Start the music and select the Pattern Group b Position, which at this point should have 
two bricks, assuming that you haven't made some Patterns on your own. Notice that the 
settings in the Patterns Window change, as well as the title, which is now Patterns b. 

 

 
 
 

When you want to make Patterns in a new Pattern Group, just select a blank Position in 
the Pattern Group Variable. The active group letter will be displayed in the title of both 
the Patterns Window and the Pattern Editor. 

 
Orchestration 

 
Since we've already discussed the Orchestration Variable in Chapter 6, we won't cover it 
in detail again here. 
 
But we would like to observe that creating alternative Positions for the Orchestration 
Variable can be an effective way to introduce changes in your music during performance. 
Let's say you have a configuration of channels and voices like the one below, with one 
channel for each Voice, in Position 1. 
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Now create Position 2 for Orchestration as shown below.  

 

 
 

Start the music. Click on Position 2.  
 
The effect will be that of all four instruments suddenly deciding to play the same line in 
unison. And the change happens much more smoothly than sending your synthesizer a 
program change, because any notes still playing are not cut off by a change in 
orchestration. 
 
Many people also like to work with the Orchestration Edit Window open all the time, 
especially in combination with the Sound Choice Variable discussed below. This process 
of orchestrating Voices can happen exceedingly fast in the interactive M environment. 
 

Sound Choice 
 

The Sound Choice Variable lets you send MIDI program changes to your synthesizers in 
real time. It also lets you save groups of program changes as presets. You can have up to 
sixteen different presets of program changes for each MIDI channel. 
 
The Sound Choice Variable consists of two rows of sixteen boxes. The top row indicates 
the current Variable Position, which is highlighted. It also shows the MIDI channel 
associated with the numerical box below which contains a program change number. 

 
MIDI Channels and Sound Choice Variable Positions

Program Change Numericals  
 
 

Let's use the Sound Choice Numericals. Select Pattern Group a again, Play-Enable the 
four Voices, and start the music.  
 
Now change a Sound Choice Numerical below the MIDI channel number that 
corresponds to one of your synthesizers. Notice that the program change won't actually 
be sent until you release the mouse button. This is different than the way numericals work 
in the rest of the program. 
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Next we'll create two Sound Choice presets. Click on the number 2 in the top row to 
select the second Variable Position. Set some different program change numbers for 
sounds you like in the appropriate boxes. Setting the numerical to an empty box (the 
lowest setting of the numerical) means that no program change is sent when you select 
that Position. 
 
Now, switch back and forth between presets 1 and 2 and listen to the sounds change. 
When you select a preset, the numbers indicated by the numericals are sent as program 
changes on the selected MIDI channels. 

 
Program Number Confusion 

 
You may or may not know this, but synthesizer manufacturers have not managed to agree 
on how to display the numbers of program changes on the front panels of their 
instruments. M's default behavior is to use program numbers that start at 1 and go to 128. 
This is used by instruments made by Yamaha, for example. Other manufacturers, such as 
Oberheim, start their numbering at 0 and go to 127. Still other synthesizers, such as the 
Ensoniq ESQ-1, use other schemes for numbering the programs that may not even 
correspond to decimal numbers. Such is life. 
 
One thing we have included in the software to make life a little easier is an option for 
each MIDI channel as to whether you want programs to be displayed as 0-127 or 1-128. 
This is accessed in the Midi Assignment Window, discussed in Chapter 13. 
 
Remember to save your work before you move on. 
 

Performing with Variables 
 

One of the main reasons there are six Positions for each Variable is that you can switch 
between Positions in performance to make subtle or dramatic changes to the music in real 
time. A number of methods are available to do this switching: 
 
• Just clicking on a Position 
• Conducting with the Baton, or through MIDI (Chapter 8) 
• Using the Hold/Do Button (Chapter 9) 
• Performing with the Input Control System (Chapter 10) 
• Performing with Snapshots and Slideshows (Chapter 9) 
 
In addition, you can use Edit Windows as performance devices. The Velocity Range Edit 
Window is the most obvious example. Try constantly changing the steps in Accent and 
Legato Cycles of fixed length. Or try changing channel/Voice assignments in the 
Orchestration Variable. In planning a performance, you might want to reserve a Variable 
Position for this kind of work. 
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8  Conducting 
 
 
 

Conducting is a special performance technique that essentially lets you change the 
selected Positions of many Variables simultaneously. 
 
In this chapter, we'll discuss various techniques for conducting. 
 
Start by opening AT-2. For this tutorial, select the first Position in each Variable and 
Play-Enable Voice 1 in Pattern Group a. 

 
 

About Conducting 
 

The importance of conducting as a performance technique is that it provides a powerful 
way of selecting and associating Variable Positions. Move the cursor into the 
Conducting Grid, in the Conducting Window. 

 

 
 
 

The cursor turns into the Baton. Press the button and presto!— the baton in the 
conductor's hand is raised. Drag the Baton around in the Conducting Grid, occasionally 
clicking the mouse button. Notice that a black dot is left in the Conducting Grid at the 
place where you clicked. 

 
Selecting Variables and Controls for Conducting 

 
Any Variable or control that has a Conducting Arrow  associated with it can be 
conducted. These include all eleven Variables plus Tempo and Snapshots. Look around 
the main screen and notice that there are boxes with arrows in them next to the name of 
each Variable, as well as to the left of the Tempo Range Bar, and below the camera icon 
in the Snapshot Window.  

 

 
 
They're the Conducting Arrows. You enable a Variable for conducting by selecting its 
Conducting Arrow. Click on the Conducting Arrow next to Note Density and quickly 
release the mouse button. The selected Conducting Arrow will look like this: 
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Now click on the Conducting Arrow again, quickly releasing the button. It will un-
highlight and conducting will be disabled. 

 

 
 

Okay, this may seem repetitive, but select the Note Density Conducting Arrow again to 
enable it for conducting. 

 
The direction in which a Conducting Arrow is pointing indicates the axis in the 
Conducting Grid along which its associated Variable is conducted. If a Conducting 
Arrow is pointing towards the right, for example, the associated Variable's Positions will 
be conducted from left to right. If the Conducting Arrow is pointing upwards, the 
associated Variable's Positions will be conducted from bottom to top. 
 

Conducting Direction

Conducting Direction  
 

Move the Baton into the Conducting Grid. Drag the mouse from left to right and back 
again, and notice how the Positions in the Note Density Variable change. 
 
Now let's change the direction of conducting. Click and hold on the Note Density 
Conducting Arrow. Watch it rotate around as long as you hold. Release the mouse button 
when the Conducting Arrow is pointing towards the left, like this: 
 

 
 

Move the mouse back into the Conducting Grid and drag from left to right again. Notice 
that the active Position of the Variable now moves from right to left. 
 
Then go back to the Note Density Conducting Arrow and change its direction to point 
upwards, then return to the Conducting Grid and drag the mouse from top to bottom and 
back again. When you've finished, deselect the Note Density Conducting Arrow. 
 
There's another way to change the Conducting Arrow direction that you might like a bit 
more than waiting for the Conducting Arrow to rotate around to the desired direction. 
We're going to be conducting tempo next, so move to the Conducting Arrow next to the 
Tempo Range Bar and click on it. Then drag the mouse to the right, outside of the box 
around the Conducting Arrow, and move in a circle. You'll see that the Conducting 
Arrow follows the mouse and changes direction as you move. Refer to the diagram in 
Chapter 2, page 5. 
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Conducting Tempo 
 
Now that we've seen conducting in action, we'll actually listen to ourselves conducting 
tempo, which is probably the most "traditional" conducting activity you can do with M. 
Set a wide tempo range like the one shown below by dragging in the Tempo Range Bar. 

 

 
 

Start the music. Voice 1 will play at the tempo indicated by the Tempo Numerical below 
the range bar. The current tempo is also indicated by the thin line in the middle of the 
range bar. 
 
Now set the Conducting Arrow so that it points to the right, and make sure it's selected, 
as shown below. 

 
Then position the cursor in the left side of the Conducting Grid and click and hold the 
mouse button. The tempo will immediately decrease to near the lower end of its range. 
Still holding the mouse button down, slowly drag the Baton from left to right across the 
Conducting Grid. As you do this, you'll hear the tempo gradually increase. The Tempo 
Numerical will also increase. 
 
As we did with Note Density, change the direction of the Tempo Arrow and conduct in 
the direction in which the Conducting Arrow is pointing. When the Conducting Arrow 
points up, conduct from bottom to top to increase the tempo. When the Conducting 
Arrow points down, conduct from bottom to top to decrease the tempo. Click in the 
middle of the Conducting Grid to set the Tempo Numerical to its midpoint and de-select 
the Tempo Conducting Arrow. 

 
Conducting Other Variables 

 
We'll start with a simple conducting setup and then move on to some more complex ones. 
 
Open the Transposition Edit Window. Leave Position 1 at C3, then select the second 
Position for editing, and set its Voice 1 transposition to C#3. Set each successive Position 
so that it's one step higher than the previous Position. You may also want to set the other 
Voices to these different transposition values, as we'll be employing them later. 
 
Next, enable conducting for Transposition by selecting its Conducting Arrow and set the 
Conducting Arrow to point to the left. The Transposition Variable should look something 
like this: 

 

 
 

 
Start the music and Play-Enable Voice 1 only.  
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Move into the Conducting Grid and drag the Baton from left to right. Notice how the 
Voice transposes as you move to different squares. 
 
You don't have to drag in the Conducting Grid. You can also position the Baton 
anywhere in the Conducting Grid and click. The Variable will jump to the new Position. 
Move the Baton to the left-most square and click. Now move to the right-most square and 
click. 
 
While this is fun, it's not much different than just clicking on Variable Positions. The real 
power of the Baton and Conducting Grid lies in their ability to let you conduct more than 
one Variable at a time, in more than one direction. 
 
Enable the Tempo, Note Density, Rhythm, and Transposition Conducting Arrows. Set 
each one so that it points in a different direction. Start Voice 1 and drag the Baton around 
in the Conducting Grid. You should hear significant changes in the music, since you'll be 
changing several Variables' Positions at once. Play-Enable the other Voices and conduct. 
 
Conducting can be a powerful performance tool. When you use M for your own work, 
you'll need to think carefully about how different Variables will work together when you 
conduct them.  

 
 
Copying and Swapping Variable Positions 

 
One handy thing you can do with M to facilitate conducting is to copy the settings from 
one Variable Position to another, or to swap two Variable Positions. This way you can 
arrange the settings of the six Variable Positions so that they make musical sense from 
left to right, or right to left. We're going to demonstrate this technique with a fun 
experiment. 
 
Look at the second Variable Position for Velocity Range. Notice that all four Voices have 
a rather low Velocity Range. We're going to take this Position and swap it with the first 
Position. Select the second Position and drag it over to the first, at which point the first 
Position will highlight too. Release the mouse button and you've swapped Positions 1 and 
2. 
 
Now double-click on the new Position 1 to open the Velocity Range Edit Window. Drag 
the window so that you can see all six Positions of the Velocity Range Variable in the 
main screen Variables Window.  
 
Hold down the Option key and drag the first Position to the second Position, then release 
the mouse button. You've just copied the contents of Position 1 to Position 2.  
 

 
 

Select Position 2 for editing in the Velocity Range Edit Window. Change each of the four 
range bars so that they are slightly farther to the right than they were, like this: 
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Go to the Variables Window and Option-drag Position 2 to Position 3. Select Position 3 
for editing in the Velocity Range Edit Window and, once again, set the velocity ranges 
for each Voice slightly farther to the right for Position 3 than where they were for 
Position 2. 
 
Follow the same procedure for Positions 4, 5, and 6 so that when you're done, the 
Velocity Range Variable looks something like this: 

 

 
 

Then enable only Velocity Range and Tempo for Conducting with both Conducting 
Arrows pointing to the right. Select a Position for the Note Density Variable with a value 
of 100 per cent for all four Voices. Then Play-Enable all four Voices and start the music. 
 
Now move into the Conducting Grid and drag the Baton from left to right. The music 
should get faster and louder as you move to the right. Reverse the Tempo Conducting 
Arrow, so that the music gets louder and slower as you drag to the right. Next, make the 
Tempo Conducting Arrow point upwards, so that you can conduct velocity and tempo 
independently. 

 
Continuous Conducting    

 
Well, that was fun, but it sure was a lot of work to make all those Velocity Range 
Variable settings different. Shouldn't there be an easier way to conduct things like 
velocity in a direct way without having to set up the Variable Positions beforehand?  
Well, there is, and it's called Continuous Conducting. 
   
Continuous Conducting is a way to use the Baton to vary velocity or articulation 
(legato/staccato) smoothly for any or all Voices, in conjunction with their current 
Velocity Range, Accent, and Legato settings.  
 
Before we start, create a Velocity Range Variable Position that looks like the one below, 
and select it as the active Position. 
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Then select the sixth Position of the Accent Variable, which looks like this: 
 

 
 
Then select the sixth Position of the Legato Variable, which looks like this: 

 

 
 

Then, for clarity's sake, de-select any Conducting Arrows you previously selected. Now 
we'll enable Continuous Conducting for Voice 1's velocity. 
 
First click on the Velocity Range Conducting Arrow, then drag the mouse to the right 
until you see four small Conducting Arrows, which correspond to the four Voices, 
pointing to the right. These four Conducting Arrows can also be rotated in any direction. 
Set the Conducting Arrows so that they look like this: 
 

 
 
Then place the cursor in the space next to the Conducting Arrow representing Voice 1, 
which is the top Conducting Arrow, and click. A small brick will appear, as shown 
below. This means that only Voice 1 can be conducted continuously. You can, of course, 
conduct more than one Voice at a time by simply adding bricks for other Voices. 
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Now start the music and drag the Baton from left to right in the Conducting Grid. The 
Variable Position won't shift, but you should hear smooth changes in volume as you drag. 
The volume should go from nearly inaudible to maximum. But what's even more 
interesting is that the Accent pattern is perceptible throughout much of the conducting 
range. 
 
Next, click next to the Voice 2 Conducting Arrow, so that a brick appears, and drag in the 
Conducting Grid. You should hear both Voices change volume continuously. 
 
Continuous Conducting modifies the effect of the Velocity Range by a constant amount, 
depending on mouse position. You can cancel this effect on a Voice with any of the 
following actions: 
 
• removing the Continuous Conducting Enable brick for a Voice 
• switching to a new Variable Position manually 
• disabling Continuous Conducting, or any kind of Conducting for the Variable altogether 
• Option-clicking anywhere in the Conducting Grid. 
 
Disable Continuous Conducting by de-selecting the Velocity Range Conducting Arrow. 
 
Then enable Continuous Conducting for the Legato Variable by clicking and holding on 
the Legato Conducting Arrow and pulling the mouse to the left so the four Conducting 
Arrows point to the left. Enable Voice 2 for Continuous Conducting as shown below. 

 

 
 

Also make sure that Voice 2 is playing some kind of sustainable sound, i.e., not a bass 
drum or castanet. 
 
Start the music and drag in the Conducting Grid. You should hear Voice 2 go from 
playing short, unsustained notes (staccato) to sustained, overlapping notes (legato). 
Again, you should still be able to hear the effect of the Legato Cycle wherever you drag 
the Baton. 
 
Continuous Conducting for Legato modifies the values in the Legato cycle in the 
following way. At the far left position, the maximum continuous value in this case, the 
Legato value is at most 4 times the current value of the Legato Variable. For example, if 
Voice 1 is set in the Legato Variable to sustain a note for 50 per cent of its duration, the 
note will instead sustain for 200 per cent of the duration. At the far right position, the 
minimum continuous value in this case, the Legato value will be at least 25 per cent of 
the current value of the Legato Variable. For example, if Voice 1 is set in the Legato 
Variable to sustain for 50 per cent of its duration, the resulting sustain would be about 12 
percent. 

 
 

Automatic Conducting 
 

When Automatic Conducting is enabled, the Baton will walk around the Conducting 
Grid by itself, thereby relieving you of the intense tedium of conducting yourself. This 
leaves you free to do other things in a performance, like sing or play the guitar, or operate 
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other M controls. You can even conduct manually while Automatic Conducing is on, if 
you like the idea of being second-guessed all the time.  
 
You can determine how often the Baton will jump around, whether it will move 
horizontally or vertically or both, and how far it will jump in each dimension. Then you 
can just sit back and watch it go. 
 
Let's try it out. Enable conducting for the Transposition Variable and set the Conducting 
Arrow so that it points to the right.  
 
Click on the Robot Conductor icon in the lower part of the Conducting Window. This 
will enable Automatic Conducting. 
 

 
 

Once you've clicked on the Robot, you need to set the range over which the Baton will 
move for each axis in the Conducting Grid. 
 
To the right of the Robot Conductor icon, you'll see two miniature range bars, one for 
each axis. Click and drag on the horizontal range bar and set it to its full range. Set the 
vertical one to the bottom of its range, which disables movement along the vertical axis. 
Your screen should look like this: 

 
Finally, you need to set the rate of change in Automatic Conducting. This rate is 
expressed as a multiple of the Tempo. 
 
Change the note icon next to the Robot Conductor as a numerical. It's adjustable from a 
whole note to an eighth note. Set it to a whole note, which makes the Baton move the 
least often. 

 

 
Play-Enable Voice 1 and start the music.  
 
Then move the cursor into the Conducting Grid and click once. Now watch as the 
amazing Conducting dot indicator dances by itself with grace and charm back and forth 
along the horizontal axis. It will usually move every four beats. When the dot crosses a 
line from one box to another in the Conducting Grid, you'll hear the Voice's transposition 
change. 
  
As you can see, the Automatic Conductor may choose not to move at all sometimes, so 
the rate of jumping should be thought of as the minimum time between changes.  
 
Now enable another Variable for conducting on the vertical axis, such as Velocity Range. 
Try to conduct Velocity Range manually while Transposition is conducted automatically. 
With two conductors on stage, you never know what will happen. 
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Now let M take over in both dimensions. Enable Automatic Conducting on the vertical 
axis by adjusting the range bar to something like this: 

 

 
 

Now both Velocity and Transposition should change automatically. Speed up the rate of 
conducting to a quarter note. Now each note has a chance of being quite different from 
the next. 
 
As you can see, it's pretty easy to get a lot of changes happening at once. This can be 
confusing if you're new to the program, so don't try to use all of M's whiz-bang features 
at once. Introduce them gradually after you understand what the processes in the program 
are doing and what you can do to control them. 
 
 
Remember to save your work when you leave this chapter.  
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9   Snapshots and Slideshows 
 
 

In this chapter, we're going to show you some of M's more advanced performance 
functions. These include the Hold/Do Button, Snapshots, and Slideshows.  
 
Open your AT-2 file. All the controls for this tutorial are located in the Snapshot 
Window, at the far right of the screen under the camera icon. 

 
Drag Area

Snapshot Conducting Arrow

Snapshots

Current Snapshot

Hold/Do Button

Quantization Numerical

Slideshow Stop Button
Slideshow Pause Button

Slideshow Loop Button

Slideshows

Snapshot Edit Button Restore from Snapshot Button

Blink Everything Button
 

 
 

Changing Groups of Variables Together 
 
We've already learned about Conducting, which is one way to change the Positions of 
more than one Variable at once. Another way is to use the Hold/Do Button. Hold/Do lets 
you select any number of new Positions, and Hold them until you're ready to make them 
happen all at once (i.e., Do). The Hold/Do is the button with the camera and slide icons at 
the top of the Snapshot Window. 
 
To start, you should close any edit windows that might be open. There's a simple way to 
do this: choose Close All Edit Windows from the Windows menu or use the keyboard 
equivalent, Cmd-0 (that's a zero). 
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Play-Enable all four Voices. Go around and make sure that each Variable on the screen 
has its first Position selected. 

 
Now start the music, and click on the Hold/Do Button. It will start blinking. 

 
Now click on the second Positions of all the Variables in the Variables Window. They'll 
start blinking too.  
 
However, from the musical output you should be able to tell that the Variables haven't 
actually changed their Positions yet. The blinking tells you that the changes are 
pending—or Holding—until some future time. 
 
Then, click on the Hold/Do Button again. All the Variables change to their blinking 
Positions together. 
 
Using the Hold/Do Button is a two-stage process. You put Variables on Hold, then make 
them Do. 
 
But the most common use for the Hold/Do Button is to create Snapshots. 

 
 

About Snapshots 
 

A Snapshot is a picture of a selected group of screen controls, including Variable 
Positions, Conducting Arrows, and certain controls in the Patterns Window. In effect it's 
a record of a Hold/Do action, because you create one in nearly the same way you perform 
Hold/Do, except that instead of Do, you click on a space in the Snapshot window to store 
all the blinking screen controls.  
 
You store a particular setup of screen controls in a Snapshot, then recall, or execute, 
Snapshots in performance to move from one set-up to another. What's more, Snapshots 
can be quantized to occur at just the right time for a smooth change in the music. 
 
The following screen controls can be stored in a Snapshot:   
 
• All Variable Positions. 
• Settings of all Conducting Arrows. 
• The settings for Src Channel, Play-Enable, Echo-Thru-Orchestration, Mouse Advance, 
Output Length, Time Base, and Phase for each Voice in the Patterns Window. 
• Sync (stored by clicking on the Sync Button when you're gathering up blinking 
controls). 
• Play-Enabling or Play-Disabling the MIDI File Sequence that can play along with the 
four Voices (see Chapter 12 for details). 
 
One important thing to note regarding Variable Positions stored in Snapshots is that a 
Snapshot only stores the Position (1-6) of the Variable, not the contents at that Position. 
So, for example, the notes or chords in a Pattern are not stored, just the letter of a Pattern 
Group, a, b, c, d, e, or f. 
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Let's look at all the things that can be stored in a Snapshot. Click on the button with the 
alluring globe icon in it at the bottom of the Snapshot Window. This is the Blink 
Everything Button. 

 
As you can see, the name makes sense, because all the screen controls listed above are 
now blinking. This button is a shortcut for clicking on Hold/Do and going around the 
screen and clicking on everything in its current Position. Now we'll make a Snapshot. 
Click in the upper left box in the Snapshot window, like this: 

 

 
 

All the blinking stopped, and a picture of the letter A posing in the sun, to represent 
Snapshot A, has appeared. (In color on a Mac II, the snapshot would win an amateur 
photography contest!)  There's also a black mark in the sun, to indicate that A is the 
current Snapshot. This is important because several commands which we'll learn about 
operate on the current Snapshot. 
 
Now go around and change a few things to arbitrarily different values on the main screen. 
Change Voice 1's Time Base to 23 | 24. Enable Conducting for the Orchestration 
Variable. Go wild. 
 
Now click on the globe again, then on the box right next to Snapshot A. We now have 
Snapshot B which contains some different screen control settings. 

 
Executing the Snapshot 

 
A Snapshot is executed by clicking on its box. Click on the Snapshot A box. Notice how, 
for example, Voice 1's Time Base returned to 1 | 4. You should also see that the sun in 
Snapshot A now has the Current Snapshot indicator. Now click on Snapshot B. The 
settings return to what they were when we stored Snapshot B. 

 
Creating a Snapshot with Hold/Do 

 
Sometimes we don't want every setting of the program included in a Snapshot. For these 
occasions, you can use the Hold/Do Button, just as you did before, except that instead of 
clicking on Hold/Do again, you select a Snapshot in which you'd like to store all the 
pending selections. Let's try this technique. 
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Click on the Hold/Do Button.  

 
Now select the fifth Positions of both the Velocity Range and Transposition Variables. 
They will begin blinking. Go over to the Snapshot Window and click on the box 
immediately below Snapshot A. You've now created Snapshot C. 
 
Now create Snapshot D with the third Positions of these two Variables, following the 
steps above. 
 
Start the music. Click on Snapshot C. Did you hear both things change at once?  Now 
click on Snapshot D. 
 
You can also perform Snapshots from the computer keyboard. Type the letter C, then D, 
as you watch the screen change and, presumably, hear the music change. 
 
Note:  The perceptual (musical) effect of a Snapshot will often precede the visual change; 
this is because the data changes inside M that affect the music are done as fast as possible 
for a smooth transition from one setup to the next. Then the program worries about 
drawing the screen.  
 
If you store a new Snapshot in a box already containing a Snapshot, the old Snapshot will 
be overwritten by the new one. It is not necessary to clear the Snapshot first. Let's make a 
new Snapshot A, made up of the second Positions of the three Cyclic Variables, Rhythm, 
Legato, and Accent. Then make up a Snapshot B of the first Positions of these three 
Variables. 

 
Conducting Snapshots 
 

It's also possible to conduct Snapshots. Enable Conducting by clicking on the Conducting 
Arrow at the top of the Snapshot Window and making it point down. Only the first six 
Snapshots can be conducted, but that's okay for right now, because you only have four. 
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Quantizing Snapshots 
 
The point at which the Snapshots change can be executed on the nearest rhythmic unit,as 
set in the Quantization Numerical next to the Conducting Arrow. The wave setting 
shown above means no quantization. Set the quantization to a whole note, as shown 
below. 

 

 
 
Snapshot quantization is useful for making changes at rhythmically precise locations. It 
will work with both conducting Snapshots, and executing them individually by typing or 
clicking. Of course, in this universe as we know it, it's impossible to quantize an event 
backwards in real time, so the quantization will generally introduce a perceptible delay in 
the execution of the Snapshot. To compensate for this, you can just anticipate the 
rhythmic unit a bit and the quantization will happen in the right place. This is easiest to 
do when Snapshots are quantized to a whole note, as we'll see. 
 
Let's conduct our Snapshots. Start the music and move the Baton into the Conducting 
Grid. Drag from top to bottom quickly and release the mouse button. Now watch what 
happens. Successive Snapshots are delayed and executed a whole note apart, 
corresponding to the order in which you dragged through the Conducting Grid. Pretty 
impressive, huh? 
 
Now execute the Snapshots manually by typing the letters A, B, C, and D. Try to get the 
feeling of anticipating the whole note so that your Snapshot is executed on time. 
 
Snapshot quantization applies in other parts of the program. For example, click on the 
Sync Button. Notice that the resetting of all Voices occurred on a whole note.  
 
You can quantize the selection of a new Position for a Variable. Just Shift-click on the 
new Position. Start the music and Shift-click on different Transposition Variable 
Positions. The change will be delayed until the next quantization point. 
 
The act of conducting run-of-the-mill Variables (except for Tempo, which isn't really a 
Variable anyway) can be quantized too. Just hold down the Shift key while you drag the 
Baton around in the Conducting Grid. 
 

Editing Snapshots 
 

Besides the globe, there are a couple of other buttons with interesting icons in the 
Snapshot Window. The Edit Snapshot Button is the one with the pencil, above and to 
the left of the globe. The Edit Snapshot Button operates on the Current Snapshot—the 
one with the black mark in the sun. Click on Snapshot C, then click on the Edit Snapshot 
Button. 
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All of the components of Snapshot C will begin blinking. Now let's add another item to 
the Snapshot, the Time Base Denominator for Voice 1 in the Patterns Window. (When 
clicking on numericals while in Hold/Do, you can only select or deselect the numerical 
for inclusion in a Snapshot. It's really not useful in conjunction with a Hold/Do, since you 
can't change the value of the numerical.)  Now let's store the Snapshot back in location C. 
You've just edited your first Snapshot.  
 
But that's not all. You can also delete items from Snapshots. Click on Snapshot A, which 
was made with the Blink Everything Button. Now click on the Edit Snapshot Button. 
 
Click on the blinking Variable Position in Legato. The blinking will stop in the Legato 
Variable, leaving everything else in the Snapshot. Store this Snapshot again in location A. 
Deleting items is quite useful in conjunction with Snapshots which you make with the 
Blink Everything Button, if you want most everything, but not absolutely everything, to 
be in your Snapshot.  
 
A couple of things that users often want to delete from a "Snapshot of Everything" are the 
Sync Button and the selection of a Pattern Group. Click on the Blink Everything Button 
to incite mass blinking, then click on Sync. Sync will stop blinking, so there won't be a 
Sync performed in the Snapshot. Now click on the blinking Pattern Group Variable 
Position. Store this Snapshot in location E, for Everything. 
 
You can also use the Edit Snapshot Button to make copies of Snapshots. Click on the 
Edit Snapshot Button again, which will display the contents of Snapshot A. Now click on 
location F, right below the box for Snapshot D. Snapshots F and A are now the same. 
 

Restore From Snapshot 
 

The Restore From Snapshot Button gives you back the settings that were in effect 
before you executed the current snapshot. It's right next to the Edit Snapshot Button. 

 
Execute Snapshot D, then click on the Restore From Snapshot Button. The settings 
should return to the values they had before Snapshot D was executed. And conveniently, 
the restore action is quantized, like any other Snapshot. 
 

 
About Slideshows 

 
Slideshows are automated sequences of Snapshots and quantized Variable Position 
selections. You can make nine different Slideshows and store them in the column to the 
right of the two Snapshot columns.  
 
You make Slideshows by "recording" a series of actions. The Slideshow recorder 
observes both the action and the time in between successive actions, much like a 
sequencer. Then, when you play back a Slideshow, these actions are reproduced, one 
after the other, exactly as you performed them. 
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The controls for Slideshow operation are shown below. 
 

Slideshow Stop Button

Slideshow Pause Button

Slideshow Loop Button

Slideshows

 
 
Recording a Slideshow 

 
Let's record a Slideshow. First Option-click on the first open box in the Slideshow 
column. You'll see the Slideshow Pause Button light up and a circle with the Slideshow 
number appear in the box. This indicates we're ready to record. 

 
 

Next, start the music and execute Snapshots A, B, C, D, E, and F in order. As usual, the 
actual time the Snapshot is executed is affected by the Snapshot quantization. Happily, 
this is the time that is recorded into the Slideshow, not the moment you type the letter or 
click on the box. 
 
After executing Snapshot F, click on the Slideshow Stop Button. 

 



 

110 

Slideshow 1's box now shows a plain 1 in it, as shown below. 
 

 
 

That was exciting. Let's stop the music for a moment. 
 
Now let's play Slideshow 1 back. You can either click on its box, or type the number 1 on 
the computer keyboard. Incidentally, typing 0 (zero) on the Mac keyboard is equivalent 
to Slideshow Stop. 
 
The Slideshow box indicates it's in playback mode with an arrow. However, you don't see 
or hear anything. That's because the music isn't going, and until it is, the Slideshow Pause 
Button is lit up.  
 

 
 

Now start the music. The Slideshow Pause Button unhighlights, and the Slideshow begins 
with Snapshot A, then onto B and so forth. After Snapshot F, the Slideshow stops. 
 
Now let's make the Slideshow loop back to the beginning after it plays Snapshot F. With 
the music still going, execute Slideshow 1 again. Notice that the slideshow doesn't 
actually start until the Snapshot quantization point. 
 
Now get ready to click on the Slideshow Loop Button, shown below. Do it right after 
you see Snapshot F execute. If you didn't have your act together, just execute the 
slideshow again and be ready this time. 

 

Slideshow Loop
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If you did this right, the Slideshow will loop over and over. You'll also see a set of repeat 
marks in the Slideshow's box, indicating that this Slideshow knows how to do the loop. 
 
We can also remove the loop by Option-clicking on the Slideshow Loop Button as the 
Slideshow is playing. Do this now. 
 
You can also Loop the Slideshow directly in recording. When you're about to stop 
recording a Slideshow, click on Slideshow Loop instead of Stop or Slideshow Stop. The 
computer keyboard equivalents for Slideshow Loop are the backslash ( \ ) or vertical bar ( 
| ) keys. 
 
Quantized selections of Positions for Variables can be included in Slideshows too. 
Option-click on the box below Slideshow 1 to record Slideshow 2. 
 
With the music going, Shift-click on Positions 1 through 6 (in order) in the Transposition 
Variable, then, for spice, use the Loop technique we just described—click on the 
Slideshow Loop Button or type a Backslash. 
 
Now type the number 2 to play back your Transposition sonata. As you might imagine, 
Shift-clicking in the Conducting Grid will add your quantized conducting actions to a 
recording Slideshow. Conducting Snapshots while recording a Slideshow will always put 
the Snapshots in the Slideshow, whether you hold the Shift key down or not. 
 
That's it for Snapshots and Slideshows. Save your work. 
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10   The Input Control System 
 
 

The Input Control System allows you to make performance changes from a MIDI 
keyboard, so that you can perform without using the mouse and without needing the 
computer in close proximity. 
 
The Input Control System has been designed so that each key on your MIDI keyboard 
has a different function and will cause specific changes when you press the key. 
 
Performing with M and the Input Control System is something that you can get better at 
with practice. In particular, you may have to learn to be somewhat precise about which 
keys to hit at what time.  
 
Start by opening the AT-2 file. 

 
 

Performing with the Input Control System 
 

Before you do anything, you have to enable the Input Control System. Go to the Patterns 
Window, open the Picture Matrix in the Use column for any Pattern and select C.  

 
 
You need only one Input Control System Enable icon in the Use column to use the Input 
Control System. 
 
Also, make sure that the Src Input Channel for the row you selected to use the Input 
Control System is set to All. 

 
Refer to the Input Control System Template in Appendix B for the location of each 
function key. You'll need to keep it handy as we talk about different Input Control 
functions. 

 
A Few Words About the Controls 

 
There are two types of controls in the Input Control System:   One-Step Controls and 
Two-Step Controls.  
 
The One-Step Controls are activated by pressing a single key, and they are all white keys. 
 
The Two-Step Controls require that two keys be played in succession. The first key is a 
"code" which interprets the second key, which is a value. The code keys are black. The 
value keys are white, and are numbered or lettered on the Template, showing numbers as 
they apply, or letters which apply to Snapshots. 
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To perform a One-Step Control, simply press the appropriate key. 
 
To perform a Two-Step Control, press the control key first, which will define the 
function, then press the value key, which will execute the control for that value and reset 
the Input Control System for the next command.  
 

 
One-Step Controls 

 
The keys marked Start and Stop will perform the same function as clicking on the Start 
and Stop buttons in the Conducting Window. Play-Enable your Voices. Now press the 
middle C key (C3). The Start Button will highlight and the music will start. Now press B 
below middle C (B2). The music will stop. 
 
The key marked Hold/Do will perform the same function as the Hold/Do Button in the 
Snapshot Window. While the music is playing, press the Hold/Do key (B3). The Hold/Do 
Button at the top of the Snapshot Window will start flashing. Now select some new 
Variable Positions, and press B3 again. The Hold/Do Button will stop flashing, and the 
Variable Positions will change. Refer back to Chapter 9 for more information about 
Hold/Do.  
 
Pressing the keys labeled Play-Enable Toggle will do the same thing as clicking in the 
Play-Enable boxes in the Patterns Window. Play-Enable all four Voices, and start the 
music. Now press any of the Play-Enable Toggle keys (C1, D1, E1, or F1). Notice that 
Play-Enable for each Voice has its own key. You'll see the Play-Enable Toggle for that 
Voice go blank in the Patterns Window. That Voice will go silent. Press the key again, 
and you'll see the speaker appear again and you'll hear the Voice. These keys are fun to 
use in performance to quickly switch Voices in and out. 
 
The key marked Sync does the same thing as the Sync Button in the Conducting 
Window. Start the music, making sure that your Voices are Play-Enabled again, and press 
the Sync key (F3). You'll hear the Voices reset to the beginnings of their cycles. 
 
The Clear Current Pattern keys will change the steps in a Pattern to rests while the 
Pattern is recording, which will give you a Pattern of the same number of steps but 
without notes. Be careful when using this function. You might erase something you want 
to save. 
 
The Stop Any Slideshow key (F4) will stop a Slideshow in playback. If you still have 
some Slideshows in your file from Chapter 9, execute the Slideshow. Then press the Stop 
any Slideshow key and it will stop. 
 
The Sequence Play-Enable Toggle key (C4), if pressed while the program is playing, 
will Play-Enable a MIDI Sequence. Pressing this key while a MIDI Sequence is playing 
will mute the Sequence. The Sequence will continue to play, you just won't hear it. Refer 
to Chapter 12 under MIDI Sequences for further details. 

 
Step Advancing Voices 
 

The Step Advance control allows you to manually step a Voice through its sequence of 
notes, something like the "one key play" feature found on small Casio keyboards. The 
control keys, as indicated on the Template, are in pairs so that you can "trill" between 
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them, but either key in a pair will do the job. You can Step Advance Voices individually, 
or together as a group, by playing the appropriate keys. We'll try step advancing Voice 1. 
 
First, Play-Enable all four Voices. 
 
Next, Voice 1 has to be enabled for Step Advance before you can step advance it. To do 
that, change the right-hand Time Base Numerical in the Patterns Window for Voice 1 to 
sa, which is the position equivalent to zero. 

 
 

Then click on the Start Button to start the system playing. You'll hear the other Voices 
playing, but Voice 1 will be silent. Now press either of the Step Advance keys for Voice 
1 (D2 or E2). Voice 1 will advance one step every time you press the key. Try trilling 
between the two keys to get it moving faster. 
 
Stop the music. Now enable Step Advance for all the Voices by setting their Time Bases 
to sa. A quick way to do this is to use M's Shift-Click on Numerical feature. Shift-
clicking on a numerical copies the last numerical value you set. Since the last thing you 
did was set Voice 1 to sa, just Shift-click on the time denominators for Voices 2, 3, and 4, 
and they'll change to sa too. 

 
 

Then start the music and press either of the keys labeled Step Advance all "sa" Voices 
(D3 or E3). You'll hear all of the Voices stepping along together each time you press one 
of the keys. Next, press any of the Step Advance keys for the other Voices (G2 and A2, 
G3 and A3, and D4 and E4). You'll hear each voice individually advance one step when 
you press its key once. 
 
Reset the Time Bases to their previous settings when you're done. 

 
Tempo  Controls 

 
Tap Tempo. M will note the amount of time between two successive depressions of the 
key assigned to Tap Tempo and set the tempo accordingly. Usually your taps define how 
long a quarter note will be, but you can tap in other metric units by setting the External 
Sync Ratio control in the Conducting Window to something besides a quarter note. Let's 
try tapping out some tempos. 
 
First, start the music. Then hit the Tap Tempo key (F2) twice. The time between taps sets 
the tempo. Look at the Tempo Numerical and watch it change as you tap twice again. Try 
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tapping very slowly. You should get a slow tempo. Tap faster to set higher tempos. Stop 
the music. 
 
Tap Conduct Tempo. Tap Conduct lets you direct the Tempo of your music from your 
input control keyboard in much the same way a conductor beats time for an orchestra. 
Successive taps on the Tap Conduct key establish a quarter note pulse that M follows. 
We'll show you how it works. 
 
With the music stopped, set Voice 1's Time Base to 1 | 8. Play-Enable Voices 1 and 2. 
Now tap once on the Tap Conduct Tempo key (C5). You'll see the Start Button highlight 
and the Tempo Numerical change to read Tap. 

 

 
 

However, you won't hear any music. This is because you have to give M a "beat for 
nothing" to tell it how fast to start.  
 
Now tap again. You'll hear the two Voices advance a quarter note:  two steps for Voice 1 
and one step for Voice 2. Now tap a few more times on the Tap Conduct key. You'll hear 
the Voices step forward by quarter notes. The difference between this and Step Advance 
is that your tapping sets the tempo for the whole program, rather than the articulation for 
a single voice or group of voices. You'll see that if you slow down drastically between 
one tap and another, M waits until it receives the next quarter note to play the Voices.  
 
Now, tap twice on the Tap Conduct key and immediately press the Freeze Tap Conduct 
key (A4). What you've done is freeze the tempo at the value you just tapped. The Voices 
will continue to play at the tempo you tapped.  
 
Now press the Accelerando key (B4). You may or may not hear a very slight increase in 
tempo as the Voices play. Each time you press the key, the tempo will increase by a small 
amount. Press the key repeatedly and listen to the Voices speeding up. This is a good way 
to introduce gradual changes in tempo from your MIDI keyboard. As you can guess, 
pressing the Decelerando key (G4) will introduce gradual decreases in tempo to your 
Voices. Finally, resume manual control over the tempo by tapping out the beat on the Tap 
key. Now stop the music by hitting B2 (the Stop key). 
 
Choose Tap Affects Velocity from the Options menu, so that it's checked. If its already 
checked, then you don't need to do anything. 
 

 
 
 

This Option lets you change the overall velocity of all of M's Voices by pressing either 
the Tap Conduct, Freeze Tap, Accelerando, or Decelerando key when you're in Tap 
Conduct mode. How hard or soft you play the key determines whether the Voices will 
play louder or softer. If you play the key above a MIDI velocity level of 64 (the defined 
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"medium velocity"), the Voices will play louder than they were. If you play below a level 
of 64, the Voices play softer. Of course, for this to work, your keyboard must be able to 
send MIDI velocity information. Let's try it. 
 
Play-Enable Voice 1 only. Start tapping away by hitting the Tap Conduct Tempo key. 
Begin hitting the Tap key harder, and listen as the Voice plays louder. Now hit it very 
softly and the Voice will get very quiet. Now hit the Freeze key very hard. The tempo is 
set at your last tapped tempo, and the Voice plays louder. You can affect the velocity 
with the Accelerando and Decelerando keys too. Try these keys, and experiment to get a 
feeling for the kind of keystrikes you need to make to change the volume of the Voices. 
 
As you can see, this can be a very useful feature in performance to create gestural 
changes in both volume and tempo. When you're finished,  stop the music. Tap Conduct 
is automatically disabled when you click on the Stop Button.  

 
 

Two-Step Controls 
 

Variables 
 
You can select Positions for any Variable from a MIDI keyboard. 
 
To select a particular Variable Position, you first press the appropriate code key for that 
Variable, then press the value key for the number of the box that you want to select. Note 
that only one value key may be pressed after pressing a code key. Even if you want to 
change to another Position in the same Variable, you still have to press the code key first 
and then another value key. 
 
Let's try a specific example. Start the music. Press the Transposition code key (A#2). 
Now press any of the value keys from 1 to 6 (D1 to B1). You'll hear a transposition 
change and see the Position change in the Transposition Variable. Try selecting other 
Transposition Variable Positions, but remember to press the Transposition code key each 
time before you press a value key. 
 
You'll notice that the value keys are numbered up to 16. This lets you select any of the 
Sound Choice Variable Positions. If you select any other Variable and press one of the 
value keys above 6, it will be ignored. 
 
Try switching some other Variable Positions. Refer to the Template to find the code keys 
for some other Variables, and follow the same procedure as you did for Transposition 
while listening to the results. 

 
Performing Snapshots  

 
Value keys are lettered as well as numbered. This lets you use your MIDI keyboard to 
switch between Snapshot Positions. Pressing the Snapshot code key (C#4 or, more 
conveniently, C#1), followed by a value key labelled A-Z will select that Snapshot. Use 
the Input Control System to switch between the Snapshots you have recorded. 
 
You can also edit the Current Snapshot by pressing the Edit Snapshot key (G#4). And 
since you know how to switch Variable Positions with the Input Control System, try 
performing your editing from the keyboard. When you're finished editing, execute a 
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Snapshot from the keyboard, and the blinking Variables will be stored into the the 
location you specified. 

 
Input Control of Slideshows 

 
Play Slideshow 1 by pressing the Play Slideshow key (D#4) followed by the value key 
for the number 1. 
 
Now try recording into a slideshow, say 5. Hit the Record Slideshow key (F#4) followed 
by the value key for the number 5. Execute a couple of Snapshots from the keyboard. 
Then press the Stop any Slideshow key (F4) . 
 
Note that there's no way to include quantized Variable Position selections made from the 
Input Control System, so if you want these in your Slideshow, you'll have to use the 
mouse and computer keyboard. 

 
Time Base Denominator 

 
The Time Base Denominator (right-hand) Numericals in the Patterns Window may be set 
from the keyboard by pressing a key marked Time Base Denominator, then pressing an 
appropriate value key. Press the code key for Voice 1's Time Base (D#1). Now press 
value key number 2 (E1). You'll see the right-hand numerical in the Time Base box for 
Voice 1 change to 2, effectively making Voice 1 play at half speed. Try this with the 
other Voices. 

 



 

118 

11   Other Performance Controls 
 
 
 

In this chapter, we'll talk about some additional performance controls. These controls all 
have special functions that you may find useful in performance. 
 
Start by opening the AT-2 file.  

 
Mouse Advance 

 
M's Mouse Advance feature is a special performance technique that lets you play selected 
Voices by moving the mouse cursor around on the screen. Let's try it out. 
 
First, enable Mouse Advance for Voice 1 by clicking on the topmost Mouse Advance 
Toggle in the Patterns Window. It's the first box in the column under the mouse icon. 
When you click on it, you'll see a diamond appear in the box. 

 
 

Next, set Voice 1's Time Base to 1 | 16. 
 
Next, make sure that all the Voices, including Voice 1, are Play-Enabled. Start the music. 
Notice that you don't hear Voice 1, even though it's been Play-Enabled.  
 
Now, hold down the Option and Command keys on the computer keyboard and move the 
mouse around. You should hear bursts of notes from Voice 1 playing in tempo whenever 
the mouse is in motion.  
 
You don't need to hold down the mouse button and it doesn't matter where you move the 
mouse on the screen. As long as the mouse is moving, Voice 1 will play. Notice that 
when the Command and Option keys are both depressed the Mouse Advance icon in the 
Patterns Window is highlighted. 

 

Mouse Advance Icon

 
 

The reason we set Voice 1's Time Base to 1 | 16 is that it makes it easier to hear the Voice 
in motion, as it were. Mouse Advance tends to work best at higher tempos and faster 
Time Bases. 
 
Try dragging the mouse around at different speeds. You should hear Voice 1 play a little 
louder when you drag faster. The speed at which you move the mouse gives you some 
control over velocity — the faster the movement, the louder the sound. This is dependent, 
of course, on the velocity values you have set in the Velocity Variable for that Voice. 
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Another performance technique using Mouse Advance is to move the mouse around 
continuously and "punch" the Command and Option keys whenever you like. Give it a 
try. Every time you punch the keys, you'll hear Voice 1 pop in.  
 
Next, stop the music and enable Mouse Advance for all four Voices. This time, push 
down the Caps Lock key on the computer keyboard, start the music, and move the 
mouse around. You'll hear all four Voices, each in its specified Time Base, as you move 
the mouse. Depressing the Caps Lock key is a way to use Mouse Advance without tying 
up both hands. 
 
Mouse Advance is probably most effective when you advance one fast-playing Voice 
against others that are playing continuously. But experiment, by all means. You'll most 
likely find the way of working with it that suits you best. 
 
Note that when a Voice is enabled for Mouse Advance and the mouse is not in motion, 
the notes in the Voice don't step along with the other Voices that are disabled for Mouse 
Advance. The Voice stays at the last step played until you move the mouse again. This is 
similar to the way Step Advance in the Input Control System works. 
 
Stop the music, unlock the Caps Lock key, disable Mouse Advance for all Voices, and 
reset Voice 1's Time Base to 1 | 4. 
 
 

Transposing Voices from your MIDI Keyboard 
 

Another useful performance technique is to transpose Voices from your MIDI keyboard. 
Since the Voice will be reading MIDI input data, the first step is to make sure that the 
Source Channel for the Voice is set correctly. For now, make sure that the Source 
Numerical for each Voice is set to All. 

 

 
 
Next, enable Keyboard Transpose for Voice 1 by selecting the sharp-and-flat icon for 
Voice 1 from the Picture Matrix in the Use column in the Patterns Window. 

 

 
 

Selecting the Keyboard Transpose function enables you to transpose a Voice in playback 
by keying notes on your MIDI keyboard. As with the Transposition Variable, C3 is 
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considered to be no transposition. Playing E3, for instance, would transpose the whole 
Voice up a major third. Playing C2 would transpose the Voice down one octave. 
 
Next, Play-Enable Voice 1 and start the music. As you listen to the Voice, press the C#3 
key on your MIDI keyboard. You'll hear the Voice transpose up a half-step. Try pressing 
other keys on your keyboard and listen to the effect. Play-Enable Voice 2 to verify that 
only Voice 1 is being transposed. Press the C3 key again to return Voice 1 to its original 
key. 
 
Next, enable Keyboard Transpose for both Voices 1 and 2 by selecting the sharp-and-flat 
icon for Voice 2. 

 
 

Next, start the music and key different notes on your MIDI keyboard. You'll hear both 
Voices transpose simultaneously.  
 
Another interesting approach to real time transposition requires two MIDI keyboards, 
each set to a different MIDI output channel. In M, set the Source Channel for Voice 1 to 
the MIDI output channel of the first keyboard, and the Source Channel for Voice 2 to the 
second keyboard's output channel, rather than setting both to All. Then, by selecting 
MIDI transposition for each Voice, each Voice could be transposed independently of the 
other by playing its appropriate keyboard. If you have two keyboards, or one fancy 
keyboard that does this sort of thing, like a Kurzweil MIDIboard, follow the steps above 
and try it out. 
 
When you're done, disable Keyboard Transpose by selecting the dash icon from the 
Picture Matrix for each Voice. 
 

 
 

The dash means that MIDI input data is ignored, in effect turning off the input. 
 
Before moving on, reset the Source Channels to All. 
 

 
Playing along with M 

 
You may find in performance that you want to play some notes on your keyboard besides 
the notes M is playing, or just hear the notes from your master controller played by 
different synthesizers. You can send those notes through the computer to any of your 
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synthesizers with the Echo Map controls. Setting up an Echo Map is a two-step process. 
First you have to enable the Echo Map, and then you have to specify the MIDI channels 
on which the notes you play will be echoed. 
 
First, enable the Echo Map by selecting the Echo Map Enable icon from the Picture 
Matrix in the Use Column in the Patterns Window for Voice 1. The icon represents two 
arrows next to a map of California with major cities indicated. 

 

 
 

Only one Echo Map Enable is necessary in the Use column. 
 
Next, select channels in the Echo Map by clicking on the appropriate numbers in the Map 
icon in the upper right-hand corner of the Patterns Window. You can choose as many 
channels as you like to echo out on. For now, set up an Echo Map which will send your 
MIDI note data out on M Output Channels 1 and 2 by clicking on 1 and 2 in the Map. 

 

 
 
 

Then Play-Enable and start Voices 1 and 2. As they are playing, play on your keyboard. 
You should hear the notes you play from the synthesizers receiving on Channels 1 and 2 
as well as the notes in Voices 1 and 2. Stop the music. Try selecting some different Echo 
channels in the Map that correspond to different synthesizers in your setup, and play your 
keyboard. You should hear the notes you play echoed by the synthesizers set to those 
channels. If you want to hear a different timbre from each channel, your synthesizers 
should be in Poly mode so that they receive on MIDI channels independently. 
 
When you're finished experimenting, disable the Echo Map by selecting the dash icon 
from the Picture Matrix. 
 
Save your work, if you like. 
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12  Movies and Midi Files 
 
 
 

A Movie is a record of the MIDI output generated by an M performance. Movies are 
useful if you've created some compositional material you'd like to use in another 
program. You capture the material in a performance, save it as a MIDI File, and import 
the data into another program. 
 
There are many applications that support MIDI Files. The most common use of MIDI 
Files is to include a Movie captured by M as a part of a sequence in a sequencer program. 
 
M is also able to import MIDI Files and read the information into a Pattern, or play the 
MIDI file "straight" as a Sequence along with its four Voices. 
 
We're going to guide you through making a Movie, saving it as a MIDI File, importing a 
MIDI File, reading it into a Pattern, and reading it directly into a Sequence. 
 
Begin by opening the AT-2 file. 

 
 

Making a Movie 
 

First, Play-Disable all Voices except Voice 1. Next, set the Tempo to a value of around 
160. Now click on the Movie Button in the Conducting Window. It will highlight. 

 
 

The idea at this point is to create a simple performance that you can save as a file. What 
we want you to do is to start the music (don't do it yet), listen to the scale, and click on a 
different Transposition Variable Position every time the scale repeats — that is, every 
eight beats, so that the key of the Voice changes every time it cycles around. If you don't 
click at exactly the right time, don't worry about it. The point is to create something that 
changes through time. 
 
So, follow these steps. When you're ready, click on Start. Listen to the scale. As it comes 
around to the beginning, on the ninth beat, click on the third Position in the Transposition 
Variable. When the scale in Voice 1 reaches its beginning again, click on the sixth 
Position in the Transposition Variable. When the scale cycles again, click again on the 
first Position. Finally, just as the scale reaches the beginning of its cycle again, click on 
the Stop Button. When you click on Stop, the Movie Button will un-highlight.  
 
Here's the sequence of events.  
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Position 1Position 3Position 6 Position 1

 
 

Got that?  Try it. 
 

After you've completed the performance, you'll have a Movie stored in memory. You can 
check by pulling down the File menu and seeing if the Save Movie As Midi File item is 
enabled, instead of being grayed-out. This indicates you've filmed your first movie. 

 

 
 
 

"Running out of Film" 
 

There is, understandably, a limit to the number of events that can be stored as a Movie, 
and if you exceed the limit, the filming will stop automatically. In any case, your Movie 
will be intact as far as it went. Since we captured such a short performance, it wasn't a 
problem in the previous example. 

 
 
Saving a Movie 

 
Choose Save Movie As Midi File... from the File menu. You'll be presented with this 
dialog. 
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You'll be asked to name the Movie. The default name is M Movie. Accurate but 
uninspired. Give it your own name. Now the movie is a MIDI File saved on your disk. 

 
Importing a MIDI File 
 

There are two ways M can read a MIDI File:  into a Pattern or into a Sequence. If a file is 
read into a Pattern, it will be as though you recorded the material or created it in the 
Pattern Editor — it's ready to use just like any other Pattern. If it's read in as a Sequence, 
all the timing information will be included and M can play it in addition to the four 
Voices, as a separate musical entity. Let's start by reading your MIDI File into a Pattern. 

 
Reading a MIDI File into Patterns 

 
First, and this is important, you need to select the Pattern Group into which you want to 
read the MIDI file. A MIDI File is always imported into the currently selected Position in 
the Pattern Group Variable. In this case, let's select Pattern Group b. 

 

 
 

Then choose Open Midi File... from the File menu. Choose M Movie (or whatever you 
named your movie) from the list in the dialog. 
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When you do, you'll get the following Import Dialog (with your own file name 
displayed in the title area). 

 

 
 

The Import Dialog allows you merge or separate different MIDI channels in the file into 
one or more of the four Patterns in the current Pattern Group. You can also control how 
timing information is interpreted when the data in the file is "recorded" into the Pattern. 
 
The controls under the heading of Source Channels let you assign data in the MIDI File 
to be read into specific Patterns.  
 
Since our MIDI File contains only one channel of information (Channel 1), we're just 
going to assign Channel 1 to Pattern 1. Click in the Channel 1 box for Pattern 1. 
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For now, leave the other controls set as they are and click on the Import Button. 
 

 
 

The program will ask you to wait briefly while the it imports the file. When it's finished, 
the Import Dialog will close. 
 
Look in the Patterns Window. The Length Numerical for Pattern 1 in Pattern Group b 
should read 32 or so, indicating that the notes from our original performance have been 
entered into the Pattern. 
 
Let's see if they have. Play-Enable Voice 1 and start the music. You should hear a C 
major scale, followed by two other transpositions of the major scale. If you don't hear 
scales, perhaps the Note Order Variable is not set to 100 Original Order. 
 
Now, this was a rather simple example of what you can do with MIDI File importation. 
However, you can now take the basic material and manipulate it in the usual ways. 
Obviously, importing into a Pattern is a good way to generate some raw material to work 
with. As we've demonstrated, M can import MIDI Files within itself as well as from other 
sources. 
 
Now we'll try another way of importing MIDI Files. 

 
Reading MIDI Files into a Sequence 

 
We're going to import the file called Happy, which is a full-fledged MIDI sequence. 
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Choose Open Midi File... again from the File menu and select Happy from the file list. 
You'll get the Import Dialog again with Happy in the title area. This time, however, click 
on the Import as Sequence Button. 

 

 
 

 
When you click on this toggle button, the mode of importing the MIDI File changes 
rather drastically. Instead of being cut into steps for a Pattern, the MIDI data is imported 
as a Sequence which can be played along with the four Voices.  
 
The only controls active in the Import Dialog when you're using Import As Sequence are 
the top row of channelization enable buttons, which are initially set to All. Deselecting a 
channel (by clicking on its box) will cause any information on that MIDI channel to be 
ignored in the MIDI File and not read into the Sequence. Deselect all but Channel 1. 

 

 
 
 

Click on the Import Button. 
 

 
 

 
You've imported to a Sequence. Let's listen to it. 
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Look over in the Conducting Window. Just to the left of the Conducting Grid you'll 
notice the Sequence Play-Enable Toggle. 

 

Sequence Play-Enable Toggle 
 

Click on it so that it's highlighted. 
 

 
 

Now Play-Disable all Voices, and click on Start. You should hear a cheesy rendition of 
Happy Birthday that modulates through a couple of keys, played by whatever synthesizer 
is listening to MIDI Channel 1. Notice that the original rhythmic information in the 
Sequence has been preserved. 
   
Now Play-Enable the four Voices, and you'll hear them too. 
 
A Sequence in M is independent of the Voices, although the controls in the Conducting 
Window, such as Tempo, Start and Stop, do affect it. Experiment with the Conducting 
Window controls while listening to the Sequence. Disable the Sequence by clicking on 
the Sequence Play-Enable Toggle, so that it un-highlights. Enable the Sequence again, 
and you'll see that the Play-Enable Toggle is like a mute switch — the Sequence 
continues to "play" even when you're not listening to it. 
 
For more information on Importing MIDI Files, refer to Chapter 19 under Open Midi 
File... 
 
If you save your work before leaving this chapter, the Happy Birthday sequence will be 
stored as part of your M document, and will be available when you open it in the future. 

 
Chapter 12 concludes the tutorial sections of this manual. Chapters 13 through 22 
reference M's features. 
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13  The Patterns Window 
 
 

The Patterns Window contains controls for processing MIDI input and creating and 
modifying Patterns. It also contains some controls which affect Pattern output that are 
stored with Pattern Groups, and the all-important Play-Enable Buttons for the four 
Voices. Basically, anything which affects a Voice individually and which is not part of a 
Variable can be found here. 

 
 
Input Controls 
 
Src (Source Channel) 

 
This numerical selects a specific M Input Channel for information that affects the specific 
Pattern and Voice. The numerical can be set to a specific Channel 1-16 or, is as usually 
the case, All, where information on any channel is processed. 

 

 
 

Distinguishing input channels allows you to perform different M functions with MIDI at 
the same time. There are many different uses for MIDI input in the program, such as echo 
rechannelizing, Input Control, recording notes into Patterns, and transposing Voices. 

 
Use   

 
This control is a Picture Matrix that assigns how MIDI input will affect a particular 
Pattern and Voice, or in other words, how MIDI information is used. The possible 
selections are: 
 
Disable, which causes any incoming notes to be ignored. 

 
 
Record, where incoming notes are recorded into a Pattern, according to its combination 
of Record Modes. 
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Keyboard Transpose, where the Voice's output is transposed by incoming notes. Middle 
C (C3) is no transposition; notes above C3 transpose the Voice up, and notes below C3 
transpose the Voice down. 

 
 
Input Control, which lets you use the Input Control System to perform various actions 
in the program. Refer to Chapter 10 for details.  

 
 

Echo Map Enable, which sends any MIDI input through the computer to the channels 
selected in the Echo Map, shown below the Echo Map Enable icon. Yes, that's two 
arrows next to a map of California and other western states with major cities indicated. 
Users of previous versions of M know there had to be an icon to take the place of the 
Note Order mouse. 

 
 

 
 

Echo-Thru-Orchestration 
 

This toggle allows you to send any MIDI input on channels specified by the Voice's 
Source Channel Numerical through the computer to the Output Channels of the Voice's 
current Orchestration. This is helpful for recording into a Pattern, since you can hear the 
same output characteristics while performing on your keyboard as the Voice will use 
when playing what you've recorded. A check mark indicates that Echo-Thru-
Orchestration is active. 

 

 
 
Pattern Select and Record Modes 

 
Clicking once in this column selects a Pattern for edit operations in the Edit and Pattern 
Menus. Double-clicking on a Voice's Pattern Select box will open the Pattern Editor on 
the Voice's current Pattern. 

 

Selected Unselected 
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In addition, the three icons inside the Pattern Select box indicate its current Record 
Modes. You can change these in the Pattern Editor, or, more conveniently, directly in the 
Patterns Window by Option-clicking on the desired icon. This will bring up one of the 
Record Mode Picture Matrices, which we'll describe. 

 
Insert Mode

Record ModeDrum Machine Mode 
 

Chord Mode. This Picture Matrix selects how incoming MIDI data is treated in terms of 
creating chords or single notes in a Pattern. 

 

 
 

Single Note. The Pattern separates all MIDI input into single note events. 
 

 
 

Chord. The Pattern records chords you play as events with chords. 
 

 
 

Build. The Pattern allows you "build" and edit chords in real time. As long as one note 
in a chord is sustained, others may be played at any time and are added to an evolving 
step. In addition, notes which are already in the chord, if played again, are deleted. 

 

 
 

Insertion Mode. This Picture Matrix determines how the Pattern records new notes with 
respect to the existing note information.  
 

 
 

Remember that when you're in Record Mode, MIDI input data affects the step in the 
Pattern at the MIDI Edit Counter, which is displayed and set in the Pattern Editor 
Window. To help you remember what the icons that represent each Insert Mode do, think 
of the white circle as the new note, and the black circles as the existing notes. 

 
Insert. New notes are added as steps inserted at the MIDI Edit Counter. 
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Replace. New notes replace the step at the MIDI Edit Counter. 
 

 
 

Overdub. New notes are added to the notes already in the step (if any) at the MIDI 
Edit Counter. 

 

 
 

Drum Machine Mode. This Picture Matrix enables or disables Drum Machine Record, 
in which the MIDI Edit Counter, which determines where a recorded note is placed in the 
Pattern, follows the Output counter of the Pattern. 

 

 
 

Enabled. Drum Machine Record is in effect. 
 

 
 

Disabled. Drum Machine Record is not in effect. 
 

 
 

Drum Machine Record Mode is discussed more thoroughly in Chapters 4 and 5. 
 
 
Output Controls 
 
Play-Enable 

 
This toggle allows a Voice to be heard when the music is going. When a speaker appears 
in the box, the Voice will be heard. No speaker, no sound. 

 

 
Mouse Advance 

 
This toggle enables a Voice for Mouse Advance, a way to affect the phrasing and note 
density of a Pattern with mouse gestures. Basically, a Pattern which is enabled for Mouse 
Advance won't play unless you move the mouse and have either the Caps Lock key down 
or hold both the Option and Cmd keys down. 
 
Refer to Chapter 11 for more details. 
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Output Length 
 

This numerical sets the number of steps in a Pattern that are played by a Voice. The 
Output Length can be less than the number of steps actually in a Pattern, but not more. 
 

 
 

You can also use the Output Length Numerical to permanently add or subtract steps from 
a Pattern. To do this, hold down the Option key while using the numerical. When you 
release the button, the Pattern will change to contain the specified number of steps. If this 
number is more than the previous Pattern length, rests are added at the end. If it's less, 
notes are deleted from the end of the Pattern. 
 
Setting the Output Length to 0 is a way of permanently muting a Pattern inside a Pattern 
Group Variable. 

 
Time Base 
 

These two numericals control the basic speed at which a Voice plays. This speed is some 
fraction of a whole note, and is determined absolutely by the Tempo control in the 
Conducting Window. It's also modified by the Rhythm Variable, so you should check in 
these two places as well as the Time Base if a Voice isn't playing as fast or slow as you'd 
like. 
 
The numerical on the left is the Denominator, and can be set to a number of basic and 
more exotic values. This divides the basic pulse of the Tempo. For example, a 
denominator of 8 means the Voice will play in terms of eighth notes. Possible values are 
1-9, 11,12,13,15,16, 24, and sa, a special mode which is used for Step Advance in the 
Input Control System. 
 
The numerical on the right is the Numerator, which acts to multiply the time of the 
Denominator by some value. Much of the time it will be 1. Higher numbers for the 
Numerator slow the Voice down, whereas higher numbers for the Denominator speed it 
up. 

 

Numerator Denominator 
 
Phase 

 
This numerical sets an initial delay given to the Voice after starting the music or 
performing a Sync. This allows phasing, echo, and other effects.  
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The number is expressed in Ticks, where M's Time Base Denominators last for the 
following number of Ticks: 
 
Denominator (as displayed) Ticks 
24    16 
16    24 
15    25.6 
13    29.5 
12    32 
11    34.9 
9    42.7 
8    48 
7    54.9 
6    64 
5    76.8 
4    96 
3    128 
2    192 
1    384 
sa    0 
 
For example, if you wanted to offset one Voice by an eighth note relative to the others, 
you would set its phase to 48. 
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14  The Pattern Editor Window 
 
 

The Pattern Editor is opened by double-clicking in the column of Pattern Select in the 
Patterns Window... 

 

 
 

 
...or by choosing Edit... from the Pattern menu with a Pattern selected. 
 
The Pattern Editor creates and edits Patterns — M's musical material — and manages the 
way in which you record into Patterns using MIDI. 

 
 

Display Controls 
 
Pattern Editor Size Box  

 
Drag on this control to change the size of the Pattern Editor window. 

 

 
 

View selector 
 

Click on a number 1-4 to select the Pattern to be edited in the Pattern Editor. Shift-click 
on a number to view a Pattern behind the one that's being edited. 

 

 
 

Editing Grid 
 
The Pattern Editor Editing Grid is where you draw in notes with the mouse. Notes are 
arranged chromatically from low to high, and steps in your Pattern are displayed from left 
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to right. As you move around in the Editing Grid, a Legend with dotted-line guide marks 
shows you the current note and step you're on. 

 

 
 
 

Clicking on a blank spot in the Editing Grid will place a note in the step. Clicking on a 
filled spot removes the note. The Pattern is grayed out past its last step; if you click in 
this area, your note is added to the Pattern and any intermediate steps are made into rests. 
 
You can drag the mouse horizontally or vertically in the Editing Grid when adding or 
subtracting notes. Be aware that dragging vertically creates chromatic chord clusters, 
which may or may not be of interest to you.  
 
You can always make chords out of steps, regardless of whether the Pattern is in Chord 
Record Mode or not. 

 
Keyboards 
 

To the left and right of the Editing Grid are Reference Keyboards. You can click on these 
keys to hear a note played through the edited Voice's orchestration. 

 

 
 

Vertical Scroll Arrows and Octave Scroll Icons 
 

You can see different regions of the keyboard by using the scroll arrows located above 
and below the left reference keyboard. The up and down scroll arrows scroll one note at a 
time, and the 8va and 8vb octave scroll icons scroll an octave at a time. 
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Scroll Bar 
 

The Pattern Editor contains a scroll bar at the very bottom of the window that you use to 
move forwards or backwards in the Pattern. The extent of the scroll bar is a little more 
than the maximum possible size of the Pattern (not necessarily its current length). The 
large arrows to either side scroll forward or back one step at a time. The white Thumb 
can be dragged to set a specific step location relative to the Pattern's maximum size. And 
clicking in the gray area to either side of the Thumb will page the part of the Pattern 
you're viewing forward or backward one screen. 
 

Scroll Arrows

Thumb Click here to scroll page  
 
 

Step Editing Tools 
 

At the top of the Pattern Editor window are four Step Editing Tools, one of which is 
always selected. These tools operate when you click in the region just above the Editing 
Grid. 

 
Step Editing Tools

Tools operate here

 
 

 
Selector. This tool selects a region of the Pattern for editing operations.  
  

 
 

You can either make a Pointwise selection, in which case you get a little triangle at the 
top of the Editing Grid... 
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...or select a Region of one or more steps by dragging above the Editing Grid. 
 

Region

 
 

The only command that works with Pointwise Selection is Insert Paste from the Edit 
menu. 
 
All the Pattern editing and modifying commands in the Edit and Pattern Menus work on a 
selected region of the Pattern, as well as the Eraser, Plunger, and Scissors tools described 
below. 
 
Eraser. This tool makes the cursor turn into an eraser above the Editing Grid, and 
changes a step into a rest when you click. If you have a region selected, all the steps will 
be changed to rests. 

 
 
Plunger. This tool turns the cursor into a Plunger above the Editing Grid, and will insert 
a new blank step before the step you click above. 

 

 
 

Scissors. Select this tool to turn the cursor into a Scissors, which will delete a step or 
region of steps when you click above the Editing Grid. 

 

 
 

 
 

MIDI Edit Range Bar 
 

This range bar sets a range of steps in the Editing Grid to be affected by incoming MIDI 
notes. 
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MIDI Edit Counter

MIDI Edit Range

 
 
 

MIDI Edit Counter 
 
This is an indicator you can drag to move the point at which the next MIDI notes will 
affect the Pattern. It often moves automatically while recording notes into a Pattern or 
during editing operations. (Refer to the illustration on the preceding page.) 
 

All Button 
 

This button sets the Edit Range to the entire Pattern. 
 

 
 

Counter Button 
 

This button sets the Edit Range to the current position of the MIDI Edit Counter. 
 

 
 
 

Editor Sound Enable 
 

If highlighted, the Editor will play each step as you add new notes to it; it will play steps 
when you drag the MIDI Edit Counter beneath the Editing Grid; and it will play notes 
when you click on the Reference Keyboard. Notes are played at a velocity set by the 
Editor Sound Velocity Numerical (see below), and are played through the Voice's current 
Orchestration settings. If you're viewing more than one Pattern, steps for each Pattern (if 
they exist) are played when you drag the MIDI Edit Counter. Editor Sound While 
Playing in the Options menu turns the effect of dragging the MIDI Edit Counter on or 
off while the music is playing. 

 
Editor Sound Velocity 

 
 

This numerical (shown above) sets the velocity of the notes played by the Editor Sound 
features in the Pattern Editor. 
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Record Mode, Insertion Mode, Drum Machine Mode 
Selector 

 
This contains the Record Mode, Insert Mode, and Drum Machine Mode Picture Matrices 
which allow you to select the appropriate Record Mode when recording MIDI data into a 
Pattern. See Chapter 13 for a complete discussion of Record Modes. 

 

 
Pattern Size Numerical 
 

This numerical sets the maximum size of a Pattern in number of steps. This number is 
based on an assumption that, on average, you will have no more than 4 notes in each step. 
If you plan to make a Pattern entirely full of large chords, you may want to increase the 
maximum size beyond the actual number of steps you plan to use. However, if you're 
going to have fewer than four notes per step, you can't reduce the maximum size to a 
value below the number of steps in the Pattern. 
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15  The Conducting Window 
 
 

The Conducting Window contains the Conducting Grid and controls which apply to the 
entire program's functioning. Computer keyboard command equivalents are included next 
to the name of the control, when applicable. 

 
 
Buttons 
 
Start (Space Bar) 
 

This button starts the music.  

 
 
Stop (Return) 

 
This button stops the music. 

 
 

 
Pause (Tab)  
 

This button is like Pause on your tape recorder. When you click on Pause, the music stops 
and picks up at the same place when you click on Pause again or hit Start. 

 
 

Sync (Space Bar) 
 
This button resets all Voices to the beginning — after you hit Sync, you will hear all 
Voices play the first note of their Patterns and use the first step of all the Cyclic 
Variables. 
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Movie  

Click on this button before hitting Start if you want to capture M's output into a Movie. 
After you've finished the performance for a movie, choose Save Movie As Midi File... 
from the File menu to save the movie as (what else) a MIDI File. 

 

 
 
Sequence Play Enable 
 

If you have imported a MIDI File as a Sequence to play along with the four Voices, you 
Play-Enable it by highlighting this button. The control will only work if you have 
imported a Sequence into memory, or if you're using an M document which includes a 
Sequence. 

 

 
 
 

Tempo  
 
Conducting Arrow   

 
Enable the Conducting Arrow to conduct Tempo. 

 

 
 

Tempo Range Bar 
 

This control is a range bar which sets the range over which tempo can be conducted. 
After setting the tempo range, the midpoint becomes the new tempo. When the music is 
going, a thin line indicates the current tempo. 
 

 
 
Tempo Numerical 

 
Sets the actual tempo.  

 

Tempo Numerical  
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Sync Ratio / Metronome Ratio 

 
When the arrow is pointing toward the Numerical, the numerical sets the ratio between 
M's quarter note pulse and its MIDI clock and metronome output.  
 

 
 

Setting the Sync ratio to a value above than a quarter note (e.g., an eighth note) will drive 
an external device faster, and setting the ratio to less than a quarter note (Eg. whole note) 
will drive an external device more slowly. The internal metronome will play at 
correspondingly faster or slower ratios. To use MIDI Clock you must have Send Clock 
Modem or Send Clock Printer enabled in the Options menu. 

 
When the arrow is pointing toward the fixed quarter note, the numerical sets the ratio 
between an incoming MIDI clock and M's quarter note. An eighth note setting will drive 
M twice as slowly as normal, and a whole note setting will drive M four times faster than 
normal. Click on the arrow to change its direction.  

 

 
 
 

Conducting Grid 
 
Moving the mouse (which changes to the Baton) in this space lets you conduct changes in 
any Variables enabled for Conducting. Chapter 8 contains information about Conducting. 

 

 
 
 

Automatic Conducting Enable (Robot Conductor) 
 

Selecting Automatic Conducting Enable (the Robot Conductor) enables the Baton to 
move by itself in the Conducting Grid, which allows automatic changes in any Variables 
enabled for Conducting. 

 

 
 

 



 

144 

Automatic Conducting Movement Ranges 
 

These controls let you set the range of possible movement for one jump of the Baton by 
the Automatic Conductor in the Conducting Grid. The miniature vertical range bar will 
cause larger vertical jumps if it is at a setting closer to the top, and the miniature 
horizontal range bar will cause larger horizontal jumps if it is set toward the right. In the 
picture below, both horizontal and vertical ranges are set to their minimum value. 

 

 
 
Automatic Conducting Time Base 

 
This control sets how often the Automatic Conductor makes a jump in the Conducting 
Grid. 

 
 

Refer to Chapter 8 for more information on Automatic Conducting. 
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16  The Variables Windows 
 
 
 

Features of Variables 
 
Conducting Arrows 

 
Each Variable has a Conducting Arrow, which enables and sets the direction of 
Conducting for that Variable. 

 
 

The Velocity Range and Legato Variables have special Conducting Arrow boxes, which 
contain Continuous Conducting Arrows as well as Conducting Arrows. 

 

 
 

Miniature Representation 
 

Each Variable has a miniature representation of each of its six Positions, so you have 
some idea of what the Variable Position will do. The miniature representation usually 
reflects the user interface design of the edit window. Each miniature representation 
contains four vertically arranged settings, one for each Voice. 

 

Note Density Variable Miniature Representations
 

 
For example, the lines with dots on the end in the Note Density Variable above represent 
how much of the time a Voice will play. The farther the line is to the right, the higher the 
percentage of time the Voice will play. 

 
Selecting Variable Positions 

 
One of the six Positions is selected at all times. This is called the Active Position. To 
select a new Position, just click on its miniature representation. 

 

Note Density Variable Active Position 
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Copying/Swapping Variables 
 

To swap two Variable Positions, drag one over the other and release the mouse. 
 

First and Second Positions Swapped 
 

To copy one Variable Position to another, Option-drag from the source to the destination 
Position. 

 

First Position Copied to Second Position 
 

Editing Variables 
 

To edit the settings of a Variable Position, double-click on that Position, or choose the 
name of the Variable from the Variables menu. The edit window for that Variable will 
open. The exceptions to this are Pattern Group, where you double-click on the Pattern 
Select boxes to edit a Pattern, and Sound Choice, which is edited directly in the Midi 
Window. 

 

Double-click here to open
Note Density Edit Window

Note Density Edit Window 
 
 

The Variables Window 
 

Pattern Group 
 

The six Positions of the Pattern Group Variable contain different groups of four 
independent Patterns, which are M's musical material. 
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Note Density   
 

The six Positions of the Note Density Variable contain settings for introducing random 
skips in a Voice. 

 

 
 

Velocity Range 
 

The six Positions of the Velocity Range Variable contain ranges of MIDI velocities for 
unaccented to accented notes. 

 

 
 

Note Order 
 

The six Positions of the Note Order Variable contain configurations of the three schemes 
for choosing a note or chord from a Pattern.  
 

 
 

Transposition 
 

The six Positions of the Transposition Variable contain settings for transposing individual 
Voices in performance 

 

 
 

Time Distortion   
 

The six Positions of the Time Distortion Variable contain re-mappings of time which 
produce swing, rubato, or more industrial effects. 
 

 
 
 

Cyclic Variables Window 
 

Accent 
 
The six Positions of the Accent Variable contain repeating patterns of accents that work 
in conjunction with Velocity Range. 
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.i.Legato 
 

The six Positions of the Legato Variable contain repeating patterns of articulations (sustain as 
a percentage of time between notes). 

 

 
 
Rhythm 

 
The six Positions of the Rhythm Variable contain repeating patterns of durations (times 
between notes) that work in conjunction with the Time Base. 
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Midi Window 
 

Sound Choice 
 

The sixteen Positions of the Sound Choice variable contain presets of MIDI program 
changes for each of the 16 M Output Channels. Select a Variable Position by clicking on 
a number 1-16. 

 

 
 

Sound Choice Program Numericals 
 

These are numericals that send program changes on the channel indicated by the number 
above. Once you set a numerical to a program change value, it becomes part of the 
currently selected Sound Choice Variable Position. 

 

Numerical 
 
Orchestration 
 

The six Positions of the Orchestration Variable contain assignments of Output Channels 
for each of the Voices. 
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17  Variable Edit Windows 
 
 

 

About Edit Windows 
 

Parts of an Edit Window 
  

Variable Edit Windows are where you configure the settings of any of the six Variable 
Positions. They're opened by double-clicking on a Variable Position, and closed by 
clicking on the Close "Box" (actually a triangle) next to the window's title. 
 

 
 

Each edit window contains an edit selector for choosing which Position of the Variable 
you're editing, such as the one shown for Note Density. 

 

Edit Selector 
 

 
Marking a Variable Position   
 

You can mark any Variable Position for example, to remind you that it's been edited and 
should be left alone. Select the Position in the selector and pull down. An asterisk will 
appear. 
 

 
 

You can protect marked Variables from being changed by enabling the Lock Marked 
Variables option in the Options menu. 
 
To remove the mark, click on the Position with the asterisk and pull down again. 

 

 
 

 
Changing the Active Variable Position from an Edit Window 

 
When you select a different Position of a Variable to edit, you aren't changing the 
Position that actually affects the music. However, you can do this from an Edit Window 
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if you hold down the Option key when you select a new Position for editing. This can be 
useful if you're going to use the controls in an Edit Window as a performance device. 
 
Shift-Option-selecting a new Position for editing quantizes the change in the Active 
Position according to the Snapshot quantization. 
 

 
Copying and Swapping Voice Settings 
 

Each edit window (except the Time Distortion Edit Window) has four sets of editing 
controls, labeled 1-4, for Voices 1-4. You can swap the settings for two Voices by 
clicking on a number and dragging to another number, like this: 

 

 
 

If you hold down the Option key, the information is copied instead of swapped. 
 
In the Time Distortion Edit Window, you select numbers 1-4 to choose which Voice's 
Time Map to edit. 

 

 
 
 

If you drag one of these numbers to another, you can perform the copy and swap 
operations. 
 

 
Using The Variable Edit Windows 

 
Note Density 

 
Click anywhere on the sliders to set the percentage of time the Voice will play. You can 
also use the numericals to the left. 
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Numericals

Sliders

 
 
 

Velocity Range   
 

The gray-shaded controls are range bars. You change them by clicking on one end of the 
desired range and then dragging to the other. Fine tuning can be performed with the 
numericals on either side, which represent the high and low Velocity Range values. 

 
Low Value
Numericals Range BarsNumericals

High Value

 
 
 

Note Order 
 

These controls consist of three boxes with numbers in them which you slide to the left 
and right to change the percentage of time each ordering scheme will be used. The box on 
the left represents Original Order, the middle box Cyclic Random, and the right one 
represents Utterly Random. Only the Original Order and Cyclic Random boxes actually 
move.  
 
Here's a guide to using the Note Order configuration controls: 
 
• Slide the left-hand box to increase or decrease Original Order. 
• Slide the middle box to the left to increase Utterly Random. 
• Slide the middle box to the right to increase Cyclic Random by decreasing Utterly 
Random. 
• Slide the left box to the left to increase Cyclic Random by decreasing Original Order. 
• Don't slide the right box (it doesn't move). 
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Original Order box

Cyclic Random box

Utterly Random box
(can't be dragged)

 
 
 

Transposition 
 

Each Voice's transposition settings are controlled by two numericals, one to set the Note 
and one to set the Octave. The actual note you're setting is relative to C3, which is 
defined as no transposition. This is the same way that Keyboard Transpose works in M 
(and many other programs). 
 
For example, if you were to play C#3 on the keyboard, you would transpose a Voice up 1 
half step from C3. Setting a Voice's transposition setting to this value will accomplish the 
same thing here. 

 

 
 
 

Time Distortion 
 

This window consists of a large area where you plot Time Distortion Maps for each 
Voice, and some associated controls. 

 
  Map Edit selector   

 
Selects which Voice's time distortion map you're editing. 
 

 
 

 Clear   
 

This button erases the time distortion map currently being edited. 
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 Map Length 
 

These two Numericals set the time distortion map length. The right-hand numerical sets 
the units of the length, for example, quarter notes. The left-hand numerical sets how 
many of these units are covered in the map. Obviously combinations are equivalent, such 
as 1 whole note and 4 quarter notes. There is absolutely no difference between one of 
these combinations and another. 
 

 
 

 
Time Distortion Map Editing 

 
The graph displays Time Maps for all four Voices at the same time. One of these, which 
you've chosen with the Map Edit selector, is actively being edited, and is drawn in a 
thicker line. If you're using color, this line will be drawn in gray where the others are in 
the respective Voice's color.  
 
There are two ways to create Time Maps. One is by starting from scratch. Click 
anywhere off the highlighted line, then move the mouse to each successive breakpoint in 
the map and click. After you have a Time Map, you can tug on the breakpoints and move 
them around for fine tuning. 

 

Tug here to edit
this Map

Start here to draw
a new Map
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Orchestration 
 
Each square represents the assignment of a particular M Output Channel to a Voice. You 
can drag through the squares in any row to enable or disable them quickly. In the 
assignment shown below, Voices 1-4 are playing on the respective Output Channels 1-4. 
 

 
 

Cyclic Editor (Accent, Legato, Rhythm) 
 
The Cyclic Editor edits the three Cyclic Variables. You can switch between different 
Cyclic Variables as well as between Variable Positions. Double-clicking on any Cyclic 
Variable Position will open the Cyclic Editor window. 
 

Cyclic Variable Name Buttons 
 

These three buttons select one of the Cyclic Variables for editing. The selectors for 
choosing a new Position for editing are located beneath the buttons. They're arranged 
vertically instead of horizontally because the Cyclic Variable Positions themselves are 
arranged vertically. If you click on a new Position in a selector, the Variable will switch 
as well as the Position, if necessary. In other words, if you're editing Rhythm and you 
click on the second Position in the Accent selector, you'll begin editing Accents. 

 

 
 
Editing Grids 

 
These display and edit the cycles for each Voice that make up a Cyclic Variable Position. 
An Editing Grid consists of 16 steps, each of which can be set to one or more of five 
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different levels. Specifying a number of steps defines a Cyclic Variable cycle. You set the 
length of a cycle by clicking on a number below the Editing Grid to set the last step. Any 
steps beyond the last step are grayed out. Each active step has a dot at one or more levels, 
from 0-4. Click on the intersection of the step line and the level line to assign a specific 
level to a step. You may also drag vertically to set a range of steps for M to pick from at 
random. Dragging horizontally is a quick way to set a bunch of steps to the same level. 

 
Steps

Levels

Click here to set numbers of steps 
 
Rhythm Value Numericals   

 
These controls let you assign a specific multiple of the current Time Base to each level of 
the Editing Grid for all Rhythm cycles. Refer to Chapter 7 for more details. 

 

 
 

Legato Value Numericals 
 

These controls set levels in the Editing Grid to specific values. The numbers express the 
percentage of time between notes that a note will be sustained. Refer to Chapter 7 for 
more details. 
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18  The Snapshot Window 
 
 

The Snapshot Window, on the far right side of the screen, is where you create and 
execute Snapshots — combinations of screen controls. The window also contains 
controls for Slideshows, which are sequences of Snapshots and Variable changes. 
Computer keyboard equivalent commands for certain controls are listed in parentheses. 
 

 
Drag Area  
 

The upper left corner of the Snapshot Window can be used to drag the window around on 
the screen or bring it to the front. 

 
 
 

Snapshot Controls 
 
Hold/Do (Backspace Key)  
 

This button initiates the action of collecting screen control settings. When you click on 
Hold/Do, the button begins to blink (the Hold stage), and any screen controls you click 
on will blink too. You then hit the button again (the Do stage) which will cause all the 
controls you clicked on while Holding to change together.  
 
More importantly, instead of clicking on Hold/Do again, you can click on a Snapshot, 
and all the blinking controls will be stored in the Snapshot for later recall. 

 

 
 

Snapshot Conducting Arrow  
 

This enables conducting of Snapshots. The first six snapshots will be executed (if they 
exist) based on the position of the Baton in the Conducting Grid. 

 

 
Snapshot Quantization  

 
This Numerical sets the rhythmic value to which changes will be "rounded off" when 
executing Snapshots (including Conducting them), performing a Sync, initiating 
Slideshows, or making quantized changes to Variables by shift-clicking. The wave value 
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(shown on the left below) means that no quantization is performed. The whole note value 
will delay the execution of an event until the next whole note quantization point. You can 
think of the whole note quantization point as some multiple of four beats away from the 
point in time that you hit the Start button.  

 
 

 
The Snapshots (Letter keys A-Z)  

 
These are 26 locations for storing screen control combinations. The procedure for 
creating Snapshots is described under the Hold/Do Button above and the Blink 
Everything Button below. Clicking on a Snapshot location that exists (such as A below) 
or typing the letter of the Snapshot will recall the stored screen control settings. Things 
which can be included in a Snapshot include: 
 
• All Variable Positions. 
• Settings of all Conducting Arrows. 
• The settings for Src Channel, Play-Enable, Echo-Thru-Orchestration, Mouse Advance, 
Output Length, Time Base, and Phase for each Voice in the Patterns window. 
• Sync. 
• Play-Enabling or Play-Disabling the MIDI File Sequence that plays along with the four 
Voices. 
 
The last two items are included in a Snapshot by clicking on the Sync Button and the 
Sequence Play-Enable Toggle in the Conducting Window. 
 

Current Snapshot indicator  
 

This is depicted by a black mark in the sun of an existing Snapshot display. It is changed 
whenever you store or execute a Snapshot. 

 

Current Snapshot
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Edit Snapshot 

 
This button begins blinking all the screen controls stored in the Current Snapshot, 
allowing you to add, change, or subtract controls. To delete an item from a Snapshot, 
click on the item while it's blinking. 
 
After you've edited the Snapshot, you can store it in any Snapshot location by clicking on 
the desired location, or cancel the Edit by clicking on Hold/Do. 

 

 
 

Restore From Snapshot 
 

This button undoes the changes brought about by the most recently executed Snapshot. 
 

 
 
Blink Everything  
 

This button begins blinking all possible screen controls that can be included in a 
Snapshot. At this point, you can perform editing operations as with the Edit Snapshot 
command, or a normal Hold/Do, and then store the global collection in a Snapshot by 
clicking in the desired location. 

 

 
 
 

Slideshow Controls 
 
The Slideshows (Number keys 1-9) 
 

These buttons, at the right side of the Snapshot window, control Slideshow recording and 
execution.  

 
To record a Slideshow, Option-click on the location (which will be numbered 1-9) where 
you want to store the Slideshow (or type Option-1-9). The music must be going in order 
to add events to a Slideshow. The Slideshow Pause button will light up, as well as the 
Record Indicator in the Slideshow. 
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Slideshow Pause

Record Indicator

 
 
Slideshow Pause will un-highlight when you execute the first Snapshot or Shift-click on a 
Variable Position. The time between Snapshot executions is recorded as well as which  
Snapshot you've executed. Recording is stopped by clicking on Slideshow Stop or the 
Stop button in the Conducting Window, and a number appears in the Slideshow to 
indicate that something has been recorded. 

 

Slideshow Stop

Recorded Slideshow

 
 

To play back a Slideshow, click on the desired Slideshow or type 1-9, just as you would 
execute a Snapshot. The start of the Slideshow is quantized by the Snapshot execution. 
While it's running, the Slideshow can be stopped by clicking on Slideshow Stop, paused 
with Slideshow Pause, or started over from the beginning by clicking on the Slideshow 
again. Note that the Slideshow does not record the contents of a Snapshot, only its 
location. So if you change a Snapshot after recording a Slideshow, the program will 
execute the new, altered Snapshot rather than the old one. 

 

Executing Slideshow

 
 

Slideshow Stop (0 number key) 
 

This button stops Slideshow recording or playback.  
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Slideshow Pause (Option-Tab)  
 

This button is lit up when a Slideshow is recording but no events have been executed, 
although you can begin recording immediately by disabling the Slideshow Record Wait 
option in the Options Menu. You can also click on this button to pause Slideshow 
recording or playback without stopping the music, in the same way the Pause button in 
the Conducting Window operates on the music as a whole. 

 

 
 
Slideshow Loop (Vertical bar or Backslash key)   

 
This button adds a loop point to any recording or playing Slideshow. If the Slideshow is 
in the process of being recorded, setting the loop point stops the recording and adds the 
loop at the very end. If the Slideshow is playing, the loop is added and the Slideshow 
subsequently begins to repeat. Keying Option-Vertical bar / Backslash on the computer 
keyboard or Option-clicking on Slideshow Loop removes a loop point during Slideshow 
playback.  

 

 
 

 
Slideshows with loops in them display repeat marks, as shown below: 
 

 

Looped Slideshow 
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19  The File Menu 
 
 

The File Menu contains commands for opening and saving files, and for quitting the 
program. 

 

 
 
 

New 
 
New brings the program back to its startup state. 
 
You can set the startup to whatever you like by using the File Menu's Save State As 
Startup command, described below. 
 

 
Open... 

 
Open... allows you to select an existing M Document, which contains all of your work 
with the program, replacing whatever work you've already done. Some programs contain 
a Close command in the File Menu which closes the current document, after which you 
have to choose Open... to open another one. In M, since you can only have one document 
open at a time, we dispensed with the Close command, since the only thing you'd do 
afterwards is New or Open... anyway. 
 
If you're working on something that you haven't saved before choosing Open..., you'll be 
asked if you want to save it first. 
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Open.... first presents you with a standard file dialog that lists the names of all the M 
documents currently saved on disk.  
 
When you open an M Document, the current state of the program will be overwritten by 
the contents of the newly opened Document. The name of the new Document will appear 
as the name of the Conducting Window. 

 
 

Open Midi File... 
 

Opening a MIDI File is a way to import notes and chords into M which were saved by a 
MIDI-File compatible application (such as M, Jam Factory, or Upbeat). There are two 
ways you can do this: by reading the information into an M Pattern, or by reading it in as 
a Sequence. 
 
This command does not ask you if you wish to save your work first, because you're not 
necessarily going to overwrite anything. 

 
Reading MIDI Files into Patterns 

 
First, select the Pattern Group into which you'd like to read the notes in the MIDI File. 
The MIDI File is always imported into the currently selected Position in the Pattern 
Group Variable. Then choose Open Midi File... from the File menu. 
 
You'll see the following dialog (with your own file name displayed in the title area). 

 

 
 

The Import Dialog allows you merge or separate different MIDI channels in the file into 
one or more of the four Patterns in the current Pattern Group. You can also control how 
timing information is interpreted when the data in the file is "recorded" into the Pattern. 
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The controls under the heading of Source Channels let you assign data in the MIDI File 
to be read into specific Patterns. For example, here's the setup if you have a MIDI File 
with separate tracks on Channels 1-4, and you want to read each track into a separate 
Pattern: 

 

 
 

Here's the channelization setup if you want to merge all tracks in the file into one Pattern. 
The easiest way to get this setting is to click on the All button. 

 

 
 

Here's a setup in which all tracks are read into all four Patterns. This might be interesting 
if each of the File Recording Parameters (discussed below) were to be set differently. 
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File Recording Parameters 
 

Each of the MIDI File recording parameters can be set independently for each Pattern. 
They describe how M should interpret freeform MIDI File data into the format of an M 
Pattern, which is just a series of steps with notes, chords, or rests, and no durations. 
 

 
 Chord Method  

 
This is a Picture Matrix similar to the Chord Mode that you select when recording a 
Pattern from MIDI (see the discussion of the Patterns Window for details), but Build 
Mode is not available.  
 
Chord Mode means that events in the MIDI File that M interprets to be chords will be 
saved as chords. Chords are interpreted by means of a quantization factor, which we'll 
discuss below.  

 

 
 
 

In Single Note Mode, events are separated into steps with one note in them, regardless of 
how little time occurs between them. 

 

 
 

 Timing 
 

M has a quantization algorithm which can turn notes which last longer than a threshold 
setting into note steps followed by rest steps. The quantization algorithm also decides 
how much time to merge into a chord. For example, if you quantize to eighth notes, 
anything in the MIDI File closer together than an eighth note will be merged into a chord. 
If subsequent events are farther away than two eighth notes, a rest will be added (if 
you've set Rests to Dur instead of None). 

 

 
 

 
The algorithm probably won't do what you want with complex multi-rhythmic parts, but 
you'll get the best results importing simple single line material into M in any case. 
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Import As Sequence 

 
If you click on this toggle button, the method of importing the MIDI File changes. 
Instead of being cut into steps for a Pattern, the MIDI data is imported faithfully as a 
Sequence which can be played along with the four Voices.  
 
 
The only controls active in the Import Dialog when you're using Import As Sequence are 
the top row of channelization enable buttons, which are initially set to All. Deselecting a 
channel will cause any information on that MIDI channel to be ignored in the MIDI File 
and not to be read into the Sequence. 

 

 
 
 

You control whether the Sequence is playing with the Sequence Play-Enable Toggle in 
the Conducting Window. 

 
When You're Ready 

 
After you've configured how you want the MIDI File to imported, click on the Import 
button. Or click on Cancel if you decide that importing the MIDI File just isn't right for 
you at this time. M will understand. 

 
Save, Save As... 
 

These commands save your current work as an M Document. It's a good idea to save your 
work periodically, even while it's in progress, to protect it from accidents such as power 
failures or even software failures, which we all know never happen. After all, it's 1988, 
and computers are finally reliable. 
 
Choose Save to automatically replace the version already stored on disk with the current 
settings. If you haven't saved the file yet, this command is the same as Save As.... 
 
Choose Save As... if you're saving the file for the first time or if you want to save your 
current version with a new name. A standard dialog for saving a file will be presented. 
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Save Movie As Midi File... 
 

This command is highlighted only after you have captured an M performance as a Movie. 
Choosing Save Movie As Midi File... will produce the standard dialog box for saving 
files. 

 
Save State As Startup 
 

This command saves the current state of the screen inside the program itself, so that when 
the program is opened, by choosing New or by starting M from the Finder by double-
clicking on the program's icon, it will display that current state as the startup screen. 
 
Save State As Startup can be useful for tailoring M's default behavior to the way that 
you prefer to work. If you have only one MIDI synthesizer, for example, you might want 
to configure the Orchestration Variable to output all the Patterns through MIDI channel 1. 
 
Your disk must be unlocked to perform Save State As Startup successfully, and there 
must be at least 50K of free space on it (this space won't actually disappear, it's just 
needed temporarily). 
 
Save State As Startup does not save the contents of Patterns in Pattern Groups nor will 
it save Time Distortion Maps. 

 
 

Midi Assignment... 
 

Midi Assignment... opens an edit window for configuring your MIDI setup. The most 
important function of this window is to map M Input and Output Channels to specific 
MIDI devices and channels.  
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Assigning Input Channels to Devices and MIDI Channels 
 

The Input Channels section of the Midi Assignment window allows you to assign a 
Device and channel for each M Input Channel. You can choose an input device from the 
popup menu in the Port/Device column under Input Channels, and use the Numerical in 
the Chan column to select a specific MIDI Channel for an M input channel. Typically, if 
you have one input device, it will be selected for all input channels, and the Chan column 
will match the input channel, as is shown in the window above. 
 
M provides two virtual input devices, to M 1 and to M 2, for connecting other software’s 
MIDI outputs to M. 

 
Assigning Output Channels to Devices and MIDI Channels 
 

The Output Channels section of the Midi Assignment window allows you to assign a 
Device and MIDI channel for each M Output Channel. 
 
M provides two virtual output devices, from M1 and from M 2, for connecting M’s 
output to other software. Other software may have its own virtual inputs; you can also use 
these inputs to connect M’s output to other software. 

 
First Program Change Number 
 

As we explained in the discussion on the Sound Choice Variable, different synthesizers 
have different ideas about how to display the first MIDI program change number. First 
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Pgm Change lets you tailor the display in each of the Sound Choice Numericals to the 
display behavior of your synthesizers. 
 
The 1st Pgm column of the Output Channels section of the window contains this setting 
for each M output channel. A value of 1 means the channel’s program number display 
will start at 1 and go to 128, and a value of 0 means the channel’s program number 
display will start at 0 and go to 127. 
 
Clicking in the box for each MIDI channel reverses the current setting. The Sound 
Choice Numericalsin the Midi Window are updated automatically to reflect the new 
setting. 

 
MIDI Messages 

 
The Send Msg… column of the Output Channels section, along with the buttons in the 
lower right corner of the Midi Assignment window, can be used to transmit MIDI 
messages to devices to change how they're behaving. This feature is generally 
unnecessary with more recent multitimbral synthesizers. 
 
To transmit a MIDI Message: 
 
• Select the channels on which you want to transmit the message. 

 

 
 

• Click on the desired button and the message will be sent. In the example shown above, 
the message would be sent on channels 1, 2, and 3. 

 
What The Messages Do 
 

Omni On tells your synthesizer to play notes received on all MIDI channels.  
 
Omni Off tells your synthesizer to receive on only the MIDI channel(s) that it's been set 
to. With one synthesizer that plays only one timbre, such as an original DX7, use the 
setting of Omni On. If you have a multi-timbral synthesizer, or if you're using several 
synthesizers, you'll most likely choose Omni Off. 
 
Local Control Off disconnects a synthesizer's keyboard from its sound generating 
mechanism, but still send the MIDI messages associated with what you're playing. This 
allows you to use the keyboard to transpose or control various functions in M without 
hearing the keys you depress played as notes.  
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Local Control On restores the connection. Some synthesizers, notably the original DX7, 
are always in Local Control On mode. 
 
System Reset sends a special command that's supposed to cause any synthesizer that's 
listening to reset to its "power-up" state. You probably will never have to use this button. 
None of us have. 
 
All Notes Off sends a message to your synthesizers to end any notes that may still be 
sustaining. This is useful to get rid of "stuck notes" caused by human error or software 
problems. 
 
Note:  You can send All Notes Off messages to all the channels in the Current 
Orchestration at any time by typing Cmd-period. 
 
Panic is another version of All Notes Off which actually sends a Note-Off message for 
every possible MIDI note on the selected channels. This command will get rid of stuck 
notes on certain equipment that doesn't respond to the usual All Notes Off message. 

  
Conducting with MIDI Controllers 
 

MIDI Conducting alows you to use any two MIDI Controllers to move the Baton in the 
conducting grid. This could be useful in a live performance situation. 
 
These controllers can be on any MIDI channel, port or OMS Device. Even if you don’t 
have an OMS device utilized in the Input Channels column, it can still send controllers 
that will be used for MIDI Conducting. 
 
One Controller will be assigned to move the Baton horizontally... 

 

 
 

...and the other will move the Baton vertically.  
 

 
 

Use the numericals to specify which MIDI Controller number you wish to use for each 
dimension. If you use the same controller number for both dimensions, you'll only be 
able to move in a diagonal line, which isn't all that useful. The controller numbers 
displayed in the numericals may be off by 1 compared to the user interface of the device 
you're configuring (such as the Kurzweil MIDIboard), but rest assured that, according to 
the MIDI specification, we're right and they're wrong. 
 
In order to use MIDI Conducting feature, you must enable it by choosing Midi Conduct 
from the Options menu. 

 
Send Sync 

 
This feature is currently disabled 
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Latency 
 
The Latency numerical allows you to delay M’s output by a specified number of 
milliseconds in order to prevent timing problems with certain USB MIDI interfaces. By 
default the value is 0, which works fine for software synthesizers. The maximum latency 
is 999ms. If you need to increase the latency, you’ll probably want to use a value of at 
least 100ms, perhaps something like 250ms. The latency value you enter will be restored 
the next time you launch M if you choose Save State as Startup from the File menu. 
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20  The Edit Menu 
 

 
 

 
 

The Edit Menu commands allow you to move or duplicate information from one Pattern 
or Region of a Pattern to another.  
 
In order to use these commands, you must indicate which Pattern or Patterns you'd like 
the operation to affect by selecting them in the Patterns Window, as shown below. 

 

 
 

 
You can select all four Patterns at once by dragging from top to bottom. Shift-selecting 
also works, in case you'd like to perform the same operation on the first and third 
Patterns, as in the example above. 
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The Edit Menu also works on a Region of a Pattern, which you create with the Selector in 
the Pattern Editor. 

 
 
 

Cut, Copy, Paste 
 

To copy information from one Pattern or Region to another: 
 
• Select the Pattern or Region from which you want to Copy.  
• Choose Cut or Copy from the Edit menu. Cut and Copy are identical except that Cut 
also removes all the selected steps from the Pattern. 
• Select the Pattern to which you want to paste. You can paste to a Pattern location in a 
different Pattern Group by switching Pattern Groups first, or even a different file by 
opening another M document before pasting. 
• Choose Paste from the Edit menu. 
 
When Paste duplicates an entire Pattern, the Record Modes, Output Length, Time Base 
and Phase information are duplicated too. Paste Notes (discussed below) does not change 
any of this information in the destination Pattern. Both Paste commands, as well as the 
Insert Paste command, leave non-note information alone when copying from or pasting 
to Regions. 
 
What happens when the destination Region is a different number of steps than what 
you're pasting?  If the destination is too small, the Pattern being pasted is truncated (if 
this is not what you want, see Insert Paste below). If the destination is too large, the 
selected Region is filled out with rests.  

 
 

Clear 
 

To clear the contents of a Pattern or Region: 
 
• Select the Pattern or Region you want to clear. 
• Choose Clear from the Edit menu. In the case of an entire Pattern being selected, the 
Pattern's Output Length will be set to 0, reflecting the fact that all notes have been 
deleted. In the case of a Region, all the selected notes are deleted, and Output Length is 
decremented by the number of steps deleted. 
 
For Regions, this command is identical to using the Scissors. 
 
The Clear key is equivalent to the Clear menu item. 
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Paste Notes 
 
This command is identical to Paste except that when pasting an entire Pattern, only note 
information is copied, without affecting the destination Pattern's Record Modes, Output 
Length, Time Base or Phase. Refer to the discussion of Paste above for more 
information. 

 
 
Change to Rests 

 
This command replaces all the notes in the selected Pattern or Region with rests. For 
Regions, it's identical to using the Eraser. This is a useful command to clear a Pattern 
when using Drum Machine Record, as it doesn't change the length of the Pattern you've 
set up. 
 

 
Fill With Rests 

 
This is one command you may not use very often. It fills the entire Pattern, up to its 
maximum size (as indicated by the Pattern Size Numerical in the Pattern Editor), with 
rests. Fill With Rests doesn't care whether you have a Region or Pattern selected. It 
obliterates everything in its path. 
 

 
Insert Paste/Paste at End 

 
If an entire Pattern is selected, this item is displayed as Paste At End. If a Region is 
selected, the command is displayed as Insert Paste. 
 
Paste At End places all the note information at the end of the selected Pattern, increasing 
the Pattern's length. It leaves the Pattern's non-note information alone. 
 
Insert Paste is similar to Paste Notes except that it inserts any steps needed to completely 
Paste the information. Insert Paste is the only editing command that works with a 
Pointwise Selection, which is what you get when clicking on a single step and then 
releasing the mouse button without dragging. 
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In the Pattern shown above, Insert Paste would paste the information after the step 
containing C, so that the last note of what was pasted would come immediately before the 
G. 
 
If you want to paste some notes at the beginning of a Pattern, make a Pointwise Selection 
before the first step, like this: 

 

 
 
 

 
Erase Snapshot 
 

This command clears the currently selected Snapshot (the one with the black mark in the 
sun). If no Snapshot is so marked, the menu item will be dimmed. 
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21  The Variables, Pattern, and Windows 
Menus 

 
 
 

The Variables Menu 
 

 
 

The commands of this menu open each Variable's Edit Window, with the currently active 
Position displayed for editing. It's identical to double-clicking on the active Position of a 
Variable. The Variables Menu might come in handy if your favorite Variable is buried 
deep beneath some other edit windows, and you want to bring its edit window to the 
front. If the edit window is already open, you can accomplish the same thing with the 
Windows Menu. 
 

Voice 1-4 Color... 
 

These commands bring up the standard Color Picker dialog to change the color that's 
used to display information for one of the four Voices. The Voice Colors are not saved in 
files, but they are saved in the Startup State, so after you change them to something you 
like, choose Save State As Startup from the File menu to make the change permanent. 
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The Pattern Menu 
 

The commands in the Pattern Menu operate on any selected Patterns or Regions. Refer to 
the discussion of the Edit Menu for information about selecting commands.  
 
The first command, Edit... merely opens the Pattern Editor and is a substitute for opening 
the Pattern Editor by double-clicking on the selected Pattern. Edit... might be useful if the 
Patterns Window is buried beneath a bunch of other windows. 
 
The other commands in the Pattern Menu transform selected Patterns or Regions in 
permanent ways. Unlike those in the Edit Menu, these commands permanently modify, 
rather than replace, the selected Pattern or Region. 
 
Notice that we said permanently modify. You can achieve some of the same results of 
choosing Pattern Menu commands by using M's Variables, but the difference is that the 
effect of a Variable is always temporary — you can change the effect by changing the 
Variable. 
 
If there's a Pattern Menu command you have a question about, the best way to learn what 
it does is to select a Region in the Pattern Editor and watch how it is transformed after 
you issue the command. 
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Transpose Up Half-Step 
Transpose Up Octave 
Transpose Down Half-Step 
Transpose Down Octave 

 
These commands will permanently transpose a selected Pattern or Region by the 
specified amount.  
 
Note the difference between these commands and the Transposition Variable. The 
transpose commands change the key of the actual note material inside the Pattern, rather 
than merely playing that material with a pitch offset. 
 

ReScramble 
 

This command generates a new Cyclic Random ordering of the selected Pattern or 
Region. You employ this ordering in a Voice by using the Note Order Variable. Refer to 
information on the Note Order Variable in Chapter 7 for more details. 
 

Original -> Scrambled 
 

This command copies the Original list to the Cyclic Random list. It has very little use, 
except that if you  perform only a few editing or recording operations, the order of only a 
few of the notes will have been changed in the two lists. However, you could probably 
get a similar effect by using a Note Order configuration of 90 per cent Original Order and 
10 per cent Cyclic Random. The only advantage of doing it the Original -> Scrambled 
way is that you would be sure which steps were being scrambled. 
 

Swap Scrambled and Original 
 

This command exchanges the list created by the Cyclic Random ("scrambled") ordering 
of notes with the Original list (i.e., the order you see in the Pattern Editor). If operating 
on a Region, only the notes in the Region of the Original and Scrambled lists in the 
region are exchanged. 
 

Rotate Forward 
Rotate Backward 

 
These commands rotate the steps of the selected Pattern. Great, you say. What does that 
mean, and why would I ever want to use it? 
 
Rotating a Pattern forward means that the first step in the Pattern becomes the last step, 
the second step becomes the first step, the third step becomes the second step, and so on, 
as shown "before and after" below with a C scale. 
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Rotating a Pattern backward means that the last step becomes the first step, the first step 
becomes the second step, the second step becomes the third step, and so on, as shown 
below with the C scale. 

 

 
 
 

If you think about it for a moment, it should be clear that if you performed a Rotate 
Forward followed by a Rotate Backward, you'd end up with your original Pattern 
again. 
 
The Rotate commands can be useful in changing the melodic or rhythmic relationship 
between one Pattern and another, and can be especially interesting in working with 
Patterns with a lot of rests, such as those created in Drum Machine Record Mode. 
 

Reverse Order 
 

This command reverses the notes in the Pattern or Region, for those who like things 
backwards (i.e., backwards things like who those). 
 

Double with Rests 
 

This command expands the Pattern or Region by inserting a rest after each step, as shown 
in the before and after example below. 
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Here's something interesting you might try to illustrate Double with Rests. 
 
• Create two different Patterns with the same number of steps. For proper aesthetics, just 
make Patterns with single notes in them. 
 
• Select both Patterns and choose Double with Rests from the Pattern menu. 
• Select one of the Patterns and choose Rotate Forward from the Pattern menu. 
 
The notes of one Pattern are now offset from the other. You could have done the same 
thing with the Phase control, but this way of doing it makes the alternating nature of the 
music independent of the Time Base setting you're using. 

 
Triple with Rests 

 
This command, as you might guess, expands the Pattern or Region by inserting two rests 
after each step. 
 

Eliminate Chords 
 

This command expands the selected Pattern or Region by turning each step containing a 
chord into a series of steps, each one containing a note of the chord. The order of the new 
steps is determined by the order in which you entered the notes of the chord, which, when 
playing on a MIDI keyboard, isn't always predictable. 
 
Note:  When you use Double With Rests, Triple With Rests, or Eliminate Chords, the 
length of the Pattern is increased automatically. 

 
Eliminate Rests 

 
This command shrinks the selected Pattern or Region by deleting all rest steps. Eliminate 
Rests is a way to undo an unfortunate choice of Double With Rests or Triple With 
Rests. 
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The Windows Menu 
 

This menu manages M's many windows. The contents of the Windows Menu will vary as 
you open and close edit windows. 

 

 
 
Close Edit Windows merely closes any edit windows you have open.  
 
The other commands bring the named window to the front, as an alternative to clicking 
on their title bar or Cmd-clicking on any other part of the window. This is useful if the 
window you want to use is buried under a lot of other windows. Incidentally, the top 
window in the list is the Conducting Window. 

 
Another keyboard shortcut for managing windows is Cmd-Option-Number. Typing this 
will send to the very back whatever window would have been brought to the front with 
Cmd-Number. So, for example, since Cmd-5 brings the Midi Window to the front, Cmd-
Option-5 will send the Midi Window behind all other windows. If no windows are on top 
of each other, nothing will appear to have happened. 
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22  The Options Menu 
 
 

The commands in the Options Menu are settings that can be turned on and off by 
choosing them. An Option is on when the menu item shows a check mark and off when 
there's no check mark. Below, all Options are shown unchecked, or Off. 
 

 
 

 
Use Metronome 

 
Choosing this command turns the Metronome on and off. When Use Metronome is 
enabled, you hear a click from the speaker to help synchronize your playing to M's clock. 
 
The ratio of the metronome to the speed of a quarter note played at the current tempo can 
be adjusted with the Sync Ratio Numerical in the Conducting Window. For more 
information, refer to the discussion of this numerical in Chapters 8 and 15 on controls in 
the Conducting Window. 

 

Sync Ratio Numerical 
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Send Clock  
 

When enabled, M sends MIDI Clock messages to the Device chosen in the Send Sync 
popup menu in the Midi Assignment window. 

 
External Clock 

 
This feature is no longer available. 

 
Tap Affects Velocity 

 
This Option enables the effect of modifying the overall velocity of all M's Voices (plus 
the MIDI File Sequence) by the velocity of the last MIDI key pressed when using the Tap 
Conducting feature of the Input Control System. Velocities are modified depending on 
whether the key pressed was above velocity 64 (the defined "medium velocity"). See 
Chapter 10 for a discussion of the Input Control System and the Tap Affects Velocity 
feature. 

 
Don't Scramble Rests 
 

This option preserves the location of rests in the Cyclic Random ordering when a 
reordering operation is performed each time you edit or record into a Pattern. It is not 
retroactive, so if you  
enable Don't Scramble Rests after having done some recording or editing, some of the 
Pattern's rests could be in different places in the Original and Cyclic Random lists. 
Choosing ReScramble from the Pattern Menu after enabling Don't Scramble Rests is 
the way to ensure consistency. 
 
What's the use of this option?  In Patterns where the position of notes versus rests is 
essential to the rhythm, you can use Cyclic Random ordering with confidence that the 
rhythmic relationships will remain consistent. 
 
Incidentally, the algorithm used to perform this operation during Pattern editing is 
probably the most complicated in the entire program, so use and enjoy Don't Scramble 
Rests often and think of the suffering that went into creating it. 
 

 
Slideshow Record Wait 

 
This option, when enabled, makes M wait for the first executed event (a Snapshot or 
quantized Variable) before recording time in the Slideshow. If this option is disabled, 
time is recorded immediately after starting the music (or if the music is going, 
immediately after the Slideshow is enabled for recording). Almost everyone will want 
this option checked, as is the default state. 
 

 
No Zoom Rects 
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This option disables the traditional window-zooming when opening a Variable's Edit 
Window. At faster tempos on slower machines, drawing the Zoom Rects can be 
somewhat slow, causing frustrating delays in response to user gestures and window 
updating. If this happens, or if you find Zoom Rects distasteful, try enabling No Zoom 
Rects. 

 
 

Sustain Enters Rests 
 

Sustain Enters Rests enables the recording of rest steps into a Pattern each time you 
press down on the sustain pedal connected to your synthesizer keyboard or controller.  
 
Don't forget that this option is on and use the sustain pedal while echoing MIDI data for 
expressive effect while recording, or you may get some unexpected rests in your Patterns. 
 

 
 

Midi Conduct 
 

This option enables a mode of conducting in which the Baton is moved around the 
Conducting Grid by MIDI Controllers. Refer to MIDI Conducting in the discussion of the 
Midi Assignment Window in Chapter 19. 
 

Second Order Transpose 
 
When enabled, this option preserves the relative transpositions set in the Transposition 
Variable when using the Keyboard Transpose feature to transpose Voices with your 
MIDI keyboard. 
 
The following diagram illustrates the effect of Second Order Transpose. 

 
Transposition
played from
Keyboard

Transposition
Variable Total

Transpositionvalue

 
 
 

If Second Order Transpose had not been enabled in this case, the total transposition 
would have been D#3, not D#4. 

 
 

No Cyclic Blinking 
 

Turn this option on if the blinking that occurs when Cyclic Variables reset to the 
beginning of a cycle irritates you or seems to be degrading the response to the mouse and 
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keyboard (such a problem will be sometimes be seen when M doesn't stop playing 
immediately when you type Return). 
 
There's no way to disable the blinking that you see in the Pattern Group Variable when 
Patterns start over again. We feel this blinking is reasonably harmless and usually 
helpful. 

 
 

Sync Restarts Sequence 
 

If this option is enabled, the imported MIDI File Sequence which plays along with the 
four Voices will restart at the beginning when you perform a Sync. You'll want to disable 
Sync Restarts Sequence if your MIDI File is rather long and you plan on performing a 
lot of Snapshots which will include Syncs. The four Voices will still sound synchronized 
to the sequence if you set the Snapshot Quantization Numerical appropriately. 
 

Editor Sound While Playing 
 

If this option is enabled, the controls that play MIDI data in the Pattern Editor (the 
Reference Keyboards, adding notes to steps, and dragging the MIDI Edit Counter) will 
continue to do so while the music is going. If this option is disabled (as is the default 
state), the Editor Sound features will only work when the music is not going. Note that 
you have to have the Editor Sound feature in the Pattern Editor enabled for this option to 
matter at all. 

 

Editor Sound Button (enabled) 
 
 

Locked Marked Variables 
 
The six Positions of all Variables, except Pattern Group and Sound Choice, can be 
marked in an edit window by clicking on the selector for editing a new Variable Position 
and dragging down with the mouse.  

 
 

Marked Variable Positions
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The mark can serve as a reference that you've already used the Position and don't wish to 
change it further. Or perhaps you want to reserve one Position in a Variable for using the 
edit window as a performance device, preserving the other Positions.  
 
If you'd like M to reinforce these desires, you can enable Locked Marked Variables. 
When this option is checked, the edit windows become inoperative on Variable Positions 
that have been marked. You can always unmark a Variable Position by making the same 
click-and-drag-down gesture as you made to mark the Position in the first place, so 
Locked Marked Variables isn't such a bad deal. 

 

Echo In Background 
 
If Echo in Background is enabled, M continues to process incoming MIDI while another 
application is in the foreground. This feature only works when using the MIDI Manager 
or OMS in either the MIDI Manager mode or when Run MIDI in Background is enabled 
in OMS MIDI Setup. 
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Appendix A - M Power User Guide 
 
 

Modified Mouse Actions 
 

General 
 
Cmd-click on any window brings that window to the front without performing any action. 

 
If Cmd-# is a Cmd-key equivalent to a bringing a window to the front in the windows 
menu, Cmd-Option-# sends that window to the very back. 
 
Shift-click on any Numerical changes the Numerical to match the value of the Numerical 
you changed most recently (within the limits of the Numerical you shift-clicked on). 
 

Variables and Edit Windows 
 
Dragging on a variable position copies or swaps the information to another position. Drag 
swaps source and destination, Option-drag copies from source to destination. 

 
Option-click on a variable position in an edit window changes that position to be both the 
currently edited position and the currently active position. You can also Shift-Option 
click, to quantize this selection. 

 
Option-click on Pattern Group Variable position doesn't do a Sync when you select it. 
 
Clicking on the the numbers 1-4 in edit windows (except Pattern Editor) can be used to 
copy or swap information for each Voice in that variable position. Drag swaps source and 
destination, Option-drag copies from source to destination. 
 

Pattern Editing 
 
Shift-click on a number 1-4 in the View column in the Pattern Editor allows you to view 
a Voice's Pattern along with the Pattern currently being edited. The notes are shown in a 
gray pattern of the Voice's color. 
 
Option-click on an Output Length Numerical in the Patterns Window permanently adds 
or subtracts steps from the Pattern (adds rests). 
 

Conducting 
 

Option-click in the Conducting Grid clears the effect of Continuous Conducting 
(dragging has no effect when option-clicking). 
 
Shift-click (or drag) in the Conducting Window quantizes conducting actions to the 
Snapshot quantization and includes any variable choices (and of course Snapshots) in a 
Slideshow, if you're recording one. 
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Hold/Do, Quantization, Snapshots, and Slideshows 

 
Shift-click on a variable position quantizes that position to the Snapshot Quantization and 
includes it in a Slideshow, if you're recording one. 
 
Shift-click on the Hold/Do Button in the Do phase of the action quantizes the actions that 
will take place to the Snapshot Quantization. Shift-click when storing a Snapshot at the 
end of a Hold/Do has the same effect. 
 
Shift-click when executing a Snapshot forces a Sync to be performed, even if none has 
been included in the Snapshot. This feature is also in effect if you type a capital letter A-
Z to execute the Snapshot. 
 
Option-click on a Slideshow 1-9 enables the Slideshow for recording. 

 
Keyboard Equivalents to M Commands 
 
General 

 
Space Bar - Start / Sync 
 
Return Key - Stop 
 
Tab Key - Pause / Unpause 
 
Backspace - Hold/Do 
 
Clear key - same as selecting Clear from the Edit menu 
 
Tilde/Grave key - plays step at MIDI Edit Counter in Pattern Editor (held as long as you 
hold the key down). This works if the Editor window is open. 
 
Comma/Greater Than key - plays step in Legend in Pattern Editor Editing Grid (the step 
at the cursor position, at the junction of the dotted lines). This only works if the mouse 
cursor is positioned within the Editing Grid. 
 
Cmd & Option keys held down together - momentarily enables Mouse Advance 
 
Caps Lock - indefinitely enables Mouse Advance 
  
A thru Z - execute (or store, if in Hold/Do) Snapshot 
 

Slideshow Keys 
 
1 thru 9 - Execute Slideshow 
 
0 - Stop any Slideshow 
 
Option-1 thru 9 - Slideshow Record 
 
Option-Tab - Slideshow Pause 
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Backslash/Vertical Bar - Insert Slideshow Loop point 
 
Option-Backslash/Vertical Bar - Remove Slideshow Loop point 
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Appendix B - M Input Control System 
 

Accelerando

Ptn 1 On/Off

Ptn 2 On/Off

Ptn 3 On/Off

Ptn 4 On/Off

Clear Ptn 1

Clear Ptn 2

Clear Ptn 3

Clear Ptn 4

Step Adv Voice 1

Step Adv Voice 1

Tap Tempo

Step Adv Voice 2

Step Adv Voice 2

Stop

Start

Step Adv All Voices

Step Adv All Voices

Sync

Step Adv Voice 3

Mute Sequence

Step Adv Voice 4

Stop Slideshow

Record Slideshow…

Edit Snapshot…

Step Adv Voice 3

Hold/Do

0

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

17

18

19

20

21

22

23

24

25

26

C3 (Middle C)C1

C2 C4

Value Function Value Function

Exec Snapshot…

Ptn 1 Time Base…

Ptn 2 Time Base…

Ptn 3 Time Base…

Ptn 4 Time Base…

Pattern Group…

Ordering…

Sound Choice…

Orchestration…

Transposition…

Intensity Range…

Note Density…

Duration…

Decelerando

Execute Snapshot…

Accent…

Legato…

Freeze Tempo

Play Slideshow…

Tap ConductC5

Step Adv Voice 4
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Index  

"Running out of Film", 120 
1st Pgm, 164 
Accelerando, 112 
Accent, 143 
Accent Button, 23 
Accent Cycle, 71, 73 
Accent Variable, 22, 70 
Active Position, 141 
All, 32 
All Button, 51 
All Notes Off, 165 
Automatic Conducting, 97 
Automatic Conducting Enable, 139 
Automatic Conducting Movement Ranges, 139 
Automatic Conducting Time Base, 140 
Baton, 91 
Blink Everything, 155 
Blink Everything Button, 102 
bombsight, 83 
breakpoint, 83, 150 
Build, 127 
Build Mode, 36 
Caps Lock key, 116 
Change to Rests, 40, 55, 169 
Chord, 127 
Chord Method, 161 
Chord Mode, 36, 53, 127 
Chord Record Mode, 24 
Clear, 19, 55, 168 
Clear, 149 
Clear Button, 83 
Clear Current Pattern keys, 110 
Clock Time, 82 
Close "Box", 146 
Close All Edit Windows, 100 
Close Edit Windows, 176 
code key, 113 
Conducting, 91 
Conducting Arrow, 91 
Conducting Arrow, 138 
Conducting Arrows, 12, 141 
Conducting Grid, 9, 91, 137 
Conducting Window, 9, 91, 137 
Conducting with MIDI Controllers, 166 
Continuous Conducting, 95 
Continuous Conducting Arrows, 141 
Copy, 55, 168 
Copying and Swapping Voice Settings, 147 
Copying/Swapping Variables, 142 
Counter Button, 135 
Ctr (Counter) Button, 51 
current Snapshot, 102 

Current Snapshot, 154 
Cut, 55, 168 
Cyclic Editor, 70 
Cyclic Editor, 150 
Cyclic Editor Window, 23 
Cyclic Random, 26, 86 
Cyclic Variable Name Buttons, 151 
Cyclic Variables, 69 
Cyclic Variables Window, 9, 143 
Decelerando, 112 
Denominator, 129 
Disable, 125 
Disabled, 128 
Don't Scramble Rests, 178 
Double with Rests, 54, 174 
Drag Area, 153 
Drum Machine Mode, 128 
Drum Machine Record Mode, 37, 53 
Drum Machine Record Mode Picture Matrix, 38 
Echo In Background, 181 
Echo Map, 117, 126 
Echo Map Enable, 118, 126 
Echo-Thru-Orchestration, 17, 32, 126 
Edit menu, 40, 167 
edit selector, 146 
Edit Snapshot, 155 
Edit Snapshot Button, 104 
Edit Window, 10, 171 
Edit Windows, 65, 66, 146 
Edit..., 41, 131, 172 
Editing Grid, 41 
Editing Grids, 23, 71, 151 
Editor Sound Enable, 45, 135 
Editor Sound Enable, 20 
Editor Sound Velocity Numerical, 135 
Editor Sound While Playing, 135, 180 
Eliminate Chords, 55, 175 
Eliminate Rests, 55, 175 
Enabled, 128 
Erase Snapshot, 170 
Eraser, 47, 134 
External Sync Ratio, 111 
File, 31 
File Menu, 158 
File Recording Parameters, 160 
Fill with Rests, 55, 169 
First Program Change Number, 164 
Freeze Tap Conduct, 112 
Hold/Do, 153 
Hold/Do Button, 100 
Import As Sequence, 161 
Import as Sequence Button, 123 
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Import Button, 122 
Import Dialog, 122, 159 
Importing MIDI Files, 124 
Input Control, 126 
Input Control System, 29, 109 
Input Control System Enable icon, 109 
Input Control System Template, 109 
Insert, 127 
Insert Mode, 52 
Insert Paste, 134, 168, 169 
Insertion Mode, 127 
Insertion Mode Picture Matrix, 38 
Keyboard Transpose, 29, 116, 125, 179 
Legato Button, 28 
Legato Cycle, 79 
Legato Value Numericals, 79, 152 
Legato Variable, 78 
Legend, 132 
Length Numericals, 82 
levels, 71 
Local Control Off, 165 
Local Control On, 165 
Lock Marked Variables, 146 
Locked Marked Variables, 180 
main screen, 8 
Map Edit selector, 149 
Map Length, 149 
Marking a Variable Position, 146 
metronome, 61 
Metronome's Time Base, 61 
Midi Assignment, 21 
Midi Assignment Window, 90 
Midi Assignment..., 163 
MIDI Clock, 139 
Midi Conduct, 179 
MIDI Conducting, 166 
MIDI Edit Counter, 45, 135 
MIDI Edit Range, 51 
MIDI Edit Range Bar, 134 
MIDI Editing, 50 
MIDI File, 119 
MIDI Messages, 164 
Midi Window, 9, 145 
miniature representation, 65, 141 
Mode Selector, 51, 136 
Mouse Advance, 115, 128 
Mouse Advance Toggle, 115 
Movie, 119 
Movie, 138 
Movie Button, 119 
New, 158 
No Cyclic Blinking, 72, 179 
No Zoom Rects, 179 
Note Density, 59, 147 
Note Density, 142 
Note Density Edit Window, 29, 66, 69 

Note Density Variable, 29, 66, 69 
Note Numerical, 67 
Note Order, 143, 148 
Note Order Edit Window, 26, 86 
Note Order Variable, 26, 86 
Numerator, 129 
Numerical, 12 
octave icons, 44 
Octave Numerical, 67 
octave scroll icons, 132 
Omni Off, 165 
Omni On, 165 
OMS Devices, 164 
One-Step Controls, 109 
Open Midi File..., 159 
Open..., 158 
Options menu, 39, 177 
Orchestration, 145, 150 
Orchestration Edit Window, 16, 33, 57, 89 
Orchestration Variable, 16, 32, 57, 88 
Original -> Scrambled, 173 
Original Order, 26, 86 
Output Channels, 164 
Output Length, 58, 129 
Output Length Numerical, 36, 56, 61 
Output-Length Numerical, 18 
Overdub, 128 
Overdub Mode, 37, 53 
Panic, 165 
Paste, 55, 168 
Paste at End, 55, 169 
Paste Notes, 55, 168, 169 
Pattern, 9, 31 
Pattern Editor, 131, 168, 172 
Pattern Editor, 19 
Pattern Editor Editing Grid, 132 
Pattern Editor Size Box, 131 
Pattern Editor Window, 41 
Pattern Group, 142 
Pattern Group Variable, 87 
Pattern menu, 41, 54, 172 
Pattern Select box, 126 
Pattern Size Numerical, 42, 136 
Patterns Window, 9, 125 
Pause Button, 60 
Phase, 129 
Phase Numerical, 63 
Picture Matrix, 14 
Picture Numerical, 61 
Play Slideshow key, 113 
Play-Enable, 128 
Play-Enable Button, 20, 57 
Play-Enable Buttons, 37 
Plunger, 47, 134 
Pointwise selection, 133, 170 
Positions, 65 
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push button, 11 
Quantization, 153 
quantization algorithm, 161 
Quantization Numerical, 104 
quantized, 101 
Range Bar, 13 
Real Time, 82 
Record, 125 
Record Indicator, 155 
Record Mode Picture Matrix, 35 
Record Modes, 35, 127 
Record Slideshow key, 113 
Reference Keyboards, 132 
Region, 47, 134, 168 
Replace, 128 
Replace Mode, 37, 53 
ReScramble, 87, 173, 178 
Restore From Snapshot, 155 
Restore From Snapshot Button, 105 
Reverse Order, 54, 174 
Rhythm, 144 
Rhythm Cycle, 75 
Rhythm Value Numericals, 76 
Rhythm Value Numericals, 152 
Rhythm Variable, 75 
Robot Conductor icon, 98 
Rotate Backward, 54, 173 
Rotate Forward, 54, 173 
Save, 40, 162 
Save as..., 31, 162 
Save Movie As Midi File, 120 
Save Movie As Midi File..., 162 
Save State As Startup, 158, 163 
Scissors, 47, 134 
scroll arrows, 44, 132 
Scroll Bar, 44, 133 
Second Order Transpose, 179 
Select Box, 18 
Select Column, 35 
Selector, 47, 133, 168 
Send Clock, 178 
Send Clock Modem, 139 
Send Clock Printer, 139 
Send Msg…, 164 
Sequence, 119, 124, 161 
Sequence Play Enable, 138 
Sequence Play-Enable Toggle, 124, 162 
Sequence Play-Enable Toggle key, 110 
Shift-Click on Numerical, 111 
Single Note, 127 
Single Note Mode, 36, 53 
Size Box, 42 
sliders, 14 
Slideshow Loop, 157 
Slideshow Loop Button, 107 
Slideshow Pause, 157 

Slideshow Pause Button, 106, 155 
Slideshow Record Wait, 178 
Slideshow Stop, 156 
Slideshow Stop, 156 
Slideshow Stop Button, 106 
Slideshows, 9, 100, 105, 153 
Slideshows, 155 
Snapshot, 101 
Snapshot Conducting Arrow, 153 
Snapshot Window, 9, 100, 153 
Snapshots, 100, 153 
Sound Choice, 145 
Sound Choice Numericals, 89 
Sound Choice Program Numericals, 145 
Sound Choice Variable, 21, 89 
Source Channel Numerical, 32 
Source Channels, 122 
Src, 18, 32 
Src (Source Channel), 125 
Start, 137 
Start Button, 20, 33, 59 
Step Advance, 110 
Step Advance all "sa" Voices, 111 
Step Editing Tools, 41, 47, 133 
steps, 44, 71 
Stop Any Slideshow key, 110, 113 
Stop Button, 20, 34, 59 
Sustain Enters Rests, 179 
Swap Scrambled and Original, 173 
Sync, 137 
Sync Button, 27 
Sync Ratio / Metronome Ratio, 139 
Sync Ratio Numerical, 177 
Sync Restarts Sequence, 180 
System Reset, 165 
Tap Affects Velocity, 112, 178 
Tap Conduct Tempo, 111 
Tap Tempo, 111 
tempo, 60 
Tempo, 138 
Tempo Numerical, 60, 138 
Tempo Range Bar, 21, 60, 138 
The Variables Menu, 171 
The Variables Window, 142 
Thumb, 44, 133 
Ticks, 63, 76, 130 
Time Base, 21, 62, 129 
Time Base Denominator, 59, 62 
Time Base Numerator, 62 
Time Base Numericals, 21, 62 
Time Distortion, 149 
Time Distortion, 143 
Time Distortion Edit Window, 82 
Time Distortion Map, 81 
Time Distortion Variable, 81 
Timing, 161 
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toggle button, 12 
Transpose Down Half Step, 54 
Transpose Down Half-Step, 172 
Transpose Down Octave, 54, 172 
Transpose Up Half Step, 54 
Transpose Up Half-Step, 172 
Transpose Up Octave, 54, 172 
Transposition, 143, 148 
Transposition Edit Window, 28, 67 
Transposition Numerical, 28 
Transposition Variable, 28, 67 
Triple with Rests, 54 
Two-Step Controls, 109 
Undo, 55 
Use, 17 
Use, 125 
Use Column, 34 
Use Metronome, 39, 61, 177 
Use Picture Matrix, 35 
Utterly Random, 26, 86 
value key, 113 
Variable, 9, 65 
Variable Positions, 10 
Variables Window, 9 
Velocity Numerical, 45 
Velocity Range, 143 
Velocity Range, 148 
Velocity Range Edit Window, 22, 70 
Velocity Range Variable, 22, 70 
View, 43 
View selector, 131 
Voice, 9, 31 
Voice 1-4 Color..., 171 
Windows Menu, 176 
 


